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Software License Agreement 

Acknowledgement 

At ScreenCheck we are committed to design and develop the highest quality software and service for 
our customers. 

Copyright 

Information in this document is subject to change without notice. The software, which includes 
information contained in any databases, depicted in this document is furnished under a license 
agreement or nondisclosure agreement and may be used or copied only in accordance with the  
terms of that agreement. It is against the law to copy the software except as specifically allowed in 
the license or nondisclosure agreement. No part of this manual may be reproduced in any form by 
any means, electronically or mechanical, including photocopying and recording, for any purpose 
without the written permission of ScreenCheck B.V. 
 
© 1993-2008 ScreenCheck B.V., All rights reserved. 
Printed in the Netherlands, Europe. 

Trademarks 

BadgeMaker; BMLITE, BM4400, BM5400, BM6400, BadgeCreator (BC) and Visipass are trademarks of 
ScreenCheck B.V., The Netherlands. 
 
Microsoft Windows is a registered trademark of Microsoft Corporation.  All other trademarks are the 
property of their respective holders and are hereby acknowledged. 
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System Requirements 
BadgeMaker requires Windows XP, Windows Vista to run and can be used on any IBM compatible 
computer that meets the following minimum requirements: 
 

• Pentium III 1 GHz Processor or better. 
• 4GB hard disk space recommended, actual size depending on number of records and images 

in a database. 
• 256MB or more internal memory. 
• Color monitor and graphics card capable of supporting SVGA resolution of 1024x768 pixels 

and 24 bit (true) colors. 

Licenses 

BadgeMaker can be used in a multi user environment. The software can be used for evaluation for a 
total of 30 days. If you want to use BadgeMaker’s full potential without any restrictions you must 
register the software. The restriction is that the package will retain the text 
http://www.screencheck.com when printing forms or badges. 

Readme File (Release Notes) 

As we are constantly improving our software and adapting it to the latest developments and 
technologies, a few  features may not be included in this manual. In addition to the BadgeMaker 
software a Readme file will be installed in the BadgeMaker directory and an icon (called Release 
Notes) will be added to the BadgeMaker program group. In this file you can read the latest changes in 
the software and the version number it applies to. For every release there is a description of the main 
changes and new features.  
 

 Please read this file before starting BadgeMaker. 
 
You can open the release notes by selecting it from the BM6400 program folder. 

Appendices 

The following plug-ins are described in separate chapters (appendices) at the end of this manual. 
 

• Encoding 
• Contactless encoding 
• IntelliTWAIN  

 
The reason is that these features are optional add-ons. Adding these features to the description of 
the relative module would make the chapters very long and distract attention from the main 
functionality of these modules. 
 
 

http://www.screencheck.com/�
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Activate BadgeMaker 
When BadgeMaker is installed for the first time you must register the software in order to gain full 
functionality.  
 
A Software Activation Code (SAC) is shipped with BadgeMaker. With this Software Activation Code 
you can register BadgeMaker on the internet. After registering, a registration name and key is 
displayed immediately and sent to your email automatically. 
 
In this document BadgeMaker 6400 is being used to demonstrate Activating BadgeMaker. The steps 
taken in this manual should be followed for all other versions of BadgeMaker. 
 
Sample of a SAC (Software Activation Code) 
 
BM6400STD70VM-TST-0007-GQYXHPAMVQ 
 
Sample of a Registration Key 
 
01CNX7-FMN6EZ-X2H386-Y5UWEN-KW93Y-VR777T-PHNK0C-1CWJN3-44G9PG-BY4H34 

Acquiring an Activation Key 

In trial mode, a message is shown every time BadgeMaker is started. 
 

 
 
Select Yes to begin registering BadgeMaker. 
 
If you do not wish to register at this time you can register at a later time by selecting the Help Menu 
and then click About, click Enter Key. The following dialog box is presented. 
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Enter Key Dialog 

 
You must obtain a Name and Activation Key to activate BadgeMaker. Follow the instructions 
carefully on the screen. 
 
Click on the link to open the website (www.register.screencheck.com.  You are now directed to the 
Software Registration Site where you can complete your registration. 
 

http://www.register.screencheck.com/�
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Software Registration Site 

 
The Hardware-Fingerprint is already filled in. You must enter the SAC that was shipped with your 
product when you purchased BadgeMaker.  
 
Enter the Software Activation Code you received in the field and all other fields marked with * are 
mandatory and must be populated.  
 

 
Input SAC 
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Register your details 

 
 Remember  

 
Note down  “Registration Name/Company”, this is needed for the registration along with the key. 
When you have entered all the required information, click the Submit Information button and you 
will receive Registration details together with a key. 
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Registration Key 

 
If you do not have internet access on the PC where BadgeMaker is installed, you can register on 
another machine but you must remember the Hardware-Fingerprint from the original 
computer/server BadgeMaker is to be installed on and fill this in on the website manually.  
 

 You must register within the 30 day trial period. 
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Enter Key 

 
Enter your new Activation Key and select Register to complete registering your copy of BadgeMaker. 
 

 
 
If you enter an incorrect Hardware-Fingerprint registration will fail and use of BadgeMaker will 
remain restricted. 
 
You can also select Help Menu>About from the main menu in the software to register BadgeMaker.  
 

 
BM Help Menu 
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Introduction to BadgeMaker 
BadgeMaker has been implemented successfully in thousands of organizations worldwide to issue 
national ID’s, driver licenses, passports, civil identification and social security cards. Use the full 
power and advanced features with BadgeMaker such as biometrics, contact and contactless smart 
cards. 
 
With BadgeMaker  an MSAccess demo database is included that illustrates most features in the 
software. The installation program will install demo files and will register an ODBC data source, so it 
will be ready to run (applicable only in BadgeMaker 6400). You can use the demo database as a 
reference when you create your own BadgeMaker project or you can test different features you 
would like to integrate into your own project. 

What's new in BadgeMaker 7.1 

  Mask edit 

 You can now choose whether to print data on badge with or without mask. 
 

 Create project from scratch 

 When saving a project created from scratch the system will ask for a unique field as well as for a 
layout field if you haven't defined one yet. 
 

  Auto Capture images 

 You can use the software to auto capture photos with the SC Digital Camera plug-in. 
Getting Started 
 
The BadgeMaker software consists of two components integrated into one application. Each 
component with its own functionality. 
 

 Badge Maker (BM) 

 This module is used to create a database and enter data into the database, acquire images and print 
cards. This module is the main screen of BadgeMaker. 
 

 Badge Creator (BC) 

 This module is used to create badge layouts with dynamic/static text, logos, signatures, photos, 
magstripe information and chip encoding. 
BadgeMaker File extensions 
 
When you wish to connect BadgeMaker to an existing database, you can start BadgeMaker and select 
the option New from the File menu.  
 
Now you can create the initial files…. 
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 .BM - BadgeMaker project file. This file contains information about the use of the database fields 
and the location of the files and formats used by BM.(name, photo, signature, encoding data etc.)  
 

 .DSN - From within the project editor a new ODBC data source name can be created. BM uses this 
data source name to connect to the database. 
  
After creating the initial files, you link Layout files to a BM-file by using the BadgeCreator module. 
 
With BadgeCreator you can define one or more layouts linked to a BadgeMaker project file. 
 

 .BC - Layouts linked to a BM-file. 
 .ENC - Encode files linked to a BM-file. 
 .CHP - Encode files linked to a BM-file. 
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Installing BadgeMaker 
For installation of BadgeMaker Software please follow these simple steps:  
 
In our example BadgeMaker 6400 has been used. This will be the same for all versions of 
BadgeMaker. 
 
Insert the ScreenCheck BadgeMaker CD into the CD-ROM, the CD will automatically launch setup.  
From the Main Menu select “Install BadgeMaker”.  
 
If however the CD does not run automatically please begin the Setup process manually. This can be 
done by opening up found in the Start Menu>Run , specify path to the *.exe file to begin. 
 

 
 
The software will begin unpacking in preparation for the install process to begin. 
 

 
 
The Welcome Screen is presented. 
 

 It is strongly recommended that you exit all running programs before continuing with the 
BadgeMaker Setup. 
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BM Setup Welcome Screen 

 
Click Next to progress. 
 

 
License Agreement 
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Please read the License Agreement. You must accept all the terms in this agreement to continue 
installing BadgeMaker. 
 
Click Yes to continue. 
 

 
Enter Customer Information 

 
Enter your name and the name of the company for whom you work for in this dialog box. Select Next 
to progress. 
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We recommend to leave the default path C:\SC\BM6400 as the destination folder which BadgeMaker 
will be installed. Although if required you can specify an alternative destination path. Click Next to 
progress to the next screen. 
 

 
Leave default settings and click Next  to begin installing BadgeMaker onto your computer. 
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Installing 

 

 
 
The BadgeMaker setup has now finished. If you do not wish to view the Readme File uncheck this 
option before clicking Finish. If you choose to read the Read Me file just click Finish. 
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ReadMe.txt 
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Uninstalling BadgeMaker 
To Uninstall BadgeMaker select Start Menu>Control Panel>Add or Remove Programs>Select Change 
or Remove Programs. 
 

 
 
Select the BadgeMaker software from the list and select Change/Remove. 
 

 
 
You will receive a warning stating BadgeMaker will be removed from the computer. At this point you 
can still cancel the process by clicking No. To proceed and remove BadgeMaker select Yes.  
 

 
 
BadgeMaker will now be removed from the system. A success prompt will confirm removal was a 
success.  
 
 In our example BadgeMaker 6400 has been used. This will be the same for all versions of 
BadgeMaker. 
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Starting BadgeMaker for the first time….. 
To open BadgeMaker select Start, click Program Files, click BadgeMaker and then click BadgeMaker. 
 BadgeMaker can also be started by double clicking the desktop shortcut; 
 

 
Desktop Shortcut 

 
When you have started BadgeMaker an empty window will be displayed with the Login dialog box 
presented. 
 

 
BM Login dialog box 

 
To begin working you must first login. Click the login button or select Users Menu and click Login. 
You will be prompted to enter your user name and password. 
 
Default Administrator password (Built In) 
 
Username: SUPERVISOR 
Password: SUPERVISOR 
 
It is recommended not to change these default values. This user has administration rights, Full 
Control. You can create additional user accounts with their own passwords later. 
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Once you have logged on double click the default project DEMO to get acquainted with 
BadgeMaker’s GUI interface and features. 
 

 
BM Project file (DEMO6400) 

 
The will launch into BadgeMaker’s Main Screen. 
 

 

Layout Selection 

Click on this box to select one of the available layouts. 
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Status bar 

The Status Bar can be found along the bottom of the main window. In the status bar you can see the 
current selected record, the username currently logged in and group the user has been assigned to. 
 

 
Status Bar 

Adjust Field Width 

Move your mouse pointer and click the borders between the fields as shown below. Drag the mouse 
either left or right to adjust the fields width. 
 

Before Adjusting 
 

 
 

After Adjusting 
 

 
 

 OMC functionality will only work in combination with the Lasercard ® optical memory card 
reader/writer and software. 
 

 The Automatic Scan functionality will only work in combination with the optional ADF software 
module and scanner. 

Relocate a field 

On the main screen of BadgeMaker the database window form a prominent part. The fields of the 
data window are placed in columns. Each record is placed in a row. The order of the columns 
(database fields) can be changed. To do this you can select the column you want to relocate, in our 
example Firstname in the header of the column: 
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BM Database – Manage records 

 
Now hold-down the right mouse button in the header of the column to relocate and drag it to the 
new location (in our example the right side of “layout”) and release the right button. The result will 
be: 
 

 

Tagging records 

One or more records can be tagged by click the square on the left side of the database window pane. 
This will result in a check mark in the squire indicating the record is checked. 
 
To check all records you can place the mouse in the left corner of the header and click on it: 
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Tagging Records 

Editing a record 

Double clicking on a record in the main dialog will open the Field Edit dialog. In this dialog, changes 
can be made to the fields, provided the fields are defined to be Editable. If a field is defined to be 
View only it cannot be edited (only the first value for can be filled in when a new record is created). 
View only fields can be recognized because the contents are grey instead of black.  
 

 
Record Details 

After clicking the right mouse button in the grid, the following dialog will come up: 
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The right button will be enable you to tag, remove tags, find, SQL select, copy, paste and adjust 
images of selected records. Under options, the font, colour and language can be changed. 

The Image Windows 

The image windows are separate windows, which are always on top (unless you close them or hide in 
the View menu). 
 
You can change the size of the Photo window by clicking with your mouse on the corners and drag 
the corners to adjust the size. By clicking on the name bar you can select the image type belonging to 
the window as the active one. When you use the Acquire Image option the image will be stored 
under the active image type. 
 

      
Image Windows 

 
When you click with your left mouse button inside the Photo window you can drag it across the 
screen. 
 
If you click inside the image window with your right mouse button, you will get three options:  
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• Hide 
• Acquire 
• Adjust 

 
Select Hide to hide the current image window, select Acquire to acquire a new image (to overwrite 
the existing image). 
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BadgeMaker Toolbar 

The Toolbar in BadgeMaker can be used to quickly start a function, by clicking on the desired button. 
 

 
BM Toolbar 

 

 Login Button  
Click on this button to login to BadgeMaker.  

 

 New Project  
Click on this button to create a new project.  

 

 Open Layout  
Click on this button to open a layout file that is linked to the currently opened *.BM file.  

 

 Edit Project 
Click on this button to edit the current project settings and database.  

 

  New Badge  
Click on this button to start BadgeCreator for designing a new layout.  

 

 Edit Badge  
Click on this button to start BadgeCreator for editing the current layout.  

 

  Preview Button  
Click on this button to preview the current record in the current layout on the screen. (Front, 
back, encoding etc.)  

 

  Toggle Card  
Click on this button to show/hide the card preview in the main screen. With the submenu 
you can select/deselect the front and back of the card.  

 

 Toggle Encode  
Click on this button to show/ hide the preview of the encode information. With the        
submenu you can toggle between magnetic or chip data previews.  

 

  Print Button  
Click on this button to print the selection using the current layout to a Windows supported 
printer.   
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 Copy Button  
Click on this button to copy an image to the clipboard.  

 

  Paste Button  
Click on this button to paste data from the clipboard to your current records.  

 

  Acquire Button  
Click on this button to acquire/add an image from the selected image type. With the 
submenu you can select the from the following: 

 
• Photo 
• Sign 
• Photo thumb 
• Sign thumb 
• Finger template 
• Finger image  

  

 Select source  
Click on this button to select the source of the photo (File, camera, signature pad). For 
example if using a camera to create photos, a source (Hardware driver) must be linked to an 
image type.  

 

 Bulk Input Button  
Click on this button to activate the bulk input feature.  

 

 Import Data  
Click on this button to import data according to the automatic import settings.  

 

  Add Record  
Click on this button to add a record to the database.  

 

 Delete Records  
Click on this button to delete the selected records.  

 

 First Button  
Click on this button to go to the first record in the database.  

 

  Previous Button  
Click on this button to go to the previous record in the database.  

 

 Next Button  
Click on this button to go to the next record in the database.  



 

 © 1993-2009 ScreenCheck B.V.        PAGE 39                                                                                                      

  

 

  Last Button  
Click on this button to go to the last record in the database.  

 

 Refresh  
Click on this button to refresh data.  

 

 Search Button 
Click on this button to activate the find function.  

 

  Select Button  
Click on this button to open the selection dialogue.  

 

  Chip encoding  
Click on this button to encode a configured chip file onto the card the chip encoding is carried 
out by a separate encode unit attached to the printer. This feature can also be used to run 
simulation chip encoding for testing chip layouts.  

 

  Encode OMC (Optical Memory Card)  
Click on this button for OMC (Optical Memory Card) encoding (optional).   

 

  About BadgeMaker  
Click on this button, to display information about BadgeMaker.  

 

 Help  
Click on this button to activate BadgeMaker Help. 
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File Menu 
The File Menu appears as the first item in the menu bar, and contains commands relating to the 
handling of files such as open, print and save. You can close windows and exit BadgeMaker from 
here. 
 

 
File Menu 
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New Project 

To create a new project file (*.BM file) select File Menu, click New Project. There are six options to 
select. 
 

 
 

Use option  from the toolbar. 
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From Existing Excel, Text or MS Access data 

Select File Menu and then click New project. 
 

 
 
After selecting a new project, select From existing Excel, Text or MS Access data. 
  
In preparation an Excel file is made, which represents a small database. This Excel database contains 
the following fields: 
  

• IDNumber 
• Firstname  
• Surname 
• Function 

 
 The file will look similar to this. 
 

 
Search for the original file that will be used to create your project. 
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Click Open and the following dialog will be displayed. 
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External data source 

 
Under Excel Data select a Sheet.  
 

 
Sheet 1 

 
As an Excel file was chosen to create this project take note of the Excel sheet which contains your 
data. You must specify a sheet, in our example we are using Sheet 1. 
 
Now you have to select the unique field of your Excel database. In our case this is going to be 
IDNumber. 
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Specify a Unique Field 

 
Select OK to complete creating the project. The conversion is complete,  you are presented with the 
following results. 
 

 
BM Main Screen 
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From Existing BM4000 project 

Select File Menu and then click New project. 
 

 
 
After selecting a new project, select From existing BM4000 project.  
 
Click OK to progress. 
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Browse to the BM4000.BM project file which will be converted to a later version *.BM project file. 
Highlight the *.BM file and click Open. 
 
A confirmation screen is shown. To start conversion select Yes, to cancel select No. 
 

 
Convert project 

 
When conversion completes the newly created project will automatically start.  
 

 
BM Main Screen 
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From Existing BM5000 project 

Select File Menu and then click New project. 
 

 
 
After selecting a new project, select From existing BM5000 project. 
 
Click OK to progress. 
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Browse to the BM5000.BM project file which will be converted to a later version *.BM project file. 
Highlight the *.BM file and click Open. 
 
A confirmation screen is show. To start conversion select Yes, to cancel select No. 
 

 
 
When conversion completes the newly created project will automatically start. 
 

 
BM Main Screen 
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From a preconfigured MS Access Database 

Select File Menu and then click New project. 
 

 
 
After selecting a new project, select From a preconfigured MS Access database. 
 
Click OK to progress. 
 

Step 1. General Settings 
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Project name: Specify a name for the project. This name will be displayed when the project is opened 
in BadgeMaker. In this example we have chosen EXAMPLE. 
 
Data retrieving method: By default Dynamic is enabled. If the ODBC driver of your database does not 
support Dynasets, you will receive an error message when you try to load the project in BadgeMaker. 
Disable this option if you receive a message stating Dynasets are not supported.  
 
Default Image quality: Images are stored in *.JPEG format by BadgeMaker. The images are stored as 
BLOB’s (Binary Large Objects) in the database. The quality of the stored image can be set by 
specifying a value in this field. The default value is 50, this combines a good image quality with a good 
compression rate (images will be 20kB-25kB). Image quality can be improved by specifying a higher 
value but stored images will increase in size.  
 

 Depending on the database used the image size that can be stored as a BLOB will vary. If you 
increase the value too much, some databases might get a problem storing the images. If this 
problem occurs, lower the image quality to decrease the image size. 
 
Thumbnail image: Check this box to store a thumb nail image of the photos and signatures 
(in addition to the stored *.JPEG images). The thumbnail image is stored in a *.BMP format in 256 
colors with a reduced resolution. 
 
Click Next to progress. 
 

Step 2. Image Files 
 

 
 
Apart from using the following image types Photo and Signature, other image types can be added 
such as Fingerprint. Click Add to configure more image types. The following dialog is displayed. 
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Settings 

 
By default BadgeMaker has four standard image types, (Photo, Sign, Photo thumbnail and Sign 
thumbnail). They cannot be changed or removed, however new image types can be added, edited 
and removed. The new type will be added to the list. 
 
To remove an image type, select a Image type from the list and click Remove.  
 

 Remember when you remove an image type the images stored under it will also be lost. Image 
types 1 – 4 cannot be removed. 
 

 When a hand scan (Biometrics) is saved, uncheck the box in the column Displayable. The hand 
scanner  will save a template of the characteristics of the hand and not an image of  the hand. 
 

 
Image Files 
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Select Use custom size thumb nails, it is now possible to edit configured image types by clicking Edit. 
 

 If you add new image types, the first new image type is type 5, the second will be type 6 and so 
on. 
 

 
Settings 

 
Edit the name of an image type and change the quality of the image. 
 

• This feature is only available if pictures are stored as BLOB's 
• The thumbnails are always stored in 8 bits/pixel 
• The location needed to store an image is calculated as follows: (Width*Height)/1024KB 
• Standard aspect ratio for photos is 3:4 and for signature 4:1 

 
Do not use values greater than 2 times the default values. Using excessive values will degrade the 
performance of BadgeMaker because of the size of the images. 
 
When a hand scan must be saved, please uncheck the box in the column Displayable. The hand 
scanner will save a template of the characteristics of the hand and not an image of the hand.  
 
Click OK when changes have been made to return to the project set up. 
 
Click Next to progress. 
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Step 3. Fields in Project 
 

 
Fields in project 

 
Select the fields to use in the project, the first three fields (already selected by default) are fixed and 
cannot be altered. You may select what fields to include from a choice of 14 Text fields, 6 Numbered 
fields and 6 Date fields. 
 

 
Text field 

 
Click Next to continue. 
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Step 4. Special Tables 
 

 
Special tables 

 
Select a image table and select a logging table (if required). 
 
Store images in this table: Select here the table that will be used to store images. This table must 
have a fixed structure. (By default Image is already selected and cannot be changed). 
 
Log mutations in this table: Keep track of the mutations made in BadgeMaker by creating a logging 
table. Select here the table to log mutations in. (By default Log is already selected and cannot be 
changed). 
 
Click Next to proceed. 
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Step 5. Special Fields 
 

 
Special fields 

 
Specify a unique field: Select a Unique Field from the database. When an image is stored, 
BadgeMaker will copy this value into the field ID of the Image Table. 
 
Register tagged records in this field: To use the option Tag Records. A field has to be selected to 
register the tagged records. An unused numeric field in the database can be used for this purpose. If 
this is not available a field must be added to the database.   
 

 This field is not mandatory, but if it is not defined the option to tag records cannot be used. 
 
Store layout description in this field: If the Automatic layout feature is used a field must be selected 
where the layout description can be read. The layout descriptions displayed in BadgeMaker's main 
screen should match the values filled in the field. If this feature will not be used, no field should be 
selected. 
 
Every department has its own layout. For the field department a ‘pick list’ is created. All the 
department descriptions are filled in this list. The same descriptions must be used for the Badge 
layouts for the different departments in Badge Creator. If the automatic layout option is activated, 
the badges for every department will be printed automatically with its own layout. 
 
Click Next to proceed. 
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Step 6. Folders 
 

 
Folder location 

 
Project folder: Location of the *.BM project file. 
 
Card layout folder: Location of badge layouts files. 
 
Encode layout folder: Location of encode files for magstripe and chip encoding. 
 
Logos folder: Advised location for logos used in badge layouts. 
 
Folder locations can be changed to another location of the operators choice. Click 
Folder, the following dialog is displayed. 
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Select a different location or create a new location if necessary. Selection of the desired folder can be 
done in the same way as in Windows Explorer. Click OK to close. 
 
For each folder the remark pops up that the folder does not exists. 
 

 
 
Click Yes to create it now. (Repeat confirmation for the others which prompts the 
operator to confirm automatically) 
 
Click Finish, to close the dialog and proceed to save your settings. 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 59                                                                                                      

  

 
Save new project 

 
Click Save to store the newly created database and specify a name for it. 
 

 
 
After the *.BM project is saved. The newly created project is started. The database is initially empty 
and can now be filled with data. 
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BM Main Screen 
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From ODBC Datasource 

Select File Menu and then click New project. 
 

 
 
After selecting a new project, select From ODBC datasource. 
 
Click OK to progress. 
 
The Select Data Source dialog will show. 
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Select Data dialog 

 
Click the Machine Data Source tab and then click New...  
 
The Create New Data Source dialog will show. 
 
Select a type of data source. 
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Create New Data Source dialog 
 
User Data Source: Selecting User Data Source creates a data source which is specific to this machine, 
and visible only to the user. 
 
System Data Source: Selecting System Data Source creates a data source which is specific to the 
machine, and usable by any user who logs onto the machine. 
 
We recommend selecting System Data Source.  
 
Click Next to progress. 
 

 
Create New Data Source dialog 

 
Depending on the type of database being used (MS Access, Oracle or SQL) select a driver  to set up a 
data source. Once you have made a choice click Next to progress. 
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A summary is presented, confirm details are correct and then click Finish. 
 
The ODBC Microsoft Access Setup dialog box is presented. 
Enter a Data Source Name to identify the Access database, then enter a description if you choose to.  
 
The Description field is blank by default and can contain your descriptive qualifiers. 
 

 
ODBC Microsoft Access Setup 

 
Select a shared database, click Select to open an existing database. The following dialog is displayed. 
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Select Database 

 
Navigate and select the database and then click OK.  
 
For this example TEMPLATE.MDB has been chosen. 
 

 
 
Click OK to return to the Select Data Source dialog. 
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Click OK to proceed.  
 
Fields from the database are shown in the Tables dialog, confirm they exist are listed 
correctly. 

 
Tables 

 
Click OK to proceed. 
 

Step 1, General Settings 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 67                                                                                                      

  

 
General settings 

 
Project name: Specify a name for the project. This name will be displayed when the project is opened 
in BadgeMaker. In this example we have chosen EXAMPLE. 
 
Data retrieving method: By default Dynamic is enabled. If the ODBC driver of your database does not 
support Dynasets, you will receive an error message when you try to load the project in BadgeMaker. 
 
Default Image quality: Images are stored in *.JPEG format by BadgeMaker. The images are stored as 
BLOB’s (Binary Large Objects) in the database. The quality of the stored image can be set by 
specifying a value in this field. The default value is 50, this combines a good image quality with a good 
compression rate (images will be 20kB-25kB). Image quality can be improved by specifying a higher 
value but stored images will increase in size.  
 

 Depending on the database used the image size that can be stored as a BLOB will 
vary. If you increase the value too much, some databases might get a problem storing 
the images. If this problem occurs, lower the image quality to decrease the image 
size. 
 
Thumbnail image: Check this box to store a thumb nail image of the photos and signatures (in 
addition to the stored *.JPEG images). The thumbnail image is stored in a *.BMP 
format in 256 colors with a reduced resolution. 
 
LDAP (Lightweight Directory Access Protocol) support: The ODBC driver for LDAP databases is not 
compliant with the ODBC drivers for other databases. Therefore BadgeMaker has to handle this 
driver differently than the others. Check this option if you connect to an LDAP database. In all other 
cases leave this option unchecked. 
 

Step 2, Image Files 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 68                                                                                                      

  

 
Image files 

 
BadgeMaker stores images in an image table usually, but it can also read image files from another 
location on the hard disk or from a CD Rom. Check Store images in folder option if you have ready-
made image files. 
 
The name of these image files must correspond with the value in the field specified in Step 5 under 
Specify Unique Field. This will depend on how the two tables in the database are linked together 
(Data Table and Picture Table). 
 
Select the Base folder for images and specify a folder destination. Different image types must be 
stored in the folder according to their image type number for example Photo = 1, Signs = 2 and so on.   
 

Step 3, Image Types 
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Image types 

 
Apart from using the following image types Photo and Signature, other image types can be added 
such as Fingerprint. Click Add to configure more image types. The following dialog is displayed. 
 

 If you add new image types, the first new image type is type 5, the second will be type 6 and so 
on. 
 

 
Settings 

 
Edit the name of an image type and change the quality of the image. 
 

• This feature is only available if pictures are stored as BLOB's 
• The thumbnails are always stored in 8 bits/pixel. 
• The location needed to store an image is calculated as follows: (Width*Height)/1024KB 
• Standard aspect ratio for photos is 3:4 and for signature 4:1 
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Do not use values greater than 2 times the default values. Using excessive values will degrade the 
performance of BadgeMaker because of the size of the images. 
 
When a hand scan must be saved, please uncheck the box in the column Displayable. The hand 
scanner will save a template of the characteristics of the hand and not an image of the hand.  
 
Click OK when changes have been made to return to the project set up. 
 
Click Next to progress. 
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Step 4, Special Tables 
 

 
Special tables 

 
Select a image table and select a logging table (if required). 
 
Store images in this table: Select here the table that will be used to store images. This table must 
have a fixed structure.  
 
Log mutations in this table: Keep track of the mutations made in BadgeMaker by creating a logging 
table. Select here the table to log mutations in. 
 
Click Select Table, a choice of tables are displayed. 
 

 
Select a table and click OK. 
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Select Next to progress to the next screen. 
 

Step 5, Special Fields 
 

 
Special fields 

 
Specify a unique field: Select a Unique Field from the database. When an image is stored, 
BadgeMaker will copy this value into the field ID of the Image Table. 
 
Register tagged records in this field: To use the option Tag Records. A field has to be selected to 
register the tagged records. An unused numeric field in the database can be used for this purpose. If 
this is not available a field must be added to the database. 
 

 This field is not mandatory, but if it is not defined the option to tag records 
cannot be used. 
 
Store layout description in this field: If the Automatic layout feature is used a field must be selected 
where the layout description can be read. The layout descriptions displayed in BadgeMaker's main 
screen should match the values filled in the field. If this feature will not be used, no field should be 
selected. This field is not mandatory. 
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Every department has its own layout. For the field department a pick list is created. All the 
department descriptions are filled in this list. The same descriptions must be used for the Badge 
layouts for the different departments in Badge Creator. If the automatic layout option is activated, 
the badges for every department will be printed automatically with its own layout. 
 
Click Next to proceed. 
 

Step 7, Folders 
 

 
Folders 

 
Project folder: Location of the *.BM project file. 
 
Card layout folder: Location of badge layouts files. 
 
Encode layout folder: Location of encode files for magstripe and chip encoding. 
 
Logos folder: Advised location for logos used in badge layouts. 
 
Folder locations can be changed to another location of the operators choice. Click Folder, the 
following dialog is displayed. 
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Select a different location or create a new location if necessary. Selection of the desired folder can be 
done in the same way as in Windows Explorer Click OK to close. 
 
For each folder the remark pops up that the folder does not exists. 
 

 
 
Click Yes to create it now. (Repeat confirmation for the others which prompts the operator to confirm 
automatically). 
 
 Click Finish, to close the dialog and save your settings. 
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Save new project 

 
Click Save to store the newly created database and specify a name for it. 
 
You are returned to the opening screen. 
 

 
BM Start-up screen 

 
Select the new project just created by double clicking on the project icon or by selecting File Menu 
and then click Open project. 
 
The Select dialog will appear. 
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Select (Records) dialog 

 
As this is a new project click OK. 
 

 
 
Select Yes, the project database will now be opened. The database is initially empty and can now be 
filled with data. 
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BM Main screen 
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From Scratch 

Select File Menu and then click New project. 
 

 
 
After selecting a new project, select From scratch. 
 
Click OK to progress. 
 
The Add Field dialog is presented allowing you to construct a database from scratch. 
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Add field 

 
Name: Enter the name of the field you want to create. No spaces are allowed.  
 
Type: Choose from the drop down list type of field required; Text, Date, Integer, 
Counter, Logical, or Numeric. 
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Example 
 

 
Add field 

 
In our example we have added four fields to a new database.  
 
IDNUMBER = NUMERIC 
SURNAME = TEXT 
D.O.B = DATE 
CARDISSUES = INTEGER 
 
Once you have completed constructing your fields click Save. 
 
The following dialog will request you to specify a unique field. 
 

 
 
Click Yes. 
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Special fields 

 
Specify a unique field: Select a Unique Field from the database. When an image is stored, 
BadgeMaker will copy this value into the field ID of the Image Table. 
 

Example 
 

 
 
Store layout description in this field: If the Automatic layout feature is used a field must be selected 
where the layout description can be read. The layout descriptions displayed in BadgeMaker's main 
screen should match the values filled in the field. If this feature will not be used, no field should be 
selected. 
 
Every department has its own layout. For the field department a ‘pick list’ is created. All the 
department descriptions are filled in this list. The same descriptions must be used for the Badge 
layouts for the different departments in Badge Creator. If the automatic layout option is activated, 
the badges for every department will be printed automatically with its own layout. 
 
Click OK to proceed. 
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Step 1. General Settings 
 

 
General Settings 

 
Project name: Specify a name for the project. This name will be displayed when the project is opened 
in BadgeMaker. In this example we have chosen EXAMPLE. 
 
Data retrieving method: By default Dynamic is enabled. If the ODBC driver of your database does not 
support Dynasets, you will receive an error message when you try to load the project in BadgeMaker. 
Disable this option if you receive a message stating Dynasets are not supported.  
 
Default Image quality: Images are stored in *.JPEG format by BadgeMaker. The images 
are stored as BLOB’s (Binary Large Objects) in the database. The quality of the stored 
image can be set by specifying a value in this field. The default value is 50, this 
combines a good image quality with a good compression rate (images will be 20kB-25kB). 
Image quality can be improved by specifying a higher value but stored images will 
increase in size.  
 

 Depending on the database used the image size that can be stored as a BLOB will 
vary. If you increase the value too much, some databases might get a problem storing 
the images. If this problem occurs, lower the image quality to decrease the image 
size. 
 
Thumbnail image: Check this box to store a thumb nail image of the photos and signatures 
(in addition to the stored *.JPEG images). The thumbnail image is stored in a *.BMP format in 256 
colors with a reduced resolution. 
 
Click Next to progress. 
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Step 2. Image Files 
 

 
Image files 

 
Apart from using the following image types Photo and Signature, other image types can be added 
such as Fingerprint. Click Add to configure more image types. The following dialog is displayed. 
 

 
Settings 

 
By default BadgeMaker has four standard image types, (Photo, Sign, Photo thumbnail and Sign 
thumbnail). They cannot be changed or removed, however new image types can be added, edited 
and removed. The new type will be added to the list. 
 
To remove an image type, select a Image type from the list and click Remove.  
 

 Remember when you remove an image type the images stored under it will also be 
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lost. Image types 1 – 4 cannot be removed. 
 

 When a hand scan (Biometrics) is saved, uncheck the box in the column Displayable. 
The hand scanner  will save a template of the characteristics of the hand and not 
an image of  the hand.  
 

 
Image types 

 
Select Use custom size thumb nails, it is now possible to edit configured image types by clicking Edit. 
 
If you add new image types, the first new image type is type 5, the second will be type 6 and so on. 
 

 
 
Edit the name of an image type and change the quality of the image. 
 

• This feature is only available if pictures are stored as BLOB's 
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• The thumbnails are always stored in 8 bits/pixel. 
• The location needed to store an image is calculated as follows: (Width*Height)/1024KB 
• Standard aspect ratio for photos is 3:4 and for signature 4:1 

 
Do not use values greater than 2 times the default values. Using excessive values will degrade the 
performance of BadgeMaker because of the size of the images. 
 
When a hand scan must be saved, please uncheck the box in the column Displayable. The hand 
scanner will save a template of the characteristics of the hand and not an image of the hand.  
 
Click OK when changes have been made to return to the project set up. 
 
Click Next to progress. 
 

 
Fields in project 

 
Select the fields to use in the project, by default all are selected. 
 
Click Next to continue. 
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Step 4. Special Tables 
 

 
Special tables 

 
Store images in this table: Select here the table that will be used to store images. This table must 
have a fixed structure. (By default Image is already selected and cannot be changed). 
 
Log mutations in this table: Keep track of the mutations made in BadgeMaker by creating a logging 
table. Select here the table to log mutations in. (By default Log is already selected and cannot be 
changed). 
 
Click Next to proceed. 
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Step 5. Special Fields 
 

 
Special fields 

 
Specify a unique field: Select a Unique Field from the database. When an image is stored, 
BadgeMaker will copy this value into the field ID of the Image Table. 
 
Register tagged records in this field: To use the option Tag Records. A field has to be selected to 
register the tagged records. An unused numeric field in the database can be used for this purpose. If 
this is not available a field must be added to the database.  
 

 This field is not mandatory, but if it is not defined the option to tag records 
cannot be used. 
 
Store layout description in this field: If the Automatic layout feature is used a field must be selected 
where the layout description can be read. The layout descriptions displayed in BadgeMaker's main 
screen should match the values filled in the field. If this feature will not be used, no field should be 
selected. 
 
Every department has its own layout. For the field department a ‘pick list’ is created. All the 
department descriptions are filled in this list. The same descriptions must be used for the Badge 
layouts for the different departments in Badge Creator. If the automatic layout option is activated, 
the badges for every department will be printed automatically with its own layout. 
 
Click Next to proceed. 
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Step 6. Folders 
 

 
Folders 

 
Project folder: Location of the *.BM project file. 
 
Card layout folder: Location of badge layouts files. 
 
Encode layout folder: Location of encode files for magstripe and chip encoding. 
 
Logos folder: Advised location for logos used in badge layouts. 
 
Folder locations can be changed to another location of the operators choice. Click Folder, the 
following dialog is displayed. 
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Select a different location or create a new location if necessary. Selection of the desired folder can be 
done in the same way as in Windows Explorer Click OK to close. 
 
For each folder the remark pops up that the folder does not exists. 
 

 
 
Click Yes to create it now. (Repeat confirmation for the others which prompts the operator to confirm 
automatically). 
 
Click Finish, to close the dialog and save your settings. 
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Save new project 

 
Click Save to store the newly created database and specify a name for it. 
 
You are returned to the opening screen. 
 

 
BM Main screen 
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Structure of the Image Table 

BadgeMaker stores images as BLOBs (Binary Large Objects) in a table in the database. This has an 
advantage that you only need to backup your database. Alphanumeric fields can be used as Photo 
and Signature ID’s and you have the option of also storing image thumbnails.  
 
If you select this option, a table must be selected by clicking the Select Table button. If a table is 
selected without the appropriate structure an error message will be displayed. 
 

 
 
The Image table must be created using the database management system of your existing database 
(e.g. MS Access, Oracle, SQL Server, Sybase etc.). The name of the table is free to select (e.g. Pictures, 
Images or else), the table must consist of 4 fields with fixed names and fixed types in a fixed order. 
 

Image Table 
 

 
 
The type can be different depending on the database used. In MS Access the numeric fields can be 
Long Integers, the images must be of type OLE object. In Oracle the type for pictures is Long Raw or 
Binary. 
 

 The ID field in the Picture table is not unique; the same ID can be used with up 
to 20 types of pictures (photo, thumbnail photo, signature and thumbnail signature). 
ID and Type fields are unique (a combined index can be made). Do not create a relationship 
between the tables. 
 
Below the link between the Database table and the Picture table is displayed. BadgeMaker will take 
care of the link between the Photo or Signature ID in the Database table and the ID field in the 
Picture table. 
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Database table and the Picture table 
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Structure of the Logging Table 

The Logging table must be created using the database management system of your existing database 
(e.g. MS Access, Oracle, SQL Server, Sybase etc.).The logging option enables logging of user actions 
(mutations) in BadgeMaker. Select the table name in which these actions (Date, Time, Mutation and 
User name) will be logged. The database made must include the following fields: MUT_DATE,  
MUT_TIME, MUT_ACTION and MUT_USER. In addition one or more fields from the Database table 
can also be logged. The exact type and name of these fields must be included in the log table. The 
user has to take care of this himself.  
 
Use the database manager of the existing database to create the log table, then select this table by 
clicking the Select Table button. 
 

Logging Table 
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Open Project 

Select File Menu and then click Open, the open file dialogue is displayed. 
 

 
 

Select a valid project file (*.BM) file and click Open. You must log in before creating or selecting a 
project file (*.BM) file. When you have logged in and selected a project file to open, the Select data 
window will be displayed. 
 
 Options in this window enable the operator to select all or part of a database. 
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Select dialog 

 
A field name can be selected from the dropdown list, then an operator must be selected from the 
next dropdown list (=, <, >, <=, >=, <>, LIKE). Enter a value in the Field Value box. Add a condition of 
AND or OR, (for the first selected statement a condition is not applied). Click Add to add the selection 
statement to the list. This procedure can be repeated to add more selection statements if required. 
 

• OK: Select the records on specified criteria. 
• Select all: Selects all the records (can take some time when working with a very large 

database). 
• Clear: Removes the current selection. 
• Cancel: Closes the select dialogue, no selection will be made. 

 
Click on Select All if you want to work with an entire database. In some cases opening a large 
database entirely may take considerable time. Do not reset your system during this process or the 
database could be damaged. 
 
After selecting the entire database or part of it, within the specified criteria stipulated, the main 
screen will be shown. 
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Edit Project 

Select File Menu and click Edit Project to change project settings of a currently opened project 
(*.BM) file. 
 

Use   option from the toolbar. 
 

 
Edit project 

 
Select Save to save any changes made to the current layout. 
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General Settings 
 

 
General settings 

 
Project name: Specify a name for the project. This name will be displayed when the project is opened 
in BadgeMaker. In this example we have chosen EXAMPLE. 
 
Data retrieving method: By default Dynamic is enabled. If the ODBC driver of your database does not 
support Dynasets, you will receive an error message when you try to load the project in BadgeMaker.  
 
Default Image quality: Images are stored in *.JPEG format by BadgeMaker. The images are stored as 
BLOB’s (Binary Large Objects) in the database. The quality of the stored image can be set by 
specifying a value in this field. The default value is 50, this combines a good image quality with a good 
compression rate (images will be 20kB-25kB). Image quality can be improved by specifying a higher 
value but stored images will increase in size.  
 

 Depending on the database used the image size that can be stored as a BLOB will 
vary. If you increase the value too much, some databases might get a problem storing 
the images. If this problem occurs, lower the image quality to decrease the image 
size. 
 
Thumbnail image: Check this box to store a thumb nail image of the photos and signatures 
(in addition to the stored *.JPEG images). The thumbnail image is stored in a *.BMP format in 256 
colors with a reduced resolution. 
 
LDAP (Lightweight Directory Access Protocol) support: The ODBC driver for LDAP databases is not 
compliant with the ODBC drivers for other databases. Therefore BadgeMaker has to handle this 
driver differently than the others. Check this option if you connect to an LDAP database. In all other 
cases leave this option unchecked. 
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Image Files 

 

 
Image files 

 
BadgeMaker stores images in an image table usually, but it can also read image files from another 
location on the hard disk or from a CD Rom. Check Store images in folder option if you have ready-
made image files. 
 
The name of these image files must correspond with the value in the field specified in Step 5 under 
Specify Unique Field. This will depend on how the two tables in the database are linked together 
(Data Table and Picture Table). 
 
Select the Base folder for images and specify a folder destination. Different image types must be 
stored in the folder according to their image type number for example Photo = 1, Signs = 2 and so on. 
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Image Types 
 

 
Image types 

 
Apart from using the following image types Photo and Signature, other image types can be added 
such as Fingerprint. Click Add to configure more image types. The following dialog is displayed. 
 

 If you add new image types, the first new image type is type 5, the second will be type 6 and so 
on. 
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Special Tables 
 

 
Project settings 

 
Store images in this table: Select here the table that will be used to store images. This table must 
have a fixed structure.  
 
Log mutations in this table: Keep track of the mutations made in BadgeMaker by creating a logging 
table. Select here the table to log mutations in. 
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Special Fields 
 

 
Special fields 

 
Specify a unique field: Select a Unique Field from the database. When an image is stored, 
BadgeMaker will copy this value into the field ID of the Image Table. 
 
Register tagged records in this field: To use the option Tag Records. A field has to be selected to 
register the tagged records. An unused numeric field in the database can be used for this purpose. If 
this is not available a field must be added to the database.  
 

 This field is not mandatory, but if it is not defined the option to tag records 
cannot be used. 
 
Store layout description in this field: If the Automatic layout feature is used a field must be selected 
where the layout description can be read. The layout descriptions displayed in BadgeMaker's main 
screen should match the values filled in the field. If this feature will not be used, no field should be 
selected. 
 

 Every department has its own layout. For the field department a ‘pick list’ is 
created. All the department descriptions are filled in this list. The same descriptions 
must be used for the Badge layouts for the different departments in BadgeCreator. 
If the automatic layout option is activated, the badges for every department will 
be printed automatically with its own layout. 
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Folders 
 

 
Folders 

 
Project folder: Location of the *.BM project file. 
 
Card layout folder: Location of badge layouts files. 
 
Encode layout folder: Location of encode files for magstripe and chip encoding. 
 
Logos folder: Location of logos used in badge layouts. 
 
Folder locations can be changed to another location of the operators choice. Click Folder, the 
following dialog is displayed. 
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Field Settings 

Misc 
 

 
Misc dialog 

 
Field description: The field description is shown in top of the field columns. Field descriptions can be 
edited by entering another description. The actual field name cannot be changed, this can only be 
done with the database management system MS Access, Oracle, or SQL Server. 
 
Restrict input: This option is only available if a field is a text field. Input restrictions are used for 
magstripe encoding the options are ISO-numeric and ISO-character.  
 
Log this field: Check this option if the contents of this field should to be stored in a log table. 
 
Field style: Select whether a field is  view only or editable. 
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Pick List 
 

 
Pick list 

 
Has pick list: Enable this option if you want to create a list with predefined values to select from for a 
field. This option can be activated only when a field is editable. 
 
Has logo: Enable this option if you want to use a dynamic logo in your badge layout. 
 
Default value: Displays an item from the list which is selected as a default value. 
 
Move your cursor into the Pick list setup region and double click to begin constructing a pick list. 
 

 
Pick list 

 
Items: Displays available items in a list. The empty bar can be used to add new items. 
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Filename: Displays the filename of a logo linked to the items. Has logo must be enabled. 
 

 
 
Set default: Select to make the current item a default, the selected value will be displayed in the 
‘default value’ box. 
 
To add an item place the cursor on the empty bar and then click Edit button. Fill in the name of the 
new list item. Click OK to save the new item. When Has logo is enabled you can select a logo. Click on 
the button as shown below to browse for a logo. 
 

 
 
Delete an item: Select an item by clicking on it and click Delete. The item will be deleted 
immediately. 
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Auto Update 
 

 
Auto update 

 
This option can only be enabled when a field style is configured as View only.  
 
When: 
 
After print : Fill the contents of a field after printing. 
Before print : Fill the contents of a field after printing. 
New record : Fill the contents of a field after adding a new record. 
After image : Fill the contents of a field after adding an image. 
After export/Send mail : Fill the contents of a field after exporting data. 
After encoding OMC: Fill the contents of a field after encoding OMC (Optical Memory Card) 
 
With: 
 
Current Date: Fills the field with the current date, field type must be Date. To create an expiry date, 
the current date can be extended with a number of days, weeks, months or years. 
Random Number: Fills the field with a random number, field type must be ‘Numeric’. 
Addition: Adds a value to the current field value, this value can be specified by the user. The field 
type must be ‘Numeric’. This option can be used to create a version number of a printed card. 
Counter: Can be used to create a sequential number.  
Constant value: Can be used to fill in a constant value after an event. 
Workstation no: Can be used to register the workstation on which a photo was added or a card was 
printed. Check that the workstation is set correctly, select System menu and then click Setup. 
User: Can be used to register the user who added a photo, or printed a card. 
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Example 
 
The IDnumber field is selected, click Field Settings and then click the Auto Update tab. 
 

 
 
In this example when a new record is added a start value 100015 is automatically added to the 
IDnumber field, the next record added will be 100016 and the next 100017. Specifying Step = 1 
means that the Start Value increments by 1 after a new record is added.  
 

Mask Edit 
 

 
Mask edit 

 
Select Enable mask edit for this field to enable this feature. 
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A mask is a set of characters and mask characters that control what you can and cannot enter in a 
field.  A mask can require operators to enter for example dates or zip codes which follow specific 
conventions. 
 
When you enable mask edit for a field you find that you must use the permitted placeholders 
allowed. 
 
The following example demonstrates a mask edit for zip codes in the U.K. format: 
 
??# - #??       (represents XZ4 - 7PJ) 
 
___ - ___ 
 
This consistency can make data easier to locate and maintain. 
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View Options 

View options allow you to configure a style for fields. BadgeMaker uses the field style settings to 
determine how fields are viewed and edited. 
 

 
View options 

 
Not Visible: A field remains hidden to the operator. No access allowed. 
 
View Only: A field cannot be edited or changed. Read only access permitted. 
 
Editable: A field can be altered and edited if needed. No restriction applied. 
 
All fields or a range of fields can be changed. 
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Add Fields 

The Add Field dialog allows you to construct a database by adding fields to your database. It is 
important you choose fields carefully.   
 
You can immediately add a field by typing a Name, for example SurName, Firstname, Telephone 
number, and IDNumber among other useful fields. 
 

 Instead of creating a field FullName, consider creating fields Surname and Firstname. It is better 
to try and keep information in its smallest, more useful parts. 
 

 
Add field 

 
Name: Enter the name of the field you want to create. No spaces are allowed.  
 
Type: Choose from the drop down list type of field required; Text, Date, Integer, Counter, Logical, or 
Numeric. 
 

 Select a type when adding a field to ensure more accurate data entry. Roe example select TEXT 
for text fields, DATE to enter dates and so on. 
 
Size: Select a size for data stored as a Text, Number, or another field type. (We recommend leaving 
this as the default value 50). 
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Index: Speed up access to data in this field by building and using an index. Prevents you from adding 
duplicate values. 
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Advanced (MM integration) 

This feature allows you to print and encode Mifare and contact cards with Magna manager 
(MM) software. 
 
Use this option to integrate Magna Manager with BadgeMaker. 
 

 
MM integration dialog 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 113                                                                                                      

  

Close 

Select the File Menu and click Close. Use this option to close the current project file. BadgeMaker will 
not be closed the current user remains logged in. 
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New Badge 

To create a new badge layout (*.BC file) select File Menu, click New Badge. 
 

Use   option from the Toolbar. 
 
BadgeCreator will open automatically and you can begin creating a badge layout using 
the New Layout Wizard to incorporate data from project fields. 
 

 
New layout wizard 
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Edit Badge 

To edit an existing badge layout (*.BC file) select File Menu, click Edit Badge. 
 

Use   option from the toolbar. 
 
BadgeCreator will open and you can begin editing existing card layouts. 
 

 
BC main screen 
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Import 
Select the File Menu and select Import. It is possible to import data from Text Files 
(*.TXT;*.CSV;*.TAB), BadgeMaker DAT files (*.DAT) or Image files (*.IMG). 
 
A DAT-file is a special ASCII-file for managing a database. It means you can use a DAT-file for updating 
and adding records to an existing database. 
 

 Keep in mind imported records must have the same number of specified fields and 
in the same chronological order as fields appear in the project. 
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Importing Text Files (*.TXT, *.CSV, *.TAB)  

In case you choose the Text Files option and select a *.TXT; *.CSV or *.TAB file 
to import, the following dialog will be started. 
 

 
Data properties 

 
Select First row contains header. Leave unchecked if the import record does not contain a header 
row. 
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Character set options are OEM or ANSI. Decide which character set should be chosen depending on 
the how the data was stored and saved. This is also valid for the Field Separator. 
 
If unclear which character set to select, we recommend leaving the default setting in place, ANSI. 
 
Select Next. The Data preview dialog box is presented. 
 

 
Data preview 

Click Next.  
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The Data mapping dialog box is presented. Source fields must be paired together with a Destination 
field in order to compile the project. 
 

 Destination field refers to the fields configured in the project, and Source field represents the 
column or location of the selected fields. 
 
If a Destination field does not have a representation in the source field list, you can leave on default 
(>-Click-<). If a source field is mapped to a destination field make sure they are of the same type and 
the field length is accurate. A special case is the Destination field, which contains the unique 
identifier, in our example the destination field IDnumber is the unique identifier, and it can be 
mapped with the first column of the Source field 1. 
 

 
 
When mapping is completed, click Next. 
 
The Finish dialogue box is presented. It will present a summary of settings specified in the Import 
Wizard. Check the information presented, if everything looks correct click Finish to start importing. 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 120                                                                                                      

  

 
Finish import 
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Importing DAT Files (*.DAT) 

If you select a BadgeMaker DAT file for importing, the following dialog box is shown on the screen. 
 

 
Data properties 

 
Character set options are OEM or ANSI. Decide which character set should be chosen depending on 
the how the data was stored and saved. This is also valid for the Field Separator. 
 
If unclear which character set to select, we recommend leaving the default setting in place, ANSI. 
 
You can select the fields you want to import by highlighting them with your mouse. Certain Image 
types can be chosen and image formats can be selected from the dropdown list. 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 122                                                                                                      

  

 
Data & Images 

 
The following formats are available: 
TIF, BMP, DIB, RLE, FLF, CUT, PCX, DCX, PCT, GIF, JPG, TGA, RAS, IM8, CMP and JIF. 
 
Click Next. The Finish dialogue box is presented. It will present a summary of settings specified in the 
Import Wizard. Check the information presented, if everything looks correct click Finish to start 
importing. 
 

 
After clicking OK, the DAT-file will be read, using the following conditions. 
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1. A Primary Index has to be defined. This Primary Index has to be a unique field. If no Primary 

Index field was selected, an error message will be displayed. 
2. Each field in the DAT file must be separated by a | (pipeline). 

 
U = Updates the first record that matches the Primary Index, as defined in the BM-file. Only the 
selected fields are updated. If a record is not found, it will be added to the database with only the 
values filled for the Primary Index and the selected fields. 
 
A = The record will be added to the database no matter if the primary index already exists or not. It is 
not necessary to add the A, the same action will take place if you end every record just with a | 
(pipeline symbol). 
 
If image types are selected, BadgeMaker will also import them under the following 
conditions. 
 

1. Under the directory where the DAT file is situated, there must be a sub directory for every 
image type. The names of these sub directories are the same as names of the image types. 

2. The images must have the correct format selected in the dropdown list. 
3. Following the standard import-fields, the DAT-file must contain the image ID’s for every 

image type. 
 
An import *.DAT-file without photo and signature information can look as follows: 
 
100001|David|Johnson|Company Card|Software Development||||||||||||||U 
100002|John|MacPeason|DriverLicence|Sales||||||||||||||U 
100003|Veronica|Stewart|Iclass 2k Card|Employee||||||||||||||U 
100004|Rafael|Domingues|Iclass 16k1 Card|Project Engineer||||||||||||||U 
100005|Paul|Peterson|Iclass 16k8 Card|Customer Services||||||||||||||U 
100006|Abigail|Kamamoto|MedicalCard|Reception||||||||||||||U 
100007|Igor|Grabowski|NationalidCard|Software Development||||||||||||||U 
 
The same import *.DAT-file with photo and signature information can be as follows: 
 
100001|David|Johnson|Company Card|Software Development||||||||||100001|100001|||U 
100002|John|MacPeason|DriverLicence|Sales||||||||||100002|100002|||U 
100003|Veronica|Stewart|Iclass 2k Card|Employee||||||||||100003|100003|||U 
100004|Rafael|Domingues|Iclass 16k1 Card|Project Engineer||||||||||100004|100004|||U 
100005|Paul|Peterson|Iclass 16k8 Card|Customer Services||||||||||100005|100005|||U 
100006|Abigail|Kamamoto|MedicalCard|Reception||||||||||100006|100006|||U 
100007|Igor|Grabowski|NationalidCard|Software Development||||||||||100007|100007|||U 
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Importing Image Files (*.IMG) 

Select Import Images to import Images. Once selected you are presented with the following prompt. 
 

 
Data properties 

 
Character set options are OEM or ANSI. Decide which character set should be chosen depending on 
the how the data was stored and saved. This is also valid for the Field Separator. 
 
If unclear which character set to select, we recommend leaving the default setting in place, ANSI. 
 
Click Next to proceed. 
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Images only 

 
Select the Image types required for import and define an Image format. 
 
Click Next to proceed. The Finish dialog presents a summary of settings defined earlier. 
 

 
 
If the settings chosen are correct click Finish to begin importing. 
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Export 

Select File Menu and click Export. It is possible to import data from Text Files (*.TXT;*.CSV;*.TAB), 
BadgeMaker DAT files (*.DAT), IDX (*.IDX), Image files (*.IMG), WebData (*.WEB). 
 
A DAT-file is a special ASCII-file for managing a database. It means you can use a DAT-file for updating 
and adding records to an existing database. 
 

 
 
Select a destination directory to save the export file and give it a name. Select a file type from the 
drop down menu and start exporting. 
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Exporting Text Files 

In case you choose the Text Files option and select a *.TXT; *.CSV or *.TAB file to export the 
following dialog will be started. 
 

 
Data properties 

 
Character set options are OEM or ANSI. Decide which character set should be chosen depending on 
the how the data was stored and saved. This is also valid for the Field Separator. 
 
If unclear which character set to select, we recommend leaving the default setting in place, ANSI. 
 
Select Next. The Data mapping dialog box is presented. 
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Data mapping 

 
In the Data mapping dialog box select a destination to map to a source filed for the export.  
 
By default all Source fields are mapped to a destination field. You can edit mappings yourself if 
needed, it is also possible to mix and match Source fields to a Destination for example you can map a 
Source filed “Firstname” to Destination “Surname”. 
 
In our example we have kept Source and Destination as equal (recommended).  
 
Select Next to proceed. The Data preview is shown. 
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Data preview 

 
If you are content with the results click Next. 
 
An Exported ASCII-file can look as follows. 
 
IDnumber,Firstname,Surname,Layout,Function,PlaceOfBirth,Email,Phonenumber,Logo,CardSerialNo,
CardsIssued, 
100001,David,Johnson,Company Card, Software Development,Miami,,+31 79 
3601160,Soft,,1,,5/9/2008,,0 
100002,John,MacPeason,DriverLicence,Sales,Sydney,,+31 
793601160,Soft,,3,6/8/2007,5/9/2008,5/9/2011,0 
100004,Rafael,Domingues,Iclass 16k1 Card, Project Engineer,Acapulco,,+31 79 
3601160,OPS,,0,6/18/2007,,,0 
100005,Paul,Peterson,Iclass 16k8 Card, Customer Services,Kopenhagen,,+31 79 
3601160,OPS,,0,5/22/2007,,,0 
100006,Abigail,Kamamoto,MedicalCard,Reception,Osaka,,+31 79 
3601160,Manag,,2,5/23/2007,6/15/2007,6/14/2010,0 
100007,Igor,Grabowski,NationalidCard,Software Development,Minsk,,+31 79 
3601160,Soft,,0,6/14/2007,,,0 
 
The Finish dialog presents a summary of settings defined earlier. 
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Click Finish to begin importing. 
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Exporting DAT Files (*.DAT) 

If you select a *.DAT file for exporting, the following dialog box is shown on the 
screen. 
 

 
Data properties 

 
The Field Separator remains disabled in this case. Click Next to proceed. 
 
Character set options are OEM or ANSI. Decide which character set should be chosen depending on 
the how the data was stored and saved. 
 
Click Next to proceed. 
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Data & images 

 
Select the Fields and which Image types to include in the Export. Click Next to proceed. 
 
Below illustrates the differences when you produce an export file without an Image type and when 
you produce an export file with an Image type specified. 
 
An Export *.DAT file without photo and signature information can look as follows: 
 
100001|David|Johnson|Company Card|Software Development||||||||||||||U 
100002|John|MacPeason|DriverLicence|Sales||||||||||||||U 
100003|Veronica|Stewart|Iclass 2k Card|Employee||||||||||||||U 
100004|Rafael|Domingues|Iclass 16k1 Card|Project Engineer||||||||||||||U 
100005|Paul|Peterson|Iclass 16k8 Card|Customer Services||||||||||||||U 
100006|Abigail|Kamamoto|MedicalCard|Reception||||||||||||||U 
100007|Igor|Grabowski|NationalidCard|Software Development||||||||||||||U 
 
The same Export *.DAT file with photo and signature information can be as follows: 
 
100001|David|Johnson|Company Card|Software Development||||||||||100001|100001|||U 
100002|John|MacPeason|DriverLicence|Sales||||||||||100002|100002|||U 
100003|Veronica|Stewart|Iclass 2k Card|Employee||||||||||100003|100003|||U 
100004|Rafael|Domingues|Iclass 16k1 Card|Project Engineer||||||||||100004|100004|||U 
100005|Paul|Peterson|Iclass 16k8 Card|Customer Services||||||||||100005|100005|||U 
100006|Abigail|Kamamoto|MedicalCard|Reception||||||||||100006|100006|||U 
100007|Igor|Grabowski|NationalidCard|Software Development||||||||||100007|100007|||U 
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The Finish dialog presents a summary of settings defined earlier. 
 
Click Finish to begin exporting. 
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Exporting IDX Files 

If you select a *.IDX file for exporting, the following dialog box is shown on the screen. 
 
An *.IDX file only exports images to another file location. Save your *IDX file in your desired location, 
the images will also be exported and saved in the same location. 
 

 
IDX export 

 
By default the Counter option is turned on. A counter replaces the name of the photo. 
 
Click OK to begin exporting. 
 
An exported *.IDX file can look as follows (With Counter switched on). 
 
100001      1.JPG        
100002      2.JPG        
100003      3.JPG        
100004      4.JPG        
100005      5.JPG        
100006      6.JPG        
100007      7.JPG   
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IDX Export 

 
Switch off the Counter option to automatically rename images to a selected field. 
 
Click OK to begin exporting. 
 
An exported *.IDX file can look as follows (Field set to Surname, Counter switched off) 
 
100001      Johnson.JPG  
100002      MacPeason.JPG 
100003      Stewart.JPG  
100004      Domingues.JPG 
100005      Peterson.JPG 
100006      Kamamoto.JPG 
100007      Grabowski.JPG 
 

 Images are stored in the same directory as the *.IDX export file. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 136                                                                                                      

  

Exporting WEB Files (*.WEB) 

If you select a *.WEB file for exporting, the following dialog box is shown on the 
screen. 
 

 
Data properties 

 
The Field Separator remains disabled in this case. Click Next to proceed. 
 
Character set options are OEM or ANSI. Decide which character set should be chosen depending on 
the how the data was stored and saved. 
 
Click Next to proceed. 
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Data & Images 

 
Select the Fields and which Image types to include in the export. Click Next to proceed. 
 

 
 
The Finish dialog presents a summary of settings defined earlier. 
 
Click Finish to begin exporting. 
 
An exported *.WEB file can look as follows. 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 138                                                                                                      

  

 
100001|David|Johnson|Company Card|Software Development| 
100002|John|MacPeason|DriverLicence|Sales| 
100003|Veronica|Stewart|Iclass 2k Card|Employee| 
100004|Rafael|Domingues|Iclass 16k1 Card|Project Engineer| 
100005|Paul|Peterson|Iclass 16k8 Card|Customer Services| 
100006|Abigail|Kamamoto|MedicalCard|Reception| 
100007|Igor|Grabowski|NationalidCard|Software Development| 
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Encode Chip 

Select File Menu and then click Encode Chip or click  in the Toolbar to simulate manual chip 
encoding.  
 
The manual encode function from the chip *.dll will be activated.  
 

 
Encode chip simulation 

 
You can select whether you want to encode only the current record, all records or only the tagged 
records.  
 
If you encode only tagged records, you have the option to un-tag these records after encoding. The 
option Tagged records is only available if one or more records have been tagged. 
 

 
Encode chip simulation 

 
 Encode Chip manually will work only if a suitable chip encoding *.dll has been added to the SC 

directory (C:\SC\ BM.....). 
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Click Yes to simulate success. ChipInit dialog will close. 
 
Click No to simulate a failure. The following dialog will simulate a failure. 
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Encode OMC 

Select File Menu and then click Encode OMC or click  in the Toolbar to simulate manual chip 
encoding.  
 
Select this option to simulate manual OMC encoding (encoding of an Optical Memory Card).  
 

 This is only optional if using an Optical Memory Card. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 142                                                                                                      

  

Print 
Click the Print button on the toolbar  or select File Menu and then click Print. 
 
Use this command to print badges from either a selected tagged record(s), current record or all 
records. 
 
Select File Menu and then click Print, the following dialog is presented. 
 

 
Print dialog 

 
The printers that are available from your computer are listed in the drop down menu under Name. 
Click the printer you want to use.  
 
Click Properties to view and edit driver settings, encode settings, print settings. The options available 
will depend on the type of printer installed. 
 
Print to File: Prints a document (badge) to a file and not directly to a printer. The document is saved 
as a *.prn file and can be printed on other printers. 
 
Print Range: Specify to print an entire document, specific pages, or a portion of the document. 
 
Copies: Type the number of printed copies to print. 
 
Click on a record in the database view or find a record using Find from the Record Menu. 
 
Select Current in the print range section to print the current record. 
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Print Setup 

Select File Menu and click Print Setup.  
 
You can select paper size and orientation. 
 

 
Print setup dialog 

 
Click Properties to view and edit driver settings, encode settings, print settings. The options available 
will depend on the type of printer installed. 
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Print Preview 

Select File Menu and click Print Preview.  
 
Use this command to preview a badge design before printing. This is useful when checking data on a 
badge is represented correctly before sending.  
 
Select the Side Menu, you can choose to view the front or back of the layout. 
 

 
Print preview (Front) 
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Print preview (back) 
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Recent Files 

 Select File Menu, towards the bottom on the menu you will notice a list of recently opened project 
files (*.BM). 
 

 
 
BadgeMaker will keep a list of recently opened projects. 

Exit 

Select File Menu and click Exit. BadgeMaker will close down. 
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Record Menu 
The Record Menu appears as the second item in the menu bar, and contains commands relating to 
the handling of records such as browsing records, adding records, editing and deleting records. You 
can run a search and tag records from here. 
 

 
Record Menu 
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First 

Use  option from the toolbar or select from the Record Menu and click First to go to the first 
record in a project. 

Next 

Use  option from the toolbar or select from the Record Menu and click Next to go to the next 
following record in a project. 

Previous 

Use  option from the toolbar or select from the Record Menu and click Previous to go back to a 
previous record in the database. 

Last 

Use   option from the toolbar or select from the Record Menu and click Last to go to the last 
record in a project. 

Refresh 

Use  option from the toolbar or select from the Record Menu and click Refresh to keep and 
settings up to date on the screen. 
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Edit 

Select the Record Menu and click Edit to open the Edit dialogue box. In this dialogue the contents of 
the fields can be edited, provided that the fields are marked as editable and the underlying database 
allows the user to edit the fields. 
 

 
Edit record 
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Add 

Use  option from the toolbar or select the Record Menu and click Add to open the Add dialog 
box. In this dialogue a new record can be created and added to the database. 
 

 
New record 

 
Fill in the required information to add. Once completed click OK to save the new record, or select 
New to create another record. 
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Delete 

Use   option from the toolbar or select from the Record Menu and click Delete to delete a new 
record in the database. 
 

 This option is only enabled if a record is tagged. 
 
Tag one or more records and then click Delete, the following dialog is shown. 
 

 
 
Choose Delete data and image(s) (complete record and images are removed) or Delete image(s) 
only. 
 
If you choose to delete images then the Advanced button is enabled, click Advance and the following 
screen is shown. 
 

 
Advanced 

 
Select which images should be deleted, and then click OK. 
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Find 

Use  option from the toolbar or select from the Record Menu and click Find to search one or 
more records from the current database. 
 

 
Find dialog 

 
Only records specified with in a search will be displayed in the database window. To return to the 
initial selection right click inside the database and select SQL Select, click Select All and then confirm 
selection by clicking Yes. 
 
You can also search on the contents of a field by pressing F3 on your keyboard. 
 
The search function will search the selected record set. However if the = (equal sign) is used, the find 
option will search the entire database. This enables the user to work with a predefined record set, 
but adds the flexibility to search for a particular record in case of urgency such as a new card being 
issued to replace a lost or expired card. 
 
Field name: The dropdown menu enables the user to select a field name on which the sorting is 
based upon. 
 
Operator: The =, <, >, >=, <=, <> or LIKE operators are used in correspondence with the selected 
field value. 
 
Field value: Fill in the value to search for, or use the drop down list to select a value of an 
earlier cached entry. 
 
This example we will search for a record by a person’s surname. To search for the surname ‘Johnson’ 
select a field name, type “Johnson” in the Field Value edit box and choose the  =  operator. The 
specified field value “Johnson” is found and displayed. 
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SQL Select 

Use  option from the toolbar or select from the Record Menu and click SQL Select to select or 
deselect a group of records in the database.  
 
You can also start SQL Select by clicking the right mouse button within the database window, and 
then click SQL Select. 
 

 
Select dialog 

 
A Field name can be selected from the dropdown list, then an Operator must be selected from the 
next dropdown list (=, <, >, <=, >=, <>, LIKE). Enter a value in the Field value box. Select the type of 
selection AND or OR (first entry does not need a condition applied). Click Add to add a condition.  
 
This procedure can be repeated to add more conditions to your search. 
 
OK: Select the records on specified criteria. 
Select all: Selects all the records (can take some time when working with a very large database). A 
confirmation will be asked if you are sure you want to select all records. 
Clear: Removes the current selection. 
Cancel: Closes the select dialogue, no selection will be made. 
 
If you choose to Select All records you will see a warning message appear. 
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Select Yes to confirm your choice or No to cancel and define a search further. 
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Predefined Conditions 

Select the Record Menu and then click Predefined Conditions to open the dialog box. 
 

 
Predefined conditions 

 
Use this option to define conditions which can be stored under four presets listed under Predefined 
Conditions. One of these presets can be used as a default condition at startup.  
 
To create a predefined condition: 
 

• Select one of the four presets…. 
• Add the required condition(s)…. 
• Click Save to store the condition(s) under the selected preset…. 
• Repeat these steps for the other presets…. 
• Assign one of the presets as default…. 

 
If an operator chooses to use a preset to define a condition to a project at startup then the SQL select 
dialogue will not be presented, but the default selection will be performed on the database 
automatically. 
 
 
 
 
 
 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 157                                                                                                      

  

Tag All 

To use select Record Menu and then click Tag all.  
 
Use this option to tag all records in the selection. Tagged records can be used to print cards, export, 
delete or to print a list from. 
 

Untagged 
 

 
 

Tagged 
 

 
 

You can also tag records individually by selecting the box next to the record, for example deleting a 
record or printing a record. 
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Remove Tags 

To use select Record Menu and then click Remove tags.  Use this option to remove all tagged records 
in the project. 
 

Untagged 
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View Menu 
The View Menu appears as the third item in the menu bar, and contains commands relating to hiding 
or showing image windows such as photos, signatures or fingerprints. You can hide or show the 
toolbar and status bar and change the appearance of BadgeMaker's main screen such as changing 
the font or selecting another language. 
 

 
View menu 
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Image Windows 

Image Windows are separate windows which are always displayed on the Main Screen. When an 
image is acquired the image is stored under an active image type. 
 

Images 
 

   
 
BadgeMaker offers up to 20 image types. The photo and signature windows are the most 
well known and most commonly used image types. Each image window can be displayed 
separately. 
 
Select View Menu and then select Image Window. 
 

 
Image window 

 
There exists an option to Show All image windows, Hide All image windows or select an individual 
image window. 
 
Image windows can be resized by dragging with the mouse pointer on one of the corners. 
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By using the right mouse button a small menu can be activated with the following options: 
 

 
 
Hide: Closes the window. 
Acquire: Activates the selected TWAIN driver or direct driver to capture a new image. 
Adjust: Opens the ‘Adjust’ dialogue which enables you to adjust the brightness, contrast or gamma of 
the image (BCG tab). It can also be used to rotate the image in steps of 90 degrees (rotate tab) and to 
sharpen or soften the image (filter tab). 
Copy: Copies the image to the clipboard. 
Paste: Pastes the image from the clipboard in the image window (and stores it into the database). 
Save: Save the current image. 
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Auto Arrange 

To select click the View Menu, then move the mouse pointer so it highlights Image Window and then 
click Auto Arrange. 
 
Check this option to arrange the image files automatically next to each other under the database 
grid. 
 
 

 
Auto arrange 
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Options 

Select the View Menu and then select Options. 
 

 
 
Font 
 
Select Font to change the font for text in the grid. You can select various Font types, Font Styles, 
Font size and Font color. In the Sample area you can preview your customized settings. 
 

 
Font 

 
Select Language to modify the language of all Top Menu items and Dialog boxes with in BadgeMaker 
and BadgeCreator.  
 
By default English (US) is the preset. 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 164                                                                                                      

  

 
 

You can change the appearance to reflect the area of the world you live in. 
 

 Please consult your dealer when the desired language is not available. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 165                                                                                                      

  

Image Menu 
The Image Menu appears as the fourth item on the menu bar, and contains commands relating to the 
handling of image files such as copy, paste, and save. You can acquire images and select a source 
from here.  
 

 
Image menu 
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Copy 

Use  option from the toolbar or select from the Image Menu and click Copy to copy data onto 
the clipboard. When you copy an image or data, you are making a duplicate of the original item, you 
can then modify, delete or save images independently of the original. 

Paste 

Use  option from the toolbar or select from the Image Menu and click Paste to paste 
data from the clipboard which you have copied previously. 

Save 

Select from the Image Menu and click Save to save data and images. 
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Adjust 

Use Adjust to adjust the image in the active image window. 
 
Click on the window of the desired image type to make it active. Right click inside the image window 
and click on Adjust. 
 

 
 

When you select Adjust, the Adjust Image dialog is displayed. 
 
BCG Tab 
 
Change the brightness, contrast or gamma by moving the slide bars. The result is directly visible in 
the image window. Click OK when the desired result is attained. Click Reset to undo any changes 
made to the image or click Close to undo changes and close the dialogue box. 
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BCG 

 
Filter Tab 
 
Use this option to soften or to sharpen the image. The result will be visible after clicking Apply 
button. Click Reset or Close if the result is not satisfying. 
 

 
Filter 

 
Rotate Tab 
 
Use this option to rotate the image 90, 180 or 270 degrees. The result will be visible after clicking 
Apply button. Click Reset or Close if the result is not satisfying. 
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Rotate 
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Acquire 

Use this function to add an image to the image database. The image type that will be acquired is 
equal to the type of the active image window selected.  
 
Click on the window of the desired image type to make it active. Right click inside the image window 
and click on Acquire. 
 

 
 
Production of the image depends on what input source has been configured. 
 
The input source to acquire an image can be selected under Select Source (listed also in the Image 
menu). 
 
BadgeMaker has the possibility to acquire existing files, by using the option Load from file. In this 
way graphic files of different formats can be selected and linked directly to the current record. Keep 
in mind that the graphic files already must have the correct ratio to show on the Badge Layout (this 
prevents distortion of the image). 
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Acquire Image from Image File 

To acquire a photo from a file select Image Menu, then click Select Source. 
 

 
Select source 

 
If File is selected (default), the following dialogue will come up when acquiring an image.  
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In this way graphic files of different formats can be selected and linked directly to a record. Keep in 
mind that the graphic files already must have the correct ratio set in the Badge Layout (an incorrectly 
set ratio results in parts of the photo missing). 
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Acquire Image from Digital Camera 

To acquire a photo from a Digital Camera select Image Menu, then click Select Source. 
 
Once you have selected the correct Image Source to the Image type (Photo), select Acquire to 
capture photos using the SC Digital Camera plug-in. 
 

 
 
The SC Digital Camera window is presented to capture images. 
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SC Digital Camera plug-ins 

 
Place the subject in the image frame until you are happy with the position. Click Freeze to take a 
snapshot. 
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SC Digital Camera plug-ins 

 
Next you must crop the image as required and click Accept Transfer. 
 

 
 
Click Yes to accept the captured image or No to cancel transferring the image.  
 
Click Yes, the photo is now added to your database and bound to a record. 
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Captured Image 

 
Settings 

 

 
Settings 

 
Select your desired language by clicking the Language dropdown menu.  
 
Select a BadgeMaker Size from the drop down menu. You can select various sizes to store your 
photos. 
 

 
 
Selecting a lower value scales down the image size stored. This is advisable if working with large 
databases with many images. 
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Zoom In & Zoom Out 
 
Use the slider on the right hand side to zoom in and zoom out to adjust the image. 
 

 
 

If your camera is not connected or switched on, you will receive the following dialog box. 
 

 
 

Click OK, and make sure the camera is powered on and connect to the computer. 
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Acquire SC Signature 

To acquire a signature image you must configure a source. 
 
Once you have selected the correct Image Source to the Image Type (Signature), select Acquire to 
capture signatures using the SC Signature plug-in. 
 

 
 

The SC Signature Capture window is presented to capture signatures. 
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SC Signature Capture dialog 

 
Using the signature pad create a signature as shown below. 
 

 The signature window size may change depending on what tablet is being used. 
 

 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 180                                                                                                      

  

Once you are happy with the quality of signature click Accept to keep the image or if not content 
with the signature quality click Erase to create another. 
 
Click Accept, the following screen is presented. 
 

 
SC Signature Capture dialog 

 
Select Settings to adjust the image if required. The following dialog is presented. 
 

 The default Line Thickness is good for most signature capturing. Only adjust if needed. 
 

 
Settings 

 
Select a Line Thickness from the drop down menu. 
 
The following choices are presented. 
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Choose line thickness 

 
For this example Medium (4) is selected which gives a good overall image quality for signatures.  
 
Selecting a higher value such as Thickest could cause the signature image to become unreadable. 
Selecting Thinnest could cause the image to degrade in quality and fade. 
 
Once you have selected a Line Thickness click OK to close and return to the SC Signature Plug-in 
window. 
 
Select OK to transfer the image. 
 

 
 
Confirm you want to overwrite by clicking Yes. 
 
The following Image window is updated and your new Signature is saved into BadgeMaker. 
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Acquire SC Biometrics 

Select the correct image type such as the “Finger Image” window for example, and click Acquire. 
 
The Crossmatch finger scanner will initialize. After a short communication with the scanner, the SC 
Biometrics window will appear. 
 

 
 Biometrics plug-in 

 
Follow the instructions on the screen carefully and scan all required fingers. 
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When a finger is scanned successfully it will be displayed with a green border around it. The red 
arrow on the right of the screen will indicate which finger should be scanned. Each finger is displayed 
on a separate row. The columns represent the number of scans. 
 

 
 
If you scan the same finger by mistake, you will receive an error message. 
 
When all fingers were scanned successfully, you will see the following dialog. 
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Select Transfer to save the scanned fingers in the database. The images and templates of the 
scanned fingers will be stored in one BLOB (Binary Large Object). 
 
In the image window the text template will be displayed. 
 
Finger images can then be displayed on a badge. Finger images and templates can be stored in 2D 
Barcode, in a contact chip or in a Mifare chip. 
 

 Please note that the finger images in general are too big to store in a barcode or Mifare chip and 
is not commonly done unless requirements insist. 
 
After saving the biometrics data, you can begin finger verification to Verify Biometrics. 
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Select Source 

BadgeMaker can use various input devices to obtain images. Select Image Menu and click Select 

Source or select from the toolbar the  icon. 
 

 
Select source 

 
Select an Image type to link to an Input source. 
 
If these devices use a TWAIN driver you can select the TWAIN driver as a source by clicking the 
TWAIN button, otherwise click the Custom button for a list of other input sources. 
 
Open Select Source to select the TWAIN driver for your input device.  
 

 
Sources 

 
Select and click Advanced at the bottom.  
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Advanced button 

 
You can select which sources will generate an “Overwrite existing Image” confirmation message. The 
operator must input Yes to confirm or No to cancel overwriting. 
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Select Source for Digital Camera 

Choose Select Source from the Image Menu. 
 

 
Select source 

 
Select the desired image type Photo to link to the SC Digital Camera image source. 
 

 
Custom 

 
Select SC Digital Camera from the Custom dropdown list. 
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Select Source for SC Signature Pad 

Choose Select Source from the Image Menu. 
 

 
Select source 

 
Select the desired image type (Sign) to link to the SC Signature Pad source. 
 

 
Custom 

 
Select the product driver from the Custom dropdown list. In this case a TOPAZ signature board has 
been installed, the corresponding device driver must be selected to initiate the device and begin 
capturing signatures. 
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Select Source for SC Biometrics 

Choose Select Source from the Image Menu. Select the desired image type to link to the SC 
Biometric image source. Select SC Biometrics from the Custom dropdown list. 
 

 
Select source 

 
Click the Bio Settings button. To modify device settings. 
 

 
Bio Settings 

 
If you check Execute Scan on start-up the scanner will directly start after selecting 
Acquire. 
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Scanner 
 
Select your device model from the drop down list. 
 
Security 
 
Select the level of security. Low security will allow easy and quick scanning but there is a chance 
different fingers will give a positive match. If you select the maximum security the verification is more 
secure but sometimes it is difficult to enroll all fingers. It is best to start with a high level of security, 
in the case the finger enrollment causes errors you can step down a level on security. 
 
Scans 
 
ScreenCheck advise to make at least two scans. If you do only one scan, there is a good chance that a 
finger is unsuccessfully enrolled. 
 
By clicking with your mouse pointer on a finger tip you can select a finger to be scanned. You can 
scan up to four fingers. To select multiple fingers hold down the <CTRL> button whilst clicking with 
the left mouse button on a finger. 
 

 
Bio Settings 
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Bulk Input 

Select the Image Menu and then click on Bulk Input, or on the toolbar click  and the following 
screen will be presented. 
 

 
 
Bulk Input can give the operator an easy option to add photos to a database from a photo form with 
a barcode.  
 
The bulk input option was made to make the grabbing of photo from input forms easier and quicker. 
Photos are attached on a form with a barcode. The photo must be exactly positioned in the frame 
printed on the form. The barcode used on the form must be positioned on the top right or top left 
corner of the form. It will be recognized automatically by the barcode scanner. Each barcode will be a 
unique identifier for a record in the database. 
 
The dialogue has three drop down boxes (one to select a field, one to select an SQL operator: =, >,<, 
LIKE etc. and another to select a field value recently used). This dialogue is modeless and will remain 
visible until it is closed. With the mouse it can be moved to the position on the screen where it will be 
best visible during the process. The default field name will always be the argument the user last 
worked with. 
 
The operator can type in a Field value or scan the barcode on the form. To do so the inquiry form will 
be laid under a video camera and a barcode scanner mounted in a repro standard. The barcode 
scanner must be programmed to be always active. As soon as the input form is laid under the repro 
stand and the barcode is recognized by the scanner, the value will be displayed in the Field value box.   
 
When a form has been scanned the photo capturing window will be presented where the photo can 
be edited or cropped further using TWAIN. When satisfied with the image click Transfer. The photo 
will be captured from the form and saved as a BLOB (Binary Large Object) in the Image table. 
 
In case no record matching  the barcode can be found, a warning dialogue will popup. Click Close to 
close the pop up, now the user will have the possibility to try a new barcode scan or to search for a 
different field by selecting one of the available fields from the drop down list. 
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 The number of Field names will differ depending on the size of the database and how 
many fields are configured. 
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Verify Bio 

The option Verify Bio is only available when SC Biometrics has been installed, if SC Biometrics is not 
installed than Verify Bio will remain disabled. 
 

 
 
SC Biometrics can carry out verification matching a current taken scan with the saved characteristics 
of a scan in the database. This is useful to identify an existing person in the database or to verify scan 
is operating successfully. 
 

 
SC Biometrics 

 
To verify a taken fingerprint for example click Verify. 
 
Present one of the indicated fingers and lay it onto the surface of the scanner. The finger is scanned 
and matched to the current selected image in the database. If the verification was successful you will 
see Access Approved in green. If the verification process is unsuccessful you will see Access 
Approved in red. 
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SC Biometrics 

 
Verify does not acquire an image. You must select Acquire to obtain an image. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 196                                                                                                      

  

Identify Bio 

To access select Identify Bio from the Image Menu.  
 
Select this feature to search the database for an individual record based upon his/her fingerprint. 
Record details of the individual are presented when the biometric fingerprint has been scanned and 
verified. 
 

 This feature is only available if a Fingerprint template exists in the database. The Finger 
Template window must be active in order to select Identify Bio from the Image Menu. 
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User Menu 
The User Menu appears as the fifth item on the menu bar, and contains commands relating to the 
handling of logging on and logging out of BadgeMaker. You can change your password from here. 
 

 
User menu 
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Login 

To be able to open a project (*.BM file), you must login first.  
 

To logon click   from the Toolbar. The following logon screen is displayed. 
 

 
Login dialog 

 
Features and functionality are heavily restricted without logging into BadgeMaker. 
 
The login procedure also gives you an authorization level. Each user is a member of a group. The 
group determines the user level. (Security) 
 
User: Type your user name and press <TAB> 
Password: Type your password and press <ENTER> 
 
The default user name for BadgeMaker is: SUPERVISOR 
The default password for BadgeMaker is: SUPERVISOR 
 
To secure access to BadgeMaker we advise to change the password as soon as possible. 
 
If you type a password incorrectly the following message is displayed. 
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If the default user/password combination does not work, the system administrator (operator who 
installed BadgeMaker). Refer to him/her for your login name and password. You can also start 
BadgeMaker by opening a project file (click Open from the File Menu); the login screen will be 
displayed. You must first login before it is possible to open and create projects. 
 
If you stop working with BadgeMaker, please close the project or exit the program, to prevent 
improper use. 
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Logout 

To logout click   from the Toolbar. 
 
Use this option to logout from BadgeMaker and to close the currently opened database. BadgeMaker 
will stay open for a new user to log in. 
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Change Password 

Select the User Menu and click Change Password. The following dialog box will be displayed. 
(Operator must already be logged into BadgeMaker) 
 

 
 
This option enables a user to change his/her password without the assistance of the supervisor. Type 
your old password and then type a new password.  
 
Confirm your new password and click OK to save changes. 
 

 
 
You can now login using your new password. 
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System Menu 
The System Menu appears as the sixth item on the menu bar, and contains commands relating to the 
handling of creating users, adding favorites and configuring auto login to BadgeMaker. You can 
configure BadgeMaker system settings from here.  
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Setup 

The Setup dialog box is used to specify and configure Workstation settings, Auto Import settings, 
Int. 2of5 bar code settings. 
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Workstation Settings 

To use select the System Menu, then click Setup, and then click Workstation Settings. 
 

 
Workstation settings 

 
WS No.  
 
This is important when working in a multi user environment with BadgeMaker. Every workstation 
number has to be unique in order to ensure user independent access to the database is achieved. 
One computer will set a WS No of 1, another computer will set a WS No of 2 and so on. 
 
Settings 
 
General Settings 
 
Use Automatic Layout: If an extra field with a layout name is added to the database this field can be 
used for automatic layout selection when printing. This field must be configured as the layout field. 
The layouts (as displayed in the layout selection drop list in BadgeMaker, see Layout Selection) must 
be filled in manually in this field. Another option is to create a dropdown list with a number of 
various available layouts.  
 
Tag Record After Insert: New and imported records will be automatically tagged when inserted.  
Remove Tag After Print: Tags will be removed as soon as records are printed. 
Automatically Open Last Used Project File: Enable this option to open the last used project file 
automatically the next time you enter BadgeMaker. 
 
Import/Export 
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Import Orphan Images: Use this option to import images without a related index file. The link 
between image and record will be made based on the image name and the value in the primary index 
field. 
 
Printing 
 
Print One Card Per Document: Enable this option when you use chip encoding. For every card sent to 
the printer a document will be created. Disable this option when you want to use pipeline printing on 
a multi station printer. 
Enable Direct Print: This option must be checked in order to correctly print and encode in one single 
run, without the printer spooler interfering in the process. 
Normal Print (do not mirror): Normal printing (print as designed) 
Mirror Horizontally: Mirror image (flip horizontal) is used to reverse an image left to right.  
Mirror Vertically: Mirror image (flip vertical) is used to reverse an image top to bottom. 
 

 As soon as you click Apply the mirrored preview will be visible at the right part of the 
BadgeMaker main screen. The full size preview will also be displayed as mirrored. 
 
Laser Engraving 
 
Enable: Enable this option if you are using a Optical Laser Engraver instead of a normal card printer. 
The print dialog will be different in this case and BadgeCreator will have some extra features to 
configure the settings for the engraver. 
 
Chip Encoding 
 
Disable Number of Copies in Print Dialog: Prevents user from printing copies of a card (without being 
noticed). 
Disable print to file in print dialog: Prevents a user from sending graphic information to a file. 
Chip encode only (no print): Use this option if you wish to encode a chip on a card without printing 
graphical information on it. This is useful when testing an encode layout. 
Continue with next card after chip encode error: When you enable this option, the print process will 
not be stopped after a chip encode error. Instead the card with the encode error will be ejected and 
BadgeMaker will continue the process with the next card. This option is particularly useful when your 
direct card printer has a separate card hopper for faulty cards. 
Advanced Print: This option can be used to retrieve records and print cards based on the information 
read from the chip embedded on the card. 
Bulk Encoding OMC Manually: Check this option if the Lasercard OMC reader and software is 
installed. With this option a series of cards can be encoded Manually. 
Bulk encoding (and printing) OMC inside printer: Check this option if the Lasercard OMC reader and 
software is installed. With this option a series of cards can be encoded inside the printer. 
 
Find and Select Options 
 
Match Case: Find and select arguments which are case sensitive. 
Ascending: By default search results are set to ascending. 
Descending: Set the order of a search in descending order. 
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Bulk Input 
 
Bulk Input Image: The selected image source will be opened automatically when a record is 
retrieved.  
Bulk Input Data: The selected Image source will not be opened but instead the Edit dialog will be 
opened automatically when a record is retrieved. Select which type of bulk input you would like to 
use for your barcode forms.  
 
Record set 
 
Database Update Fix: Some specific ODBC drivers could return update errors in combination with 
BadgeMaker. Since most current ODBC drivers work without problems, we advise to leave this option 
unchecked unless you receive update error messages from your ODBC driver. 
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Automatic Import 

To use select the System Menu, then click Setup, and then click Auto Import. 
 
By clicking on the field names, the fields to be imported will be highlighted in the list. The highlighted 
fields will be imported; fields which are not highlighted will be ignored.  
 
You can select all fields at once by pressing the CTRL <A> key combination. 
 

 
Automatic Import 

 
When this check box is set a DAT file is placed in the data directory with the same name as the *.BM 
file and will be automatically imported after the *.BM file is opened. After an import the DAT file will 
be deleted automatically. When no DAT file is available when opening a *.BM file, BadgeMaker will 
start up as normal without prompts. 
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Int. 2of5 Barcode 

To use select the System Menu, then click Setup, and then click Int. 2of5 bar code. 
 
Interleaved 2 of 5 bar codes is a numeric only barcode used to encode pairs of numbers into a self 
checking barcode format. The Interleaved part is a digit encoded in the bars and the next digit is 
encoded in the spaces. The encoded digits are "Interleaved" together to form a number's only 
barcode. 
 

 
Int. 2of5 bar code 

 
Check digit for interleaved 2 of 5 bar code 
 
Use Check Digit: When using the 2 of 5 bar code, you can choose to use a check digit, an extra 
verifiable control if the bar code number is correct. 
 

 Interleaved 2 of 5 is a self-checking barcode type, meaning that a check character is not required 
for a barcode scanner to read it. However many implementations include a Check Digit to assure 
data integrity. 
 
Check Digit Properties 
 
Modulo: Specify a checksum. Default is 10.  
 
Calculation Method 
 
Normal: The check digit is the remainder of the sum of digits of the barcode divided by the modulo. 
Inverse: Inverted, the modulo of 10 will be placed before the barcode. 
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 The number 10 is converted to 0 
 

Example of a Int 2of5 Bar Code 
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Security 

Select System Menu and then click Security. The following window will be presented. 
 

 
Authorization 

 
In order to secure and restrict users from accessing certain features in BadgeMaker you must decide 
what tasks and actions users and groups will perform. Tasks and actions that a user or group of users 
can perform are determined by the rights assigned to them.  
 
For example a user who is a member of the Administrators group can create a new badge and edit 
projects whereas a user who is a member of the Users group cannot modify projects or create new 
badges. 
 

 To create new users and specify user groups, you must be a member of the Administrator's 
group. 
 
Click the User's tab. 
 
A list of users already configured in BadgeMaker are shown here. 
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Users 

 
To modify a group a user is already a member of select the user and click Modify. 
 

 
 

You can change the current user group to another group, select OK to save the change. 
 
To create a new user click New. Specify a User name and a password, this will be used to log into 
BadgeMaker, assign the new user to a group. 
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New user 

 
Choose from the following groups listed. 
 

• Administrators: Full access, add users with caution. 
• Power Users: Lightly restricted access. 
• Users: Restricted Access, members can perform the common tasks. 
• Guest: Heavy restricted access. 

 
If a new user is added and already exists you will receive the following error. 
 

 
 
Click OK. 
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Favorites 

To add/remove items from the favorites list select System Menu, and click Favorites. 
 

 
Favorites 

 
Choose what items will be listed in the far right windowpane. 
 

 
List favorites 
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Auto Login 

Auto login is very useful when a database is used that already requires a password to obtain access 
to it and only one operator is normally working with BadgeMaker. 
 
To enable Auto Login click on System Menu, and then click Auto Login. 
 
Fill the following dialog box with your login credentials (Username and Password). 
 

 
Auto login 
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The operator needs a user name and password to access BadgeMaker to access projects. If enabled 
the operator will automatically log on to BadgeMaker.  
 

 Access rights to BadgeMaker’s features are determined by which group the operator has been 
assigned to via Security. 
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Help Menu 
The Help Menu appears as the last item on the menu bar, and contains commands relating to the 
handling of help files and information about BadgeMaker such as hardware fingerprint, and version 
number. 
 

 
Help menu 
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Help Index 

Select Help Menu and click Help Index to open the Help File. 
 

Click  on the BadgeMaker Toolbar or click F1 on your keyboard. The following dialog is displayed. 
 

 
Help Files 
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About BadgeMaker 

To open select Help Menu, and then click About. 
 
Use this function to retrieve the version number and information about BadgeMaker. Also the Enter 
Key can be found here, which enables the registration of the BadgeMaker Software. 
 

 
About box 
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Connect Info 

To open click Help Menu, and then click Connect info…. 
 
By choosing this option you can obtain information about the Data source, the information is 
presented in the following dialog box. 
 

 
Data source info 
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BadgeCreator 
In the previous chapter we have discussed and explained how to create a project (BM) file with the 
necessary settings for BadgeMaker. In order to be able to produce cards, you need to have at least 
one card layout. 
 
In this chapter will be explained how to create badge (card) layouts and how to integrate encode 
information in the card. 
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Starting BadgeCreator 
To open BadgeCreator you must already be logged into BadgeMaker. From the BadgeMaker File 
Menu select either New badge to open BadgeCreator. 
 

 You must create a project first in BadgeMaker before creating card layouts and forms. 
 
When you have started BadgeCreator the following window is displayed. 
 

 
BC Main screen 
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BadgeCreator Main Screen 
Once you have started BadgeCreator the main screen is presented. 
 

 
BC Main screen 

 
Use these Help files to understand how to create a badge (card) layout and integrate encode 
information onto a badge layout. 
 
In the main screen the Badge Layout will be displayed. From here you can design graphics, logos, 
barcode layouts, magstripe layouts, chip encoded layouts. Set dynamic and static text on a layout. 
Images acquired in BadgeMaker can be added and linked to layouts. 
 

 It is not possible to create a badge layout before a project file has been created. 
 
On the right side of the main screen Project Explorer is located listing the current project file, linked 
badge layouts, and encode layouts. 
 
Working with the mouse 
 
In BadgeCreator the mouse is used to position and resize objects and to open the properties of an 
object by double clicking them. More than one item can be selected with the mouse by using CTRL+ 
Left Click. The selected items can be moved, copied or deleted as needed. 
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Working with cursor keys 
 
In BadgeCreator you can move objects on a badge layout using the cursor keys (←↑↓→). 

Project Explorer 

Project Explorer lists the currently opened project file layouts. The location of the project file is 
located at the root (Top of the list). All layouts linked to the project are listed beneath. 
 
To show Project Explorer select View Menu and click Show project Explorer. 
 

 
Project explorer 

 
Layouts can be accessed and opened by double clicking on a specific layout item. 
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Right-click a layout to Open or Remove From Project. 
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Quick Access Toolbar 

The Quick Access Toolbar in BadgeCreator can be used to quickly start formatting text by clicking on 
the desired button. 
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BadgeCreator Toolbar 

The Toolbar in BadgeCreator can be used to quickly start a function by clicking on the desired button. 
 

 
 

 Back to Main Screen 
Click on this button to return to the BadgeMaker main screen. 

 

  Badge Layout Mode 
Click on this button to enter the badge layout mode to configure/create badge layouts. 

 

 Magnetic Layout Mode 
Click on this button to enter the magnetic layout mode to configure/create magnetic encode 
layouts. 

 

 Chip Mode 
Click on this button to enter the chip layout mode to configure/create chip encode layouts. 

 

 Mifare Mode 
Click on this button to enter the mifare layout mode to configure/create mifare layouts. 

 

 Open Layout 
Click on this button to open an existing layout linked to the current project (*.BM) file. 

 

 New Layout 
Click on this button to start the New layout Wizard. 

 

 Save Layout 
Click on this button to save the current layout. 

 

 Send to Other Side 
Click on this button to send a selected item to the back of the badge or, send a selected item 
from the back of the badge to the front side of the badge. 

 

 Copy  
Click on this button to copy an image to the clipboard. 

 

 Paste 
Click on this button to paste data from the clipboard to your current records.  

 

 Undo 
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Click on this button to undo last action. 
 

 Lock Items 
Click on this button to lock items on the layout from being moved or edited such as images 
and text. This is a useful tool once you have completed a new layout. Select this button to 
lock the layout down. 

 

 Add Static Text  
Click on this button to add static text. Static items are non-unique and fixed such as Company 
Name, Address, Logo. 

 

 Add Dynamic Text 
Click on this button to add dynamic text to your badge layout. Dynamic text is a placeholder 
that automatically pulls text from the database. Dynamic items are unique and not fixed such 
as an Individual's name, e-mail, phone number or department. 

 

  Add Logo 
Click on this button to add a logo to the badge layout. 

 

 Add Image 
Click on this button to add an image to the badge layout. 

 

 Add Background Image 
Click on this button to add a background image to the badge layout. 

 

 Add Line 
 Click on this button to add a line to the badge layout. 
 

 Add Rectangle 
Click on this button to add a rectangle to the badge layout. 

 

 Add Circle 
Click on this button to add a circle to the badge layout. 

 

 Add Barcode  
Click on this button to add a barcode to the badge layout. 

 

  Change Layout Side 
Click on this button to switch views between the back and front side of the card layout. 

 

 Zoom In 
Click on this button to zoom in on the badge layout. 

 

 Zoom Out 
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Click on this button to zoom out on the badge layout. 
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File Menu 
The File Menu appears as the first item in the menu bar, and contains commands relating to the 
handling of layouts such as open, create new and save. You can close layouts and return to 
BadgeMaker from here. 
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New Layout 

To create a New Badge Layout (*.BC file) select File Menu, and click New Layout. 
 

Click  from the BadgeCreator Toolbar. 
 
The following dialog box is presented providing options which allow you to create a New Layout. 
 

Layout 
 

 
New badge layout 

 
Name: Enter a unique name for your badge layout.  
 

 The name is not case sensitive and limited to 30 characters are allowed. 
 
Include Back: Select this option to define a double sided badge layout. If this option is not checked 
your badge layout will only consist of a front side. 
Use specific printer for this badge: Specify a specific printer.  
Background Colour Front: Select a colour for the front side of the badge layout. 
Background Colour Back: Select a colour for the back side of your badge layout.  
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 This option is disabled if Include Back Side is selected. 
 
Magnetic Stripe Positioning: Select the way the magnetic stripe will be positioned on the badge 
layout. If no magnetic stripe is to be used in the layout select No. 
Chip Positioning: Select the layout side the chip will be positioned. If no chip is to be used in the 
layout select No. 
Chip Type: Select a chip type from the list.  The following types can be selected from the drop down 
list. 
 

• ISO 
• AFNOR 
• Plug-in SIM 

 
  The chip type option can only be selected if Chip Positioning is set to Front or Back. 
 
Number of Pins: Select the number of pins for the chip. For ISO and AFNOR both 6 pin and 8 pin can 
be selected. For Plug-in SIM only 8 pin is available.  
 

 The Number of Pins option can only be selected if Chip Positioning is set to Front or Back. 
 

Paper 
 

 
Paper 
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Type: Define the size of the badge by selecting a predefined Type from the drop down list or select 
Manual Size to define your own badge size. 
 

• ISO-Card  86/54.5: Select this if you want to design an ISO standard card.  
• A4: Select this if you want to design a layout on A4 paper. If you print the layout on A4 paper 

it is possible to print more than one record on a sheet.  
• Letter: Select this if you want to design a layout for Letter paper. If you print the layout on 

Letter paper it is possible to print more than one record on a sheet. 
• Manual Size: If you have selected ISO-card, you can define your own badge size. The badge 

dimensions can now be filled in the dialog. 
 
Select one of these if you want to design an ISO standard card and use a Magicard Turbo or 
Rio/Tango printer. You can also select to print edge to edge or print with a white border. 
 

• ISO-Card Magicard Turbo White Border 
• ISO-Card Magicard Turbo Edge To Edge 
• ISO-Card Magicard Rio/Tango White Border 
• ISO-Card Magicard Rio/Tango Edge To Edge 
• Mitsubishi 110/110: Select this if you have a Mitsubishi CP100 with sheets of 110x110mm. 
• Mitsubishi 150/100: Select this if you have a Mitsubishi CP100 with sheets of 150x100 mm. 
• ISO-Card Fargo: Select this if you want to design an ISO standard card and you use a Fargo 

printer. 
• ISO-Card DNP: Select this if you want to design an ISO standard card and you use a DAI 

Nippon printer. 
 
Orientation: Configure the orientation of the layout. 
 
Select Portrait:  to set a layout in portrait. 
Select Landscape:  to set the layout in landscape. 
 
Badges Per Page: Set the number of columns and number of rows on a badge. 
 
Columns: Enter a value to set the number of columns. 
Rows: Enter a value to set the number of rows. 
 
Size: Set the width and height of the badge.  
 
Width: Enter a value to set the width of the badge. 
Height: Enter a value to set the height of the badge. 
 
Header and Footer: Define the height of a Header and a Footer.  
 

 This option is only available for the types A4 and Manual. 
 
Margins: Configure the left, top, right and bottom margins of a layout. 
 
Left: Enter a value to set the left margin of a layout. 
Top: Enter a value to set the top margin of a layout. 
Right: Enter a value to set the right margin of a layout. 
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Bottom: Enter a value to set the bottom margin of a layout. 
 

 
 
Space Between: Configure the space between the columns and rows. 
 
Column: Enter a value to change the space between columns. This affects the width of the badge. 
Rows: Enter a value to change the space between rows. This affects the height of the badge. 
 
Click OK to confirm and close. Click Cancel to discard changes. 
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New Layout Wizard 

Select File Menu and click New Layout Wizard to open the Badge Layout Wizard, the following 
screen is presented. 
 

 
BC New layout wizard 

 
Click Next to and select the type of layout to create. 
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New Layout Wizard (Badge) 

Select File Menu and click New Layout Wizard to open the wizard, the following screen is presented. 
 

Click  from the BadgeCreator Toolbar. 
 
The Welcome screen can be skipped in future by selecting Don't display this screen in the future. 
 

 
BC New layout wizard 

 
Click Next to proceed to the next screen and begin configuring a New Layout. 
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Step 1 
 

 
Layout type 

 
Select Badge to create a Badge layout and click Next to proceed.  
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Step 2 
 
Type a name for your desired layout and select which Type (Card Type) you want to 
use. 
 

 
 
In this example Include Back has been selected, this creates a double sided card layout. 
 
Click Next to proceed to the next screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 238                                                                                                      

  

Step 3 
 

 
Badge layout 

 
When selecting Badge Layout in Step 1 a number of input fields are not available. These are greyed 
out. 
 
Click Next to proceed to the next screen. 
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Step 4 
 

 
Badge fields 

 
Select which images to include into the badge layout, and below select which fields from the 
database to include into the badge layout.  
 

 Fields chosen will be shown in the layout as dynamic text linked to data fields in the database, 
not static text which is fixed information set on a layout. 
 
Click Next to proceed to the next screen. 
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Step 5 
 

 
Badge options 

 
Chip and Magstripe Options configure where on the layout place holders will be positioned for the 
magnetic stripe and the chip. This prevents other items and objects being placed on top of the chip 
or magstripe.  
 

 Note that these place holders are only indicating the position of the chip and magstripe. 
 
Click Next to proceed to the next screen. 
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Step 6 
 

 
 
Once all settings have been defined and configured the final dialog is presented. 
 
Click Finish to complete the Wizard or click Back to change settings. When you click Finish a new 
layout is presented in BadgeCreator. 
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BC Main screen 

 

Form the BadgeMaker Toolbar click  , this will open BadgeCreator and start the New 
Layout Wizard. 
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New Layout Wizard (Gallery Badge) 

Select File Menu and click New Layout Wizard to open the wizard, the following screen is presented. 
 

Click  from the BadgeCreator Toolbar. 
 
The Welcome screen can be skipped in future by selecting Don't display this screen in the future. 
 

 
 
Click Next to proceed to the next screen and begin configuring a New Layout. 
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Step 1 
 

 
Choose type 

 
Select Gallery Badge to create a gallery badge and click Next to proceed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 2 
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Type a name for your desired layout and select which Type (Card Type) you want to use. 
 
Choose between the following Type A4, Manual Size and Letter. 
 

 
 
Click Next to proceed to the next screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 3 
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Gallery layout 

 
Click Next to proceed to the next screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 4 
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Gallery fields 

 
Select which images to include into the badge layout, and below select which fields from the 
database to include into the badge layout.  
 

 Fields chosen will be shown in the layout as dynamic text linked to data fields in the database, 
not static text which is fixed information set on a layout. 
 
Click Next to proceed to the next screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 5 
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Once all settings have been defined and configured the final dialog is presented. 
 
Click Finish to complete the Wizard or click Back to change settings. When you click Finish a new 
layout is presented in BadgeCreator. 
 

 
BM main screen 
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 Form the BadgeMaker Toolbar click , this will open BadgeCreator and start the New Layout 
Wizard. 
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New Layout Wizard (Magnetic Layout) 

Select File Menu and click New Layout Wizard to open the wizard, the following screen is presented. 
 

Click  from the BadgeCreator Toolbar. 
 
The Welcome screen can be skipped in future by selecting Don't display this screen in the future. 
 

 
 
Click Next to proceed to the next screen and begin configuring a New Layout. 
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Step 1 
 

 
Choose layout 

 
Select Magnetic Layout to create a magstripe badge and click Next to proceed. 
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Step 2 
 

 
 
Click Finish to complete the Wizard or click Back to change to another Card Mode. 
 
When you click Finish a new layout is presented in BadgeCreator. 
 

 
Magnetic layout mode 
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 Form the BadgeMaker Toolbar click  , this will open BadgeCreator and start the New Layout 
Wizard. 
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New Layout Wizard (Contact Chip) 

Select File Menu and click New Layout Wizard to open the wizard, the following screen is presented. 
 

Click  from the BadgeCreator Toolbar. 
 
The Welcome screen can be skipped in future by selecting Don't display this screen in the future. 
 

 
 

Click Next to proceed to the next screen and begin configuring a New Layout. 
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Step 1 
 

 
Choose layout 

 
Select Contact Chip to create and click Next to proceed. 
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Step 2 
 

 
Chip options 

 
A *dll must be specified in order for a contact chip to be encoded with images and data specified in 
the layout. Specify bmchip.dll under Dll Name. 
 

 BMChip32.dll is shipped with BadgeMaker, specify this *.dll unless you have created your own 
specific *.dll.  
 

 A *.Dll name is required. If it is empty, the chip encode layout cannot be saved. 
 
If no chip is specified and you choose to proceed, the following dialog is presented. Click Yes to 
supply a *.dll at a later time or No to return to Step 2 and specify a *.dll. 
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Step 3 
 

 
Chip images 

 
Select the required Images to include into the chip encoding. When this option is specified the name 
and directory of the Image will be stored into the chip layout. 
 
Click Next to proceed. 
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Once all settings have been defined and configured the final dialog is presented. 
 
Click Finish to complete the Wizard or click Back to change settings. When you click Finish a new 
layout is presented in BadgeCreator. 
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Chip layout mode 
 

From the BadgeMaker Toolbar click  , this will open BadgeCreator and start the New Layout 
Wizard.  
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New Layout Wizard (Mifare) 

Select File Menu and click New Layout Wizard to open the wizard, the following screen 
is presented. 
 

Click   from the BadgeCreator Toolbar. 
 
The Welcome screen can be skipped in future by selecting Don't display this screen in the future. 
 

 
 
Click Next to proceed to the next screen and begin configuring a New Layout. 
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Step 1 
 

 
Choose card type 

 
Select Contactless Chip to create and click Next to proceed. 
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Step 2 
 
In this dialog choose the type of contactless chip to use.  
 
Select Mifare and click Next to continue. 
 

 
Chip type 
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Step 3 
 
Select which type of Mifare chip to use. 
 

 
Mifare options 

 
For this example Mifare 1k is selected. 
 
Allow multitrack database items (non-binary): Select this option to scan a field across multiple 
tracks (for large segments of information). 
 
Enable MAD Section: Enable MAD (Mifare Application Directory) to define common data structures 
for multi application directory entries.  
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Step 4 
 

 
 
Once all settings have been defined and configured the final dialog is presented. 
 
Click Finish to complete the Wizard or click Back to change settings. When you click Finish a new 
layout is presented in BadgeCreator. 
 

 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 265                                                                                                      

  

 From the BadgeMaker Toolbar click  , this will open BadgeCreator and start the New Layout 
Wizard.  
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New Layout Wizard (iClass) 

Select File Menu and click New Layout Wizard to open the wizard, the following screen is presented. 
 

Click  from the BadgeCreator Toolbar. 
 
The Welcome screen can be skipped in future by selecting Don't display this screen in the future. 
 

 
 
Click Next to proceed to the next screen and begin configuring a New Layout. 
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Step 1 
 

 
Choose type 

 
Select Contactless Chip and click Next to proceed. 
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Step 2 
 
In this dialog choose the type of contactless chip to use. 
 

 
Choose contactless chip type 

 
Select iClass and click Next to continue. 
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Step 3 
 

 
 
Select a Chip Configuration in relation to the iClass chip type being used. Choose between 2Kbit Chip 
and a 16Kbit Chip. 
 
Click Next to proceed. 
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Step 4 
 

 
 

Once all settings have been defined and configured the final dialog is presented. 
 
Click Finish to complete the Wizard or click Back to change settings. When you click Finish a new 
layout is presented in BadgeCreator. 
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iClass layout mode 

 

 From the BadgeMaker Toolbar click  , this will open BadgeCreator and start the New Layout 
Wizard. 
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New Layout Wizard (Legic) 

Select File Menu and click New Layout Wizard to open the wizard, the following screen is presented. 
 

Click  from the BadgeCreator Toolbar. 
 
The Welcome screen can be skipped in future by selecting Don't display this screen in the future. 
 

 
 
Click Next to proceed to the next screen and begin configuring a New Layout. 
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Step 1 
 

 
Choose layout type 

 
Select Contactless Chip and click Next to proceed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 274                                                                                                      

  

Step 2 
 
Select Chip Type Legic and click Next to proceed. 
 

 
 

 BadgeMaker supports Legic cards with a capacity of 256 bytes, 1024 bytes and up. Cards with a 
capacity of 22 bytes are not supported, since this media does not support segmentation. 
 

 A Legic card can be divided into segments. Each segment can be used for different application 
and the size of a segment is variable.  
 

Step 3 
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Type a Name for the Legic segment and define the Size. The size of a Legic segment is variable, but 
should not exceed the capacity of the medium.  
 

 Do not make a segment larger than needed.  
 
Click Next to proceed. 
 

Step 4 
 

 
Stamp 

 
Define the Number of Organizational Levels.  
 
If you select one level only, the Stamp is 1 Byte. For each additional level, the stamp will increase 
with one byte. A byte can have a value between 00 and FF.  
 
You can define up to 12 Organizational Levels. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 276                                                                                                      

  

Step 5 
 
In the following dialog various levels of protection can be set to keep encoded information from 
easily being read. 
 

 
Protection 

 
Once all settings have been defined and configured the final dialog is presented. 
 
Click Finish to complete the Wizard or click Back to change settings. When you click Finish a new 
layout is presented in BadgeCreator. 
 

 
Legic layout mode 
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New Layout Wizard (HID Prox) 

Select File Menu and click New Layout Wizard to open the wizard, the following screen is presented. 
 

Click  from the BadgeCreator Toolbar. 
 
The Welcome screen can be skipped in future by selecting Don't display this screen in the future. 
 

 
 
Click Next to proceed to the next screen and begin configuring a New Layout. 
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Step 1 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select Chip Type HID Prox. 
 
Click Next to proceed. 
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Step 4 
 

 
 
Once all settings have been defined and configured the final dialog is presented. 
 
Click Finish to complete the Wizard or click Back to change settings. When you click Finish a new 
layout is presented in BadgeCreator. 
 

 
HID Prox layout mode 

Click BM Field to link a HID Prox Card field to a field defined in BadgeMaker. 
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 In the list only character fields will be presented. The HIDProx fields can contain leading zeros 

which cannot be stored in a numeric field. 
 

  Form the BadgeMaker Toolbar click , this will open BadgeCreator and start the New Layout 
Wizard. 
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New From Template 

Select the File Menu and click New From Template, the following dialog is presented. 
 

Click  from the BadgeCreator Toolbar. 
 

 
BC card templates 

 
When the Create New Layout from Template opens select from the list a template card design. 
 

• Canteen Card 
• Medical Assistance Card 
• Military Card 
• Photo Badge 
• Picture Gallery 
• Report 
• Sports Card 
• Transportation Card 

 
Picture Gallery template is A4 in size. it contains several row and columns to display a group of 
photos for example on one sheet. 
 
Photo Badge is a traditional ID Card with a standard Photo, Logo and data placed 
into the layout. 
 
Report is a record list containing a Header and a Footer. 
 
These cards are all examples and will present a good basis on which to begin designing your card 
layout. 
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 Dynamic fields configured in the template's design are linked to the Demo project. The following 
warning will be shown. 
 

 
 

Select OK to proceed. You must replace field names on the layout to correspond to your own 
database. 
 

 
BC main screen 
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Open Layout 

Select the File Menu and click Open Layout, the following dialog is presented.  
 

Click  from the BadgeCreator Toolbar. 
 

 
Open layout 

 
All layouts created in BadgeCreator can be accessed in the Open Layout dialog box. 
 

• Badge Layouts 
• Magstripe Layouts 
• Custom Layouts 
• Contact Chip Layouts 
• Contact Chip Layouts 
• Contactless Layouts 

 
Badge layouts 
 
Select a previously configured Badge design layout which is linked to the project (*.BM) file.  
 
For this example COMPANY CARD is selected. 
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Select OK to open the layout in BadgeCreator. 
 

 
BC main screen 
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Close Layout 

Select the File Menu and click Close Layout to close the current opened layout. 
 
Before the layout is closed, BadgeCreator will prompt the operator to save before closing, this will 
ensure data is not lost 
 

 
 

Select Yes to save or No to exit without saving. 
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Import Layout 

Select the File Menu and click Import Layout to close the current opened layout. 
 

 
 

Navigate to the directory where the *.BC file is located.  
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Select the file and click Open to begin importing. For this example Canteen Card is chosen from the 
Demo Project. 
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The operator can rename the layout or keep the same name, select the location his to save.  
 
Badge Layouts are normally stored under Projects\<Project>\Badges.  
 
Select Save to continue. The following dialog is presented. 
 

 
 

 Import layout files (*.BC) linked to another project file (*.BM). Of course the databases 
belonging to the specific *.BM file will differ, therefore the operator must adjust the database 
fields after importing another layout. If this is not carried out then errors will occur when printing 
the layouts. 
 
Click OK to proceed. 
 
If importing a badge layout which has encode layouts attached then the operator is given the option 
to import the encoded layouts as well.  

 
 
Click Yes to confirm importing encodes or No to import the badge layout only with no encode layout. 
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Imported fields linking 

 
If fields configured in the imported layout do not match the fields in the current database, select the 
drop down menu to re-link imported  fields set in the current project or if no change is needed leave 
Keep as is. 
 

 
Imported fields linking 

 
Click OK to finish configuring Badge and Database Fields.  
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When you click OK a new layout is presented in BadgeCreator. 
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Remove Layout 

Select the File Menu and click Remove Layout to close the current opened layout. 
 
Use this option to remove the current layout from the current project . The following dialog is 
presented. 
 

 
 
Click Yes to confirm removal or click No to cancel removal. At this point the current layout is removed 
from the current project.  
 
A second dialog box is presented to confirm deletion of the current layout from the actual Hard Disk. 
 

 
 
Click Yes to confirm removal or click No to cancel removal.  
 

 It cannot be restored anymore using Import Layout if the layout is deleted. 
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Save 

Select the File Menu and click Save to Save the current layout. 
 

Click  from the BadgeCreator Toolbar. 
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Save As 

Select the File Menu and click Save As to save the current layout and define a name and location. 
 

Click  from the BadgeCreator Toolbar. 
 

 
 
Select Save to finish. 
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Mode 

Select the File Menu, click Mode, and then select a layout type to begin designing and configuring. 
 

 
 
The operator can switch between. 
 

• Badge Layout Mode 
• Magnetic Encode Layout Mode 
• Contact Encode Layout Mode 
• Contactless Encode Layout Mode 
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Badge Layout 

Select the File Menu, click Mode, and then click Badge Layout to open Badge Layout Mode. 
 

Click  from the BadgeCreator Toolbar. 
 

 
Badge layout mode 

 
In Badge Layout mode, badge layouts are created and edited. 
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Magnetic Encode Layout 

Select the File Menu, click Mode, and then click Magnetic Layout to open Magnetic 
Layout Mode. 
 

Click  from the BadgeCreator Toolbar. 
 

 
Magnetic layout mode 

 
In Magnetic Layout mode, magnetic layouts are created and edited. 
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Chip Encode Layout 

Select the File Menu, click Mode, and then click Chip Encode Layout to open Chip Encode Layout 
Mode. 
 

Click  from the BadgeCreator Toolbar and select Chip Mode from the drop down menu. 
 

 
 
In Chip Encode Layout mode, chip layouts are created and edited. 
 

 
Chip layout mode 
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OMC Encode Layout 

Select the File Menu, click Mode, and then click OMC Encode Layout to open OMC Encode Layout 
Mode. 
 

Click  from the BadgeCreator Toolbar and select OMC Mode from the drop down menu. 
 

 
 
In OMC Encode Layout mode define the contents of the Optical Memory Card file or edit a previously 
made file. The Optical Memory Card file contains the data that will be placed on the Optical Memory 
Card info file when a print or encode command is given. The OMC *.dll must to read the information 
from this file to encode the Optical Memory Card. 
 

 OMC functionality is disabled by default, it will only work in combination with a Lasercard ® 
optical memory card reader/writer and related software. 
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Mifare Encode Layout 

Select the File Menu, click Mode, and then click Mifare Encode Layout to open Mifare Encode Layout 
Mode. 
 

Click  from the BadgeCreator Toolbar and select Mifare Mode from the drop down menu. 
 

 
 
In Mifare Encode Layout mode, mifare layouts are created and edited. 
 

 
Mifare layout mode 
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iClass Encode Layout 

Select the File Menu, click Mode, and then click iClass Encode Layout to open iClass Encode Layout 
Mode. 
 

Click  from the BadgeCreator Toolbar and select iClass Mode from the drop down menu. 
 

 
 
In iClass Encode Layout mode, iClass layouts are created and edited. 
 

 
iClass layout mode 
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Legic Encode Layout 

Select the File Menu, click Mode, and then click Legic Encode Layout to open Legic Encode Layout 
Mode. 
 

Click  from the BadgeCreator Toolbar and select Legic Mode from the drop down menu. 
 

 
 
In Legic Encode Layout mode, Legic layouts are created and edited. 
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HID Prox Encode Layout 

Select the File Menu, click Mode, and then click HID Prox Encode Layout to open HID Prox Encode 
Layout Mode. 
 

Click  from the BadgeCreator Toolbar and select HID Prox Mode from the drop down menu. 
 

 
 
In HID Prox Encode Layout mode, HID Prox layouts are created and edited. 
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Back To Main Screen 

Select the File Menu and click Back to main Screen to close BadgeCreator and return to BadgeMaker. 
 

Click  from the BadgeCreator Toolbar to return to BadgeMaker's Main Screen. 
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Edit Menu 
The Edit Menu appears as the second item in the menu bar, and contains commands relating 
to the handling of data and images such as adding images, edit the current layout, copy and paste 
text and items. You can run a lock items on a layout from here. 
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Undo 

Use  option from the toolbar or select Edit Menu and click Undo to undo an action in 
BadgeCreator. 
 
Using Undo will erase the last change made, reverting it back to an older state. 
 

Send To Other Side 

Use  option from the toolbar or select Edit Menu and click Send To Other Side. 
 
This option allows you to move an item to the other side of a badge layout if the layout includes a 
front and back side. 
 

Copy 

Use  option from the toolbar or select Edit Menu and click Copy to copy data onto the clipboard.  
 
When you copy an image or data, you are making a duplicate of the original item, you can then 
modify, delete or save images independently of the original. 
 

Paste 

Use  option from the toolbar or select Edit Menu and click Paste to paste data from the clipboard 
which you have copied previously. 
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Select All Items 

Select Edit Menu and click Select All Items to select all objects and text on the currently opened 
badge layout. 
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Add Item 

Select Edit Menu and select Add Item to add an item to a layout in BadgeCreator. 
 

 
Add item menu 
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Static Text 

Use  option from the toolbar or select Edit Menu>Add Item and click Static Text to add static text 
to the currently opened layout. The following dialog is presented. 
 

Data 
 

 
 
Enter text to create a static text field on a badge layout. At the bottom of the dialog in the preview 
box this text will be displayed with selected font and color. 
 
Word Wrap: If the length of text is too long to fit on one line it will spread across 
multiple lines to fit into the text box on the badge layout. 
 

Word Wrap not selected 
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Word Wrap selected 

 
 
Only the width can be changed, the height will be adjusted automatically to make the text fit into the 
box. 
 

Position 
 

 
Add Static text 

 
Set the position of the text box on the badge layout. Text will be positioned within a rectangle box, 
(as seen below). 
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Layer: Items can be placed on several transparent layers. Items created with a higher value will be 
placed on top of items with a lower value. Values must be set within range 0 - 9. 
Orientation: Text can be rotated in increments of 90 degrees. 
Clipping: Text outside the text box is clipped - only text inside the text box will be visible any text 
shown outside the text box will be clipped automatically. 
 

Not Clipped 
 

 
 

Clipped 
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Font 
 

 
Edit static text properties 

 
Click Font, the following dialog is presented. 
 
Alignment: Defines how the text is positioned within the bounds specified by X start, Y start, Width 
and Height. 
 

• Left:  for left alignment. 
• Center:  for alignment in the middle. 
• Right : for right alignment. 
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Font dialog 

 
Define the font in which the text will be displayed on the badge layout. 
 
Font: Specifies a text font. In the box select a font name. Your choice will appear in the Sample Box. 
Font Style: Specifies a font style such as Bold, Italic, Regular. Your choice will appear in the Sample 
Box. 
Size: Specifies a font size in points. Select a size in the list. To ensure readability for most designs use 
a size of 8 points or larger. Your choice will appear in the Sample Box. 
 
Static Text will be shown on the badge layout as the following. 
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Dynamic Text 

Use  option from the toolbar or select Edit Menu>Add Item and click Dynamic Text to add 
dynamic text to the currently opened layout. The following dialog is presented. 
 

Data 
 

 
Dynamic Text Item 

 
Click Field. The following dialog is displayed. 
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Select a field from your BadgeMaker Database to create a dynamic text field on a badge layout.  
 
For this example Firstname is chosen. 
 

 
Add dynamic text item 

 
At the bottom of the dialog in the preview box this text will be displayed with selected font and color. 
 
You can also type a string that can be built of one or more database fields in combination with 
constants. With the space button a +” “+ will be added to the string. Now another database filed or 
constant can be added to the string. In this example Field “Firstname” and Field “Surname” are 
entered. 
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Data 

 
Click Clear to erase field entries and start over again. 
 
Click Undo to undo last action. 
 
Word Wrapping: If the length of text is too long to fit on one line it will spread across multiple lines 
to fit into the text box on the badge layout. 
 

Word Wrap not selected 
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Word Wrap selected 

 
 

Only the width can be changed, the height will be adjusted automatically to make the text fit into the 
box. 
 

Position 
 

 
Position 

 
Set the position of the text box on the badge layout. Text will be positioned within a rectangle box, 
(as seen below). 
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Layer: Items can be placed on several transparent layers. Items created with a higher value will be 
placed on top of items with a lower value. Values must be set within range 0 - 9. 
 
Orientation: Text can be rotated in increments of 90 degrees. 
 
Clipping: Text outside the text box is clipped - only text inside the text box will be visible any text 
shown outside the text box will be clipped automatically. 
 

Not Clipped 
 

 
 

Clipped 
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Font 
 

 
Font 

 
Click Font, the following dialog is presented. 
 
Alignment: Defines how the text is positioned within the bounds specified by X start, Y start, Width 
and Height. 
 
Left:  for left alignment. 
Center:  for alignment in the middle. 
Right:  for right alignment. 
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Font properties 

 
Define the font in which the text will be displayed on the badge layout. 
 
Font: Specifies a text font. In the box select a font name. Your choice will appear in the Sample Box. 
Font Style: Specifies a font style such as Bold, Italic, Regular. Your choice will appear in the Sample 
Box. 
Size: Specifies a font size in points. Select a size in the list. To ensure readability for most designs use 
a size of 8 points or larger. Your choice will appear in the Sample Box. 
Strikeout: Draws a line through the selected text. 
Underline: Specifies whether the selected text is underlined. 
 
Dynamic Text will be shown on the badge layout as the following. 
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Add Logo 

Use   option from the toolbar or select Edit Menu>Add Item and click Add Logo to 
add a logo to the currently opened layout. 
 

 
 
The following dialog is presented. 
 

 
 
Select a logo to use and click Open. 
 
The logo is now added to your badge layout. 
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Logo added 
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Add Dynamic Logo 

Use  option from the toolbar or select Edit Menu>Add Item and click Add Dynamic Logo to add 
a dynamic logo to the currently opened layout. 
 

 
 
The following dialog is presented. 
 

Locate Logo 
 

 
Locate logo 

 
Select dynamic logo field: If a dynamic logo is used, select a dynamic logo from the dropdown list. 
The fields marked as dynamic logo fields (Options Has pick list and Has logo enabled in BadgeMaker) 
can be selected from this list. Make sure the logos corresponding with the logo names available in 
the Logos directory (Only one logo file for each logo field). 
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Sales.jpg added 

 
Select OK to show the result. 
 

 
 
Transparent: If this option is selected, the logo will become transparent. Logo's will mingle with the 
background when made transparent. 
 

 The transparent option will work best with black and white logos. 
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Position 
 

 
Position 

 
Set the position of the logo on the badge layout. 
 
Layer: Items can be placed on several transparent layers. Items created with a higher value will be 
placed on top of items with a lower value. Values must be set within range 0 - 9. 
 
Scale Type: Three options are available: Free, Actual Size, Keep Aspect Ratio. 
 

• Free: Logo is freely scalable.  
• Actual Size: Logo will be displayed on the layout in actual size based on the original logo size.  
• Keep Aspect Ratio: The original size of the logo can be scaled, but only within the original 

width/height ratio. These options are available as soon as a logo file has been selected. 
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Image 

Use  option from the toolbar or select Edit Menu>Add Item and click Add Image to 
add a image to the currently opened layout. The following dialog is presented. 
 
The following options allow you to add or edit an image. 
 

 
 
Field and Position 
 
Image Field: Select one of the available image types from the drop down list.. 
 

• Photo 
• Sign 
• Photo Thumb 
• Sign Thumb 
• Finger Image 

 
Biometrics: This drop down box is only activated if a biometrics image field is selected. In a 
biometrics image field, multiple finger scans can be stored. In this drop down field, one of the 
scanned fingers can be selected to display on the badge. If you wish to display more than one finger 
image on the badge, you have to insert an image for each finger. 
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Aspect Ratio: The image proportion restricts the size of the image on the layout to one of the 
following proportions. 
 

• 3*4: Width * Height ratio, commonly applied for identity card photos 
• 4*1: Width * Height ratio, commonly applied for signature images 
• Custom Proportion: Allows you to define your own Width * Height ratio's. The value 

for Width and Height should be between 1 and 999. 
• Free: The size of the image is not restricted. 

 
 Default ratio is set to 3*4 

 
Scale Type: Define how the image is drawn in a rectangle defined by X start, Y start, Width and 
Height. 
 
Clip Destination On Source: The rectangle is fully covered by the image by enlarging the image so 
that the image width or height fits exactly in the frame width or height. The parts which are outside 
the rectangle are clipped (No image distortion). 
 
Fit Source In Destination: The image size is reduced so that the width or height fits on the width or 
height of the rectangle. (No image distortion) 
Scale Source To Destination: The rectangle is filled with the image by re-sizing the image width and 
height to the width and height of the rectangle. (Image distortion) 
 

 Default scale type is set to Fit Source in Destination. 
 
Transparent: If this option is selected, the image will become transparent. Image's will mingle with 
the background when made transparent. 
 
Advanced Image Settings 
 
Click Advanced, the following dialog is displayed. Additional settings can be configured in this dialog. 
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Advanced image settings 

 
Select Ghost to enable the following settings. 
 

• Brightness 
• Contrast 
• Gamma 

 
When Ghost becomes enabled the image will become transparent. The Image can then be altered by 
adjusting the settings to morph the image into the background. 
 
Image Border Settings 
 
Click Border the following dialog is displayed. Additional settings can be configured in this dialog. 
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Image border settings 

 
Define a border line color and thickness. 
 

 
 
Click OK to confirm settings. The result on the layout will look similar to this... 
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Result of adding border 
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Bar Code 

Use  option from the toolbar or select Edit Menu>Add Item and click Bar Code to add a bar 
code to the currently opened layout. 
 

 
 
The following dialog is presented. 
 

Data 
 

 
Add bar code item 

 
Click Select Field to enter a database field and bring up a list of fields. 
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Select table field 

 
Click OK once a field has been selected. 
 

 
Data 

 
Transparent: If this option is selected, the barcode will become transparent.  
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Position 
 
Set the position of the barcode on the badge layout. 
 

 
Position 

 
Layer: Items can be placed on several transparent layers. Items created with a higher value will be 
placed on top of items with a lower value. Values must be set within range 0 - 9. 
 
Orientation: The Bar code can be rotated in increments of 90 degrees. 
 
Alignment: Defines how the Bar Code is positioned within the bounds specified by X start, Y start, 
Width and Height. 
 

• Left:  for left alignment. 
• Center:  for alignment in the middle. 
• Right:  for right alignment. 

 
 
 
 
 
 
 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 333                                                                                                      

  

Type 
 

 
Type 

 
Bar Code: Select a barcode from the available list. 
 

• UPC-A 
• UPC-E 
• EAN/jan-13 
• EAN/jan-8 
• Code 3 of 9 
• Extended code 3 of 9 
• Interleave 2 of 5 
• Code 128 Auto 
• Codabar 
• Zip 
• MSI Plessey 
• Code 93 
• Extended Code 93 
• UCC -128 
• HIBC 
• PDF417 
• UPC-E0 
• UPC-E1 
• Code 128 Subset A 
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• Code 128 Subset B 
• Code 128 Subset C 

 
Bar Code Text: Select from the drop down list where to position readable text in combination with 
the barcode.  
 

 
 

Example – Off 
 

 
 

Example – Above 
 

 
 

Example – Below 
 

 
 
Density: Determines the width off the bar code stripe. 
 

Before 
 

 
 

After 
 

 
 
Height: Determines the height of the barcode layout. 
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Before 
 

 
 

2 Digit 
 

 
 

5 Digit 
 

 
 

Stretch Factor: Determines the length of the barcode as an addition to the density setting.  
 

 The result of this setting is visible in the Preview of BadgeMaker and on printed cards, but not in 
the Add Barcode dialog. 
 
Checksum: To increase the reading accuracy, some barcode types can use checksum's. The 
availability of a checksum is dependent on the barcode type. The calculated value is added to the 
barcode. 
 

Bar Code Text Font 
 

 
 
Define the font in which the text will be displayed on the badge layout. 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 336                                                                                                      

  

 
• Font: Specifies a text font. In the box select a font name. Your choice will appear in the 

Sample Box. 
• Font Style: Specifies a font style such as Bold, Italic, Regular. Your choice will appear in the 

Sample Box. 
• Size: Specifies a font size in points. Select a size in the list. To ensure readability for most 

designs use a size of 8 points or larger. Your choice will appear in the Sample Box. 
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Add 2D Bar Code 

Use  option from the toolbar or select Edit Menu>Add Item and click Add 2D Bar Code to add a 
2D bar code to the currently opened layout. 
 

 
 

 This option is only available if the DataStrip plug in is installed! 
 
The following dialog is presented. 

 
General 

 

 
General 

 
Barcode Type: Only DataStrip 2D is available at the moment. 
Error Correction Factor: Set a value between 25 and 50 for the error correction. 
 

 Increasing this value will reduce the amount of information that can be stored in the barcode. 
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Feature Length: Length in pixels of particles of which the barcode is composed of. 
Feature Width: Width in pixels of particles of which the barcode is composed of. 
 
In the middle section of the dialog the available space for data is indicated. If you decrease the 
feature length or width the strip space will grow.  
 

 Readability will worsen if you adjust the feature properties too small. 
 

Position 
 

 
Position 

 
 The strip width and length will also affect the amount of data that can be stored in the bar code. 

 
Layer: Items can be placed on several transparent layers. Items created with a higher value will be 
placed on top of items with a lower value. Values must be set within range 0 - 9. 
 
 
 
 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 339                                                                                                      

  

Data 
 

 
Data 

 
Click Add to add a Field or a Constant to the barcode. 
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Security: Select this option if the barcode scanner should not display the database field (or constant).  
 
The data will still be processed by a scanner. 
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Images 
 

 
Images 

 
Add an image to the bar code. Select Add to obtain a list of images to add. Select Remove to delete 
an Image for the barcode. 
 

 
Barcode images 
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Images with a maximum width of 120 pixels and a maximum height of 160 pixels can be stored into 
the barcode.  
 
Compression Level: Set a value between 0 and 100. The default value is 20. 
 

 Templates can also be stored in the bar code. In that case the width, height and compression 
level will not be used. 
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Line 

Use  option from the toolbar or select Edit Menu>Add Item and click Line to add a line to the 
currently opened layout. The following dialog is presented. 
 

Position 
 

 
Position 

 
The X start and X end value, will determine the length of the line. 
The Y start and X end value, will determine the angle of the line. 
 
Layer: Items can be placed on several transparent layers. Items created with a higher value will be 
placed on top of items with a lower value. Values must be set within range 0 - 9. 
 

Color 
 

 
Color 

 
Click Color to select a color for the line. Set the Line Thickness of the line. 
 
Click OK to confirm, Click Cancel to cancel changes. 
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Rectangle 

Use  option from the toolbar or select Edit Menu>Add Item and click Rectangle to add a 
rectangle to the currently opened layout. The following dialog is presented. 
 

Position 
 

 
Position 

 
The X start and X end value, will determine the length of the line. 
The Y start and X end value, will determine the angle of the line. 
 
Layer: Items can be placed on several transparent layers. Items created with a higher value will be 
placed on top of items with a lower value. Values must be set within range 0 - 9. 
 

Color 
 

 
Color 

 
Click Color to select a color for the line. Set the Line Thickness of the line. 
 
Click OK to confirm, Click Cancel to cancel changes. 
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Delete Item 

Select Edit Menu and click Delete to delete an item in the opened layout.  
 
The following dialog is presented. 
 

 
 
Select Yes to confirm delete or No to cancel deleting. 
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Set Background Image 

Select Edit Menu and click Set Background Image to set a background to your badge. 
 

Click  on the BadgeCreator Toolbar to set a background image on your layout. 
 
The following dialog is presented. 
 

 
 
Select a graphic and click Open to set as a background. 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 347                                                                                                      

  

 
BC layout screen 
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Delete Background Image 

Select Edit Menu and click Delete Background Image to delete a background to your badge.  
 
The following dialog is presented. 
 

 
 
Click Yes to delete the background image or No to cancel deleting. 
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Item 

Select Edit Menu and click Item to select an item on your badge.  
 
Use this option to edit the properties of an item in the badge layout.. 
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Select item From List... 

Select Edit Menu and click Select Item From List to select an item in the opened layout.  
 
The following dialog is presented. 
 

 
Available items 

 
In this dialog you can either select an item by double clicking on a selected item or directly edit the 
selected item by selecting Edit. 
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Clicking on + will show the items associated with this layer and allow you to edit these particular 
items. If no + is displayed, no items are available on this layer to select. 
 

 This option is particularly handy if items are positioned close together on a layout for more 
precision.   
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Toggle Header/Footer Property 

Select Edit Menu and click Toggle Header/Footer Property to change the property of a static text 
from header/footer text to body text or the other way round. 
 

 This option is only valid for layouts in A4 or Letter.  
 

 This option will only work with static text items! The property of dynamic fields cannot be 
changed to header/footer item. 
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Badge Layout 

Select Edit Menu and click Badge Layout to edit settings of the current open badge layout.  
 
The following dialog is presented. 
 

 
Edit badge layout 

 
Select OK to close. 
 
The Edit Badge Layout dialog is show in the same format as New Layout 
 
 
 
 
 
 
 
 
 
 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 354                                                                                                      

  

Snap To Reference Line... 

Select Edit Menu and click Snap To Reference Line to delete an item in the opened layout.  
 
The following dialog is presented. 
 

 
 
The Reference Line is shown in the Main Screen as a Green dotted line . 
 
Use this command to position an item according to the position of the Reference Line. After selecting 
this command the item is repositioned when the layout is redrawn. 
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The item is snapped to the Reference Line. 
 

 This command is only available if an item is selected and the Reference Line Options is set to 
Vertical or Horizontal. 
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Lock Items 

Select Edit Menu and click Lock Items to lock all items from being edited or altered on your badge 
layout. 
 

Use  option from the toolbar. 
 
Use this option to lock items to protect them from moving them by mouse. By clicking once you 
enable the option, by clicking again you disable the option.  When the items are locked, you still can 
edit them by double clicking on the item. 
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View Menu 
The View Menu appears as the third item in the menu bar, and contains commands relating to hiding 
or showing Project Explorer. You can Zoom In and Zoom Out of a badge layout, and can select either 
the front or back side of a card. 
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Zoom In 

Use  option from the toolbar or select View Menu and click Zoom In to zoom in closer on the 
design view of the currently opened layout. 
 

Normal View 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 359                                                                                                      

  

Zoom In 
 
Select Zoom In to view the layout on a larger scale. 
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Zoom Out 

Use  option from the toolbar or select View Menu and click Zoom Out to zoom out further from 
the design view of the currently opened layout. 
 

Zoom Out 
 
Select Zoom Out to make the image smaller, giving an overall view of the layout. 
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Center On Screen 

Select View Menu and click Center On Screen to center the current badge layout in the middle of the 
Main Screen. 
 

Center On Screen enabled 
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Center On Screen disabled 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 363                                                                                                      

  

Show Whole Badge 

Select View Menu and click Show Whole Badge.  
 
Use this option to fit the layout into the window. Use this option again (or press F11) if the window is 
resized. The size of the layout will be adjusted to the new size of the window. 
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Layout Side 

Front 

Use  option from the toolbar or select View Menu, then select Layout Side and click Front to 
view the front side of the open layout. 
 

Back 

Use  option from the toolbar or select View Menu, then select Layout Side and click Back to view 
the front side of the open layout. 
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Edit Header/Footer 

Select the View menu and click Edit Header/ Footer. Use this option to edit the header and footer of 
a badge layout or an A4 or Letter badge layout. 
 
In the header and footer only fixed items can be placed. 
 

 Dynamic items like database fields, image fields and barcodes are disabled. 
 
Click again on this menu option to disable it. You can also double click within the layout area to 
return to it. By double clicking on the header or footer you will enable Edit Header/Footer. 
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Show Project Explorer 

Select the View Menu and click Show Project Explore to show Project Explorer in the Main Screen. 
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Options Menu 
The Options Menu appears as the fourth item on the menu bar, and contains System Settings, 
Encode Settings. 
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System Settings... 

Select Options Menu and click System Settings.  
 

Default Font 
 

 
Default font 

 
Select and define a default font, font size, font style and color for static text and database fields. At 
the bottom of the dialog in the preview box this text will be displayed with selected font and color. 
 
Alignment: Defines how the text is positioned within the bounds specified by X start, 
Y start, Width and Height. 
 

• Left:  for left alignment. 
• Center:  for alignment in the middle. 
• Right:  for right alignment. 
• Strikeout: Draws a line through the selected text. 
• Underline: Specifies whether the selected text is underlined. 

 
Click Font to define. 
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• Font: Specifies a text font. In the box select a font name. Your choice will appear in the 
Sample Box. 

• Font Style: Specifies a font style such as Bold, Italic, Regular. Your choice will appear in the 
Sample Box. 

• Size: Specifies a font size in points. Select a size in the list. To ensure readability for most 
designs use a size of 8 points or larger. Your choice will appear in the Sample Box. 
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Zoom and Grid 
 

 
Zoom & Grid 

 
Zoom Factor: Select the default zoom factor for BadgeCreator, the zoom factor of the opened badge 
can be adjusted accordingly. 
 
Show Grid: Use this option to show a grid in the layout to help position items. 
Snap To Grid: When this option is activated existing items will be aligned to the closest point on the 
grid when they are moved. New items can be positioned on an in between value. This option will also 
work when the grid lines are not displayed. 
 
Grid Resolution: Select a grid resolution (mm). 
 
At the bottom of the dialog in the preview box this text will be displayed with selected font and color. 
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General 
 

 
General 

 
Show crosses for dynamic text in the layout: Use this option to represent the dynamic text by crosses. 
If this option is not checked, the field names are presented. 
 

 We advise to leave settings in the General dialog as default. 
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Encode Settings... 

Select Options Menu and click Encode Settings. The following dialog is presented. 
 

 
Connect Encodes 

 
In the Connect Encodes dialog link an encode layout to a badge layout. Check the right badge is 
selected. On the left-hand side of the window, the available configured encode layouts are displayed.  
 
Select one and click the transfer right button. 
 

 
 
Now the encode layout will be displayed on the right-hand side of the window. 
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Encode added 

 
Click Apply to save.  
 

 A combination of one chip encode layout and one magstripe layout is possible. Only one contact 
or contactless chip encode layout can be connected at a time. If you try to connect them both to a 
layout the following warning message is displayed. 
 

 
 
To disconnect an encode layout, select the layout on the right side and click the transfer left button. 
 

 
 
Click OK to close and save settings. 
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Reference Line... 

Select Options Menu and click Reference Line. The following dialog is presented. 
 

 
Reference line options 

 
No Reference Line: No reference line is created to align items too. 
 
Vertical: A vertical reference line is displayed, starting at the X position.  
 
There are three ways to align: Left (the left side of the item aligns with reference line), Centre (the 
centre of the item aligns with the reference line) or Right (the right side of the item aligns with the 
reference line). 
 
Horizontal: A horizontal reference line is displayed, starting at the X position. 
 
There are three ways to align: Top (the top of the item aligns with reference line), Centre (the centre 
of the item aligns with the reference line) or Bottom (the bottom of the item aligns with the reference 
line). 
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Help Menu 
The Help Menu appears as the last item on the menu bar, and contains commands relating to the 
handling of Help files. 
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Help Index 

Select Help Menu and click Help Index to open the Help File. 
 

Click  on the BadgeMaker Toolbar or click F1 on your keyboard. The following dialog is displayed. 
 

 
BM Help files 
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Introduction to Encoding 

 Magnetic Stripe Encoding 
 
Magstripe cards is based on the International Standard ISO/IEC 7811/2. 
 
Information is stored on a magnetic stripe laminated in the card. The stripe is swiped through a 
reader and the information encoded can be read. Magneticstripe cards can be placed in either a 
swipe or motorized reader/encoder to be read, rewritten, and verified in a fraction of a second. 
magstripe is also very easy to implement and cost effective. 
 

 Contact Chip Encoding 
 
Contact Chip cards is based on the International Standard ISO/IEC 7816. 
 
Contact Chip cards contain a memory chip that can be read or encoded. Chips can consist of a chip 
O/S (COS) managing memory and a microprocessor for encoding data and storing data. Storage will 
differ in capacity depending on the type of chip being encoded. 
 

 OMC Encoding 
 
OMC (Optical Memory Cards) is based on the International Standard ISO/IEC 11693 and 11694. 
 
OMC (Optical Memory Cards) utilize technology used to create CD's or CD ROM's. Laser sensitive 
material is laminated in the card and used to store information. An OMC card can store a large 
amount of data between 4 and 6.6MB. Photos, logos and fingerprints can be encoded into the card. 
The media is a write once read many (WORM) media. 
 

 MIFARE Encoding 
 
MIFARE is based on the International Standard ISO/IEC 14443 Type A.  
 
MIFARE is used for contactless smart card systems. MIFARE typically has a maximum read and write 
distance of 10cm. It is highly secure and reliable as there are no moving parts and no battery involved 
in MIFARE.  
 
MIFARE 1k features 
 

• MIFARE 1k has a storing capacity of 1 KB of information (768 Bytes). 
• Unique serial number of 4 Bytes 
• 16 secure sectors each sector consisting of 4 blocks with a length of 16 Bytes. 
• 2 x 48 bit keys per sector for key hierarchy. 
• Data Retention is around 10 years. 

 
MIFARE 4k features 
 

• MIFARE 4k has a storing capacity of 4 KB of information (3480 Bytes). 
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• Unique serial number of 4 Bytes. 
• 40 secure sectors. 32 sectors consist of 4 blocks with a length of 16 Bytes and 8 
• sectors consisting of 16 blocks with a length of 16 Bytes. 
• 2 x 48 bit keys per sector for key hierarchy. 
• Data Retention is around 10 years. 

 
 iClass Encoding 

 
iClass is based on the International Standard ISO/IEC 15693 and 14443.  
 
With iClass you can add biometrics, logging onto a PC, data storage and retrieval and other on-card 
applications. 
 
iClass consists of two types. 
 

• 2 KB chip 
• 16 KB chip 

 
A 2 KB chip will have 32 blocks of 8 bytes; 6 blocks are occupied by the manufacturers 
configuration and key storage data. Another 13 blocks are mostly occupied by the 
HID Access Control application. 
 
A 16 KB chip has 256 blocks of 8 bytes. Depending on the configuration defined, there 
can be 2 or 16 application areas.  
 

• 13.56 MHz interface. 
• Unique Serial number of 8 bytes. 
• Information encoded is encrypted through the use of secure algorithms. 
• Data Retention is around 10 years. 
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Magnetic Encoding 
Select the File Menu, click Mode, and then click Magnetic Layout to open Magnetic Layout Mode. 
 

Click  from the BadgeCreator Toolbar to create a Magnetic encode layout. 
 

Main Screen 
 

 
Mag encode screen 

 
In Magnetic Layout mode, magnetic layouts are created and edited. 
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Magnetic Encode Layout Toolbar 

The Toolbar in Magnetic Layout Mode can be used to quickly start a function by clicking on the 
desired button. 
 

 
 

 Back to Main Screen  
Click on this button to return to the BadgeMaker main screen. 

 

 Badge Layout Mode 
Click on this button to enter the badge layout mode to configure/create badge layouts. 

 

 Magnetic Layout Mode 
Click on this button to enter the magnetic layout mode to configure/create magnetic encode 
layouts. 

 

 Chip Mode 
Click on this button to enter the chip layout mode to configure/create chip encode layouts. 

 

 Mifare Mode 
Click on this button to enter the mifare layout mode to configure/create mifare layouts. 

 

 Open Layout 
Click on this button to open an existing Magnetic layout linked to the current project (*.BM) 
file. 

 

 New Layout 
Click on this button to start the New layout Wizard. 

 

 Save Layout 
Click on this button to save the current layout. 

 

  Add Field 
Click on this button, to add a field to the current track. 

 

 Delete Field 
Click on this button, to remove the selected field. 

 

 Track 1 
Click on this button to select track 1. 
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  Track 2 
Click on this button to select track 2. 

 

  Track 3 
Click on this button to select track 3. 
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Open An Existing Magnetic Layout 

Select File Menu and click Open Layout or use  from the toolbar. 
 
The following screen is presented. Configured Magnetic Layouts are listed here. 
 

 
Open layout 

 
Select Magstripe Demo. 
 
The Layout is presented in the Main Screen. 
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Magnetic Encoding Options Menu 

Encode Settings... 

Select Options Menu and click Encode Settings. The following dialog is presented. 
 

 
Connect encodes 

 
In the Connect Encodes dialog link an encode layout to a badge layout. Check the right badge is 
selected. On the left-hand side of the window, the available configured encode layouts are displayed.  
 
Select one and click the transfer right button. 
 

 
 
Now the encode layout will be displayed on the right-hand side of the window.  
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Click Apply to save.  
 

 A combination of one chip encode layout and one magstripe layout is possible. Only one contact 
or contactless chip encode layout can be connected at a time. If you try to connect them both to a 
layout the following warning message is displayed. 
 

 
 
To disconnect an encode layout, select the layout on the right side and click the transfer left button. 
 

 
 
Click OK to close and save settings. 
 
 
 
 
 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 386                                                                                                      

  

Encoding 

Select Options Menu and then click Encoding, the following dialog is presented. 
 
These options specify the Fill Character, Fill Up To End and Magicard Track options for magstripe 
tracks. 
 

Fill Up To End 
 

 
Fill up to end  

 
Fill Character up to position: Define per track which fill character to use. 
 

 Use fill characters that are allowed according to the ISO 3554 standard.  
 
Track 1.2.3.: Specify a character which is used to fill Track1.This track is only filled when a Track is 
checked. 
 

Fill Character 
 

 
 
Fill Up To End: Select a Track to fill the rest of the track with the selected Fill Character. 
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Magicard Options 

 

 
Magicard Options 

 
MPC: Magnetic bits per inch. Magnetic bits per character (set to 5 or 7) 
BPI: Bits per inch. Bits per Inch (set to 75 or 210) 
COE: High or low coercitivity. High or low coercively magstripe (select the magstripe to be used) 
 
Click OK to save settings and Cancel to undo any changes made.  
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Field Menu 

Add... 

Select Field Menu and click Add. Use  from the Magnetic Encode Mode Toolbar. 
 
The following dialog is presented to add a Field to the chip encode layout. 
 

 
Add field 

 
Select a field to add to your current project. 
 
Type 
 
Database Field: Information is extracted from fields specified by the operator and will be written 
onto the encode layout. (Dynamic) 
Constant: Static text or number. (Static) 
 
Start Position: Enter the Start Position of a field or text which has been selected to include in the 
encode layout. 
Length: Specify the number of characters to be used. 
Prefix with zero: Prefix data with 0's if data is smaller than the length specified. 
 
Data: Display's the selected field chosen to add. 
 
 Select OK and see the new field has been added to your magnetic encode layout. 
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Edit... 

Select Field Menu and click Edit. The following dialog is presented to edit a Field in the magnetic 
encode layout. 
 

 
Edit field 

 
Edit settings configured for a specific field. 
 
Type 
 
Database Field: Information is extracted from fields specified by the operator and will be written 
onto the encode layout. (Dynamic) 
Constant: Static text or number. (Static) 
 
Start Position: Enter the Start Position of a field or text which has been selected to include in the 
encode layout. 
Length: Specify the number of characters to be used. 
Prefix with zero: Prefix data with 0's if data is smaller than the length specified. 
 
Data: Display's the selected field chosen to add. 
 
Select OK and see the new field has been edited in your magnetic encode layout. 
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Delete 

First you must select a field and then select Field Menu and click Delete. Use   from the Magnetic 
Encode Mode Toolbar. 
 
The following dialog is presented to delete a Field in the magnetic encode layout. 
 

 
 
Select Yes to confirm deletion or No to cancel deletion. 
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Tracks Menu 

Track 1 

Select the Track Menu and then select Track 1.  
 

Select  from the Magnetic encode toolbar to edit and view fields configured on Track 1. 
 
Data added to Track 1 will show the following dialog screen. 
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Track 2 

Select the Track Menu and then select Track 2.  
 

Select  from the Magnetic encode toolbar to edit and view fields configured on Track 2. 
 
Data added to Track 2 will show the following dialog screen. 
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Track 3 

Select the Track Menu and then select Track 3.  
 

Select  from the Magnetic encode toolbar to edit and view fields configured on Track 3. 
 
Data added to Track 3 will show the following dialog screen. 
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Chip Encoding 
Select the File Menu, click Mode, and then click Chip Encode Layout to open Chip Encode Layout 
Mode. 
 

Click  from the BadgeCreator Toolbar and select Chip Mode from the drop down menu. 
 

 
 

Main Screen 
 

 
Chip layout main screen 

 
In Chip Encode Layout mode, chip layouts are created and edited. 
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Chip Encode Layout Toolbar 

The Toolbar in Chip Layout Mode can be used to quickly start a function by clicking on the desired 
button. 
 

 
 

  Back to Main Screen 
Click on this button to return to the BadgeMaker main screen. 

 

  Badge Layout Mode 
Click on this button to enter the badge layout mode to configure/create badge layouts. 

 

 Magnetic Layout Mode 
Click on this button to enter the magnetic layout mode to configure/create magnetic encode 
layouts. 

 

  Chip Mode 
Click on this button to enter the chip layout mode to configure/create chip encode layouts. 

 

 Open Layout 
Click on this button to open an existing Chip Layout Mode linked to the current project 
(*.BM) file. 

 

 New Layout 
Click on this button to start the New layout Wizard. 

 

 Save Layout 
Click on this button to save the current layout. 

 

 Add Field 
Click on this button, to add a field to the current track. 

 

 Delete Field 
Click on this button, to remove the selected field. 
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Open An Existing Chip Layout 

Select File Menu and click Open Layout. 
 
The following screen is presented. Configured Chip Layouts are listed here. 
 

 
Select DEMO 

 
Select Chip Demo. 
 
The Layout is presented in the Main Screen. 
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Options Menu 

Encode Settings... 

Select Options Menu and click Encode Settings. The following dialog is presented. 
 

 
Connect encodes 

 
In the Connect Encodes dialog link an encode layout to a badge layout. Check the right badge is 
selected. On the left-hand side of the window, the available configured encode layouts are displayed.  
 
Select one and click the transfer right button. 
 

 
 
Now the encode layout will be displayed on the right-hand side of the window. 
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Click Apply to save.  
 

 A combination of one chip encode layout and one magstripe layout is possible. Only one contact 
or contactless chip encode layout can be connected at a time. If you try to connect them both to a 
layout the following warning message is displayed. 
 

 
 
To disconnect an encode layout, select the layout on the right side and click the transfer left button. 
 

 
 
Click OK to close and save settings. 
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Field Menu 

Add... 

Select Field Menu and click Add. Use   from the Chip Encode Mode Toolbar. 
 
The following dialog is presented to add a Field to the chip encode layout. 
 

 
Add field 

 
Select a field to add to your current chip layout. 
 
Database Field: Information is extracted from fields specified by the operator and will be written 
onto the encode layout. (Dynamic) 
Constant: Static text or number. (Static) 
 
Data: Display's the selected field chosen to add. 
Comment: Add a comment to you added field. 
 
Select OK and see the new field has been added to your chip encode layout. 
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Edit 

Select Field Menu and click Edit. The following dialog is presented to edit a Field in the chip encode 
layout. 
 

 
 
Edit settings configured for a specific field. 
 
Type 
 
Database Field: Information is extracted from fields specified by the operator and will be written 
onto the encode layout. (Dynamic) 
Constant: Static text or number. (Static) 
Data: Display's the selected field chosen to add. 
Comment: Add a comment to you added field. 
 
Select OK and see the new field has been edited in your chip encode layout. 
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Delete 

First you must select a field and then select Field Menu and click Delete. Use  from the Chip 
Encode Mode Toolbar. 
 
The following dialog is presented to delete a Field in the chip encode layout. 
 

 
 
Select Yes to confirm deletion or No to cancel deletion. 
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Include Image 

Select Field Menu and then click Include Image. 
 
The following dialog is presented. 
 

 
Include images 

 
Select which Image to save onto the chip layout. Select from the following types. 
 

• Photo 
• Sign 
• Photo thumb 
• Sign thumb 
• Finger Template 
• Finger Image 

 
 Images are larger in size and therefore can take up a lot of space. Images must be reduced in size 

to fit onto a chip. 
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Dll Params 

Select Field Menu and then click Dll Params. 
 
Type the name of your <chip.dll> to use for encoding information onto a chip. If for some reason 
additional information is required, this information can be supplied using these parameters. 
 
The following screen is presented. 
 

 
Enter .dll params 

 
Dll Name: Enter the name of the <chip.dll> 
 
Dll Param1: Enter a parameter. 
 
Dll Param2: Enter a parameter. 
 

 Chip encode layouts cannot be saved when no chip.dll has been specified. 
 
BMChip32.dll is installed with BadgeMaker to carry out encode simulation. Custom Dll’s must be 
designed using Chip Skeleton in order to successfully encode a chip. Chip Skeleton gives you a 
framework to develop a chip *.dll.  
 

 Dll's are stored in the following directory C:\SC\<BMversion> 
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Mifare Encoding 
Select the File Menu, click Mode, and then click Mifare Encode Layout to open Mifare Encode Layout 
Mode. 
 

Click  from the BadgeCreator Toolbar and select Mifare Mode from the drop down menu. 
 

 
 

Main Screen 
 

 
 
In Mifare Encode Layout mode, mifare layouts are created and edited. 
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Mifare Encode Layout Toolbar 

The Toolbar in Mifare Layout Mode can be used to quickly start a function by clicking on the desired 
button. 
 

 
 

 Back to Main Screen 
Click on this button to return to the BadgeMaker main screen. 

 

 Badge Layout Mode 
Click on this button to enter the badge layout mode to configure/create badge layouts. 

 

 Magnetic Layout Mode 
Click on this button to enter the magnetic layout mode to configure/create magnetic encode 
layouts. 

 

 Chip Mode 
Click on this button to the chip layout mode to configure/create chip encode layouts. 

 

 Mifare Mode 
Click on this button to enter the Mifare Layout Mode to configure/create Mifare Layouts. 

 

 Open Layout 
Click on this button to open an existing Mifare layout linked to the current project (*.BM) file. 

 

 New Layout 
Click on this button to start the New layout Wizard. 

 

 Save Layout 
Click on this button to save the current layout. 

 

 Add Field 
Click on this button, to add a field to the current track. 

 

 Add Function 
Click on this button, to add a function to the current track. 

 

 Add Binary Item 
Click on this button, to add a binary field to the Mifare Layout. 
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 Add DB Field 
Click on this button, to store a constant, counted value or card serial in a database. 

 

 Remove Item 
Click on this button, to remove a field from the layout. 

 

 Preview 
Click on this button, to preview a layout. 
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Open An Existing Mifare Layout 

Select File Menu and click Open Layout or use  from the toolbar. 
 
The following screen is presented. Configured Mifare Layouts are listed here. 
 

 
 
Select Mifare Demo. 
 
The Layout is presented in the Main Screen. 
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Mifare DEMO 
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Mifare Menu 

Add Field 

Select Mifare Menu and click Add Field or use  from the toolbar.  
 
The following dialog is displayed. 
 

 
 
Select a field to add to your current mifare layout. 
 
Add to 
 
Track: Select which track to write the field to. 
Block: Select a block to write a field to. 
Begin Byte: Select a Begin Byte to write the field to. 
No. of bytes: Select the number of bytes needed for a field  
 
When creating a New Mifare Layout the operator will have the option to enable Allow 
multitrack database items (non-binary): Select this option to scan a field across 
multiple tracks (for larger segments of information). 
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Encode As 
 
Encode As: Select the method to encode information onto the card. Select an option from the 
following. 
 

 Options are dependent on field type. 
 

Character 
 

 
 
String: (field type character, numeric and date) 
 

Date 
 

 
 
String: (field type character, numeric and date) 
Decimal: (field type numeric) 
Binary coded decimal: (field type numeric and date) 
 

Numeric 
 

 
 
String: (field type character, numeric and date) 
Motorola decimal: (field type numeric) 
Intel decimal: (field type numeric) 
Binary coded decimal: (field type numeric and date) 
 
The contents of a date field can be encoded in different orders. Select a set from the drop down list. 
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In case you encode as a string every character is represented by its ASCII value (every character is 
encoded into one byte).  
 
Motorola en Intel decimal encoding work with hexadecimal values. Special hexadecimal encoding is a 
mixture (hexadecimal notation without decimal to hexadecimal conversion of the value). 
 
Example  
 
Suppose the database has a numeric field with 4 positions named ID number. The value 
is 1500 (=05DC hex).  
 
The following ways of encoding are possible. 
 

 
 
In the case the largest value of the field ID number would be 9999999 (98967F hex), 
there would be 7 bytes needed to encode it as a string, 3 bytes to encode it as Motorola 
or Intel decimal and 4 bytes to encode it as special hex. 
 

 
 
The following example shows how unused bytes are filled when the number of bytes 
assigned for the field is more than needed. 
 
Number of bytes assigned is 6, the value is 1500. 
 

 
 
At the bottom an overview summary is shown illustrating the fields positioned on 
the current layout. It is possible to scroll down and view the entire layout structure of the mifare 
encode layout. 
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Summary 

 
Numbers running across are the number of bytes in each Block. Number running down the left hand 
side are the number of Blocks to a Track. 
 
Select OK to add the newly created field.. 
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Add Function 

Select Mifare Menu and click Add Function or use  from the toolbar.  
 
The following dialog is displayed. 
 

 
Add functions 

 
 Except for the card serial number, functions occupy one byte. 

 
Function 
 
Constant: Select a value between 0 and 255. This value will be encoded into the selected byte. If 
more than one byte is selected, same value will be encoded to every byte. The value can also be read 
from the database. Select Field listed in the Function Properties, the value from the field will be 
encoded onto the chip layout.  
 
Count: The counter function can read a value from the database and increment it with 
a defined value (e.g. the number of times a new card is issued for the same individual 
can be stored in the database), or an array with incremental values can be encoded. 
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Function Properties 
 
In Function Properties you can select if the value must be incremented after it is written to the card. 
 
Value: Select a value between 0 and 255. 
 
Card Serial Number: The card serial number (encoded by the manufacturer in track 0) can be read 
from the card and encoded another time in one of the other tracks. It can be encoded as a decimal 
string (10 bytes) or hexadecimal string (8 bytes). 
 
Checksum: A checksum can be calculated over a number of bytes. Select the way the checksum is 
calculated, select where the checksum should be stored and select the bytes where the checksum 
should be calculated over. The checksum is one byte, if more than one byte is selected for the 
checksum, the value of the checksum will be repeated in every byte. 
 
Function Properties 
 
In Function Properties you can select the way a checksum is calculated. 
 
XOR 
 
I 0 0 I I 0 0 I 
0 I I 0 0 I I 0 
0 0 I I 0 0 0 I 
I I I 0 I I I 0 
0 I I I I 0 I 0 
 
Result: 0  I   0  I   I  0  I  0 
 
Selecting XOR will always result in a value that fits into one byte. 
 
ADD 
 
I 0 0 I I 0 0 I 
0 I I 0 0 I I 0 
0 0 I I 0 0 0 I 
I I I 0 I I I 0 
0 I I I I 0 I 0 
 
Result: I  0   I  0  0  I   I  0  0  0 
 

 When ADD is selected the low byte value will be written to the card. 
 
Parity 
 
A parity check can be selected, since encoding is done in minimal parts of one byte, it will occupy one 
byte only. 
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Polynomial CRC 
 
Use a polynomial to calculate the checksum. When you use a polynomial fill in the polynomial you 
would like to use. 
 
Example: The polynomial to use is x8+x5+x4+x2+1. This is represented by the binary value 
100110101 (309 in decimal). In the PolyOne text box a decimal value must be specified. This decimal 
value must be between 257 and 511 (between 100000001 and 111111111 binary). 
 
Start Value: Select a value between 0 and 255 and fill it in, in the box . 
 

 Polynomial CRC is the most reliable way to calculate a checksum. 
 
At the bottom an overview summary is shown illustrating the fields positioned on the current layout. 
It is possible to scroll down and view the entire layout structure of the mifare encode layout. 
 

 
Summary 

 
Numbers running across are the number of bytes in each Block. Number running down the left hand 
side are the number of Blocks to a Track. 
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Add Binary Item... 

Select Mifare Menu and click Add Binary Item or use   from the toolbar.  
 
The following dialog is displayed. 
 

 
Add binary fields 

 
Add a binary field to the Mifare Layout. 
 
Select an Image Type stored as a BLOB (Binary Large Objects). Below as an example Photo is chosen. 
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Select the range on the card where it should be encoded.  
 

 Most images (photos, signatures or fingerprint images) are too big to encode on a card. 
Biometric data such as fingerprint or hand palm characteristics are in general small enough to store 
on the card. 
 

• Track: Select a Begin & End Track to write the field to. 
• Block: Select a Begin & End Block to write a field to. 
• Byte: Select a Begin & End Byte to write the field to. 

 
Select Apply to insert the new binary field. Click OK to exit. 
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Edit Item 

Select Mifare Menu and click Edit Item.  
 
The following dialog is displayed. 
 

 
Add field dialog 

 
Select a field to edit in your current mifare layout. 
 
Fields 
 

• Track: Select which track to write the field to. 
• Block: Select a block to write a field to. 
• Begin Byte: Select a Begin Byte to write the field to. 
• No. of bytes: Select the number of bytes needed for a field  

 
 When creating a New Mifare Layout the operator will have the option to enable Allow 

multitrack database items (non-binary): Select this option to scan a field across multiple tracks (for 
larger segments of information). 
 
At the bottom an overview summary is shown illustrating the field and where it is 
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positioned on the current layout. It is possible to scroll down and view the entire 
layout structure of the mifare encode layout. 
 

 
Summary 

 
Numbers running across are the number of bytes in each Block. Number running down the left hand 
side are the number of Blocks to a Track. 
 
Select OK to apply the change. 
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Add Database Update 

Select Mifare Menu and click Add Database Update or use  from the toolbar.  
 
The following dialog is displayed. 
 

 
 
Select a field from the database which will be updated automatically from information and a card 
when the Mifare card is read. 
 
Constant: A constant value can be stored in the selected field. When the card is encoded, the value 
will be written in the field. (Fixed Text) 
Count: A counted value can be stored in the selected field. It will be incremented for every card 
encoded. The start value can be given in or can be read from another (or the same) field. 
Card Serial No: The card serial number that was written in the card by the manufacturer can be 
stored in the database when the card is encoded.  
 
Example 
 
A card serial number that was written in the card by the manufacturer can be stored in the database 
when the card is encoded. That way it is possible to check the database which card number was 
assigned to a certain person. This number can be stored as a decimal or hexadecimal value. 
 
The database update functions are displayed in the lower half of the main screen. 
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DB Update field 
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MM10 Integration 

Select Mifare Menu and click MM10 Integration. 
 
If you wish to make a link with MM10 Integration (Mifare Technology) you can link fields from 
BadgeMaker to fields in the MM10 Integration.  
 
The following dialog is displayed. 
 

 
Settings 

 
Select Enable Carthago Section and set the Begin Track for MM10 on the Mifare chip and the Nr of 
Tracks used by MM10 Integration. 
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Select an MM-10 Field and map a BM Field to it. 
 
Select OK to apply changes or Cancel to undo any changes made. 
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QE Integration 

Select Mifare Menu and click QE Integration. 
 
The following dialog is presented. 
 

 
QE Settings 

 
Select Enable QE Section to encode Mifare cards for use in QA10/QV10 environments. 
 
Select which tracks will be used.  QE Integration requires 3 tracks to encode. 
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Map a QE Field to a BM Field from your database to set up. 
 

 
 
Select OK to save the QE configuration or Cancel to undo any changes made.  
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Remove Item 

First you must select a field and then select Mifare Menu and click Remove Item or use  from the 
toolbar.  
 
The following dialog is displayed. 
 

 
 
Select Yes to remove the selected field or No to cancel removal. 
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Remove DB Update Item 

First you must select a field and then select Mifare Menu and click Remove DB Update Item or use   
from the toolbar.  
 
The following dialog is displayed. 
 

 
 
Select Yes to remove the selected DB Update field or No to cancel removal. 
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Overview 

Select Mifare Menu and click Overview.  
 
The following dialog is displayed. 
 

 
Mifare Summary overview 

 
The overview display's a preview of the data that will be encoded onto the current layout.  
 
Full Screen: Display the Overview full screen (enlarged). 
Print: To print the Overview select this option. 
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Edit MAD 

Select Mifare Menu and click Edit MAD. 
 
MIFARE Application Directory (MAD) defines common data structures for card application directory 
entries, allowing terminals to identify the right card (and the right memory sector within the card) 
without the need to perform a comprehensive search through all of the cards’ memories until the 
appropriate application is found. 
 
The following dialog is presented. 
 

 
 
MAD (Mifare Application Directory) can be used to assign different applications to different tracks 
 

• To administrate free tracks  
• To register card holder info  
• To register card publisher info 
• To protect tracks against writing new data 

 
Select Use Mifare Application Directory to enable. 
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MAD 

 
MAD 
 
Select the MAD tab, the following dialog is presented. 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 436                                                                                                      

  

 
MAD 

 
Select New to assign an application to tracks  
 

 
Application info 

 
Specify a Function cluster. Specify an Application code. 
 
Show as either Decimal or Hexadecimal. 
 
Select Save + exit to return to the main MAD dialog box. 
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Select which tracks are to be assigned to the Mifare Application. 
 
Select OK to close.  
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Admin 
 
Select the Admin tab, the following dialog is presented. 
 

 
Admin 

 
Select which of the tracks not yet populated in the layout will remain free. 
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Selected tracks will be highlighted in blue. 
 
Select OK to close. 
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Card Holder Info 
 
Select the Card Holder Info tab, the following dialog is presented. 
 

 
Card holder info 

 
Select Enable Card Holder Info to select the appropriate database fields for the individual. 
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Use the drop down lists to select a field from your database. 
 
Select OK to close. 
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Card Publisher Info 
 
Select the Card Publisher Info tab, the following dialog is presented. 
 

 
Card Publisher Info 

 
Select Enable Card Publisher Info to enter Card Publisher Info and assign a track to write the 
information to. 
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Protection 
 
Select the Protection tab, the following dialog is presented. 
 

 
Protection 

 
Select the tracks to be protected against a failure occurring during the write process. 
 
Selected tracks are shown highlighted. 
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 © 1993-2009 ScreenCheck B.V.        PAGE 446                                                                                                      

  

Options Menu 

Encode Settings... 

Select Options Menu and click Encode Settings. The following dialog is presented. 
 

 
Connect encodes 

 
In the Connect Encodes dialog link an encode layout to a badge layout. Check the right badge is 
selected. On the left-hand side of the window, the available configured encode layouts are displayed.  
 
Select one and click the transfer right button. 
 

 
 
Now the encode layout will be displayed on the right-hand side of the window. 
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Click Apply to save.  
 

 A combination of one chip encode layout and one magstripe layout is possible. Only one contact 
or contactless chip encode layout can be connected at a time. If you try to connect them both to a 
layout the following warning message is displayed. 
 

 
 
To disconnect an encode layout, select the layout on the right side and click the transfer left button. 
 

 
 
Click OK to close and save settings. 
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Settings 

Select Options Menu and click Settings. 
 
The following dialog is displayed. 
 

 
Settings 

 
Mifare Version 
 
Select the type of Mifare Chip being used.  
 

• Mifare 1K classic: Select a Mifare 1K classic type. 
• Mifare 4K classic: Select a Mifare 4K classic type. 

 
Allow multitrack database items (non-binary): Select this option to scan a field across multiple tracks. 
 

 Binary items will not be affected by this setting. 
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iClass Encoding 
Select the File Menu, click Mode, and then click iClass Encode Layout to open iClass Encode Layout 
Mode. 
 

Click  from the BadgeCreator Toolbar and select iClass Mode from the drop down menu. 
 

 
 

Main Screen 
 

 
 

In iClass Encode Layout mode, iClass layouts are created and edited. 
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iClass Encode Layout Toolbar 

The Toolbar in iClass Layout Mode can be used to quickly start a function by clicking on the desired 
button. 
 

 
 

 Back to Main Screen 
Click on this button to return to the BadgeMaker main screen. 

 

 Badge Layout Mode 
Click on this button to enter the badge layout mode to configure/create badge layouts. 

 

  Magnetic Layout Mode 
Click on this button to enter the magnetic layout mode to configure/create magnetic encode 
layouts. 

 

 Chip Mode 
Click on this button to the chip layout mode to configure/create chip encode layouts. 
 

 iClass Mode 
Click on this button to enter the Mifare Layout Mode to configure/create iClass Layouts. 

 

 Open Layout 
Click on this button to open an existing iClass layout linked to the current project (*.BM) file. 

 

 New Layout 
Click on this button to start a New layout Wizard. 

 

  Save Layout 
Click on this button to save the current layout. 

 

 Add Field 
Click on this button, to add a field to the current track. 

 

 Add Function 
Click on this button, to add a function to the current track. 

 

  Add Binary Item 
Click on this button, to add a binary field to the iClass Layout. 

 

 Add DB Field 
Click on this button, to store a constant, counted value or card serial in a database. 
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 Remove Item 
Click on this button, to remove a field from the layout. 

 

 Preview 
Click on this button, to preview a layout. 
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Open An Existing iClass Layout 

Select File Menu and click Open Layout or use  from the toolbar. 
 
The following screen is presented. Configured iClass Layouts are listed here. 
 

 
Open layout 

Select an iClass Demo from the list. 
 
For this example iClassDemo16k8 is chosen. 
 
The Layout is presented in the Main Screen. 
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iClass Menu 

Add Field 

Select iClass Menu and click Add Fields or use  from the toolbar.  
 
The following dialog is displayed. 
 

 
Add fields 

 
Select a field to add to your current mifare layout. 
 
Fields: Specifies the selected filed currently being configured. 
 
Add to 
 

• Page: Select which Page to write the field to, (for 16K/16 chips only). 
• Block: Select a block to write a field to, (6 –31 or 19-255). 
• Begin Byte: Select a Begin Byte to write the field to, (0 - 7). 
• No. of bytes: Select the number of bytes needed for a field . 

 
Encode As 
 
Encode As: Select the method to encode information onto the card. Select an option 
from the following. 
 

 Options are dependent on field type. 
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Character 
 

 
 

String:  (field type character, numeric and date) 
 

Date 
 

 
 

• String: (field type character, numeric and date) 
• Decimal: (field type numeric) 
• Binary coded decimal: (field type numeric and date) 

 
Numeric 

 

 
 

String: (field type character, numeric and date) 
Motorola decimal: (field type numeric) 
Intel decimal: (field type numeric) 
Binary coded decimal: (field type numeric and date) 
Decimal: (field type date), the decimal can be coded in various sequences.  
 
The contents of a date field can be encoded in different orders. Select a set from the drop down list. 
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In case you encode as a string every character is represented by its ASCII value (every character is 
encoded into one byte).  
 
Motorola and Intel decimal encoding work with hexadecimal values. Special hexadecimal encoding is 
a mixture (hexadecimal notation without decimal to hexadecimal conversion of the value). 
 
Example  
 
Suppose the database has a numeric field with 4 positions named ID number. The value 
is 1500 (=05DC hex).  
 
The following ways of encoding are possible. 
 

 
 

In the case the largest value of the field ID number would be 9999999 (98967F hex), there would be 7 
bytes needed to encode it as a string, 3 bytes to encode it as Motorola or Intel decimal and 4 bytes to 
encode it as special hex. 
 

 
 

The following example shows how unused bytes are filled when the number of bytes assigned for the 
field is more than needed. 
 
Number of bytes assigned is 6, the value is 1500. 
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On the right half of the dialog an overview summary is shown illustrating the fields positioned on the 
current layout. 
 

 
iClass summary 

 
Numbers running across are the number of bytes in each Block. Number running down the left hand 
side are the number of Blocks to a Track. 
 
Select OK to add the newly created field. 
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Add Function 

Select iClass Menu and click Add Function or use  from the toolbar.  
 
The following dialog is displayed. 
 

 
Add function 

 
Function 
 
Constant: Select a value between 0 and 255. This value will be encoded into the selected byte. If 
more than one byte is selected, same value will be encoded to every byte. The value can also be read 
from the database. Select Field listed in the Function Properties, the value from the field will be 
encoded onto the chip layout.  
 
Count: The counter function can read a value from the database and increment it with a defined 
value (e.g. the number of times a new card is issued for the same individual can be stored in the 
database), or an array with incremental values can be encoded. 
 
Function Properties 
 
In Function Properties you can select if the value must be incremented after it is written to the card. 
Select if the value must be incremented after it is written to the card Write before increment or 
before it is written to the card Increment before write. 
 
Start Value: Select a Start Value between 0 and 255. 
Card Serial Number: The card serial number (encoded by the manufacturer in track 0) can be read 
from the card and encoded another time in one of the other tracks. It can be encoded as a decimal 
string (10 bytes) or hexadecimal string (8 bytes). 
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Checksum: A checksum can be calculated over a number of bytes. Select the way the checksum is 
calculated, select where the checksum should be stored and select the bytes where the checksum 
should be calculated over. The checksum is one byte, if more than one byte is selected for the 
checksum, the value of the checksum will be repeated in every byte. 
 
Function Properties 
 
In Function Properties you can select the way a checksum is calculated. 
 
XOR 
 
I 0 0 I I 0 0 I 
0 I I 0 0 I I 0 
0 0 I I 0 0 0 I 
I I I 0 I I I 0 
0 I I I I 0 I 0 
 
Result: 0  I   0  I   I  0  I  0 
 
Selecting XOR will always result in a value that fits into one byte. 
 
ADD 
 
I 0 0 I I 0 0 I 
0 I I 0 0 I I 0 
0 0 I I 0 0 0 I 
I I I 0 I I I 0 
0 I I I I 0 I 0 
 
Result: I  0   I  0  0  I   I  0  0  0 
 

 When ADD is selected the low byte value will be written to the card. 
 
Parity 
 
A parity check can be selected, since encoding is done in minimal parts of one byte, it will occupy one 
byte only. 
 
Polynomial CRC 
 
Use a polynomial to calculate the checksum. When you use a polynomial fill in the polynomial you 
would like to use. 
 
Example: The polynomial to use is x8+x5+x4+x2+1. This is represented by the binary value 
100110101 (309 in decimal). In the Polynom text box a decimal value must be specified. This decimal 
value must be between 257 and 511 (between 100000001 and 111111111 binary). 
 
Start Value: Select a value between 0 and 255 and fill it in, in the box. 
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 Polynomial CRC is the most reliable way to calculate a checksum. 
 
Add To 
 

• Page: Select which Page to write the field to, (for 16K/16 chips only). 
• Block: Select a block to write a field to, (6 –31 or 19-255). 
• Begin Byte: Select a Begin Byte to write the field to, (0 - 7). 
• No. of bytes: Select the number of bytes needed for a field . 

 
On the right half of the dialog an overview summary is shown illustrating the fields positioned on the 
current layout. 
 
Click OK to exit. 
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Add Binary Item 

Select iClass Menu and click Add Binary Item or use  from the toolbar.  
 
The following dialog is displayed. 
 

 
Add binary fields 

Add a binary field to a iClass Layout. 
 
Select an Image Type stored as a BLOB (Binary Large Objects). Below as an example Fingerprint is 
chosen. 
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  Most images (photos, signatures or fingerprint images) are too big to encode on a card. 
Biometric data such as fingerprint or hand palm characteristics are in general small enough to store 
on the card. 
 
Add To 
 

• Page: Select which Page to write the field to, (for 16K/16 chips only). 
• Block: Select a block to write a field to, (6 –31 or 19-255). 
• Begin Byte: Select a Begin Byte to write the field to, (0 - 7). 
• No. of bytes: Select the number of bytes needed for a field . 

 
On the right half of the dialog an overview summary is shown illustrating the fields positioned on the 
current layout. 
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Summary 

 
Select Apply to insert the new binary field. Click OK to exit. 
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Edit Item 

Select iClass Menu and click Edit Item. 
 
The following dialog is displayed. 
 

 
 
Edit the currently selected field, assign the field data to another Page, Block or specify a Begin Byte 
and specify the No. of Bytes. 
 
Add to 
 

• Page: Select which Page to write the field to, (for 16K/16 chips only). 
• Block: Select a block to write a field to, (6 –31 or 19-255). 
• Begin Byte: Select a Begin Byte to write the field to, (0 - 7). 
• No. of bytes: Select the number of bytes needed for a field . 
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Add Database Update 

Select iClass Menu and click Add Database Update or use  from the toolbar.  
 
The following dialog is displayed. 
 

 
DB Update 

 
Select a field from the database which will be updated automatically from information on a card 
when the Mifare card is read. 
 
Constant: A constant value can be stored in the selected field. When the card is encoded, the value 
will be written in the field. (Fixed Text) 
Count: A counted value can be stored in the selected field. It will be incremented for every card 
encoded. The start value can be given in or can be read from another (or the same) field. 
Card Serial No: The card serial number that was written in the card by the manufacturer can be 
stored in the database when the card is encoded.  
 
Example 
 
A card serial number that was written in the card by the manufacturer can be stored in the database 
when the card is encoded. That way it is possible to check the database which card number was 
assigned to a certain person. This number can be stored as a decimal or hexadecimal value. 
 
The database update functions are displayed in the lower half of the main screen. 
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DB Update 
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Remove Item 

First you must select a field and then select iClass Menu and click Remove Item or use  from the 
toolbar.  
 
The following dialog is displayed. 
 

 
 

Select Yes to remove the selected field or No to cancel removal. 
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Remove DB Update Item 

First you must select a field and then select iClass Menu and click Remove DB Update Item or use 

 from the toolbar.  
 
The following dialog is displayed. 
 

 
 

Select Yes to remove the selected DB Update field or No to cancel removal. 
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Overview 

Select iClass Menu and click Overview or use  from the toolbar.  
 
The following dialog is displayed. 
 

 
Summary 

 
The overview display's a preview of the data that will be encoded onto the current layout. 
 
Click Next to view the next pages of your encode layout. 
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Print: To print the Overview select this option. 
 
Select OK to close 
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Options 

Encode Settings... 

Select Options Menu and click Encode Settings. The following dialog is presented. 
 

 
Connect encodes 

 
In the Connect Encodes dialog link an encode layout to a badge layout. Check the right badge is 
selected. On the left-hand side of the window, the available configured encode layouts are displayed.  
 
Select one and click the transfer right button. 
 

 
 

Now the encode layout will be displayed on the right-hand side of the window.  
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Click Apply to save.  
 

 A combination of one chip encode layout and one magstripe layout is possible. Only one contact 
or contactless chip encode layout can be connected at a time. If you try to connect them both to a 
layout the following warning message is displayed. 
 

 
 

To disconnect an encode layout, select the layout on the right side and click the transfer left button. 
 

 
 

Click OK to close and save settings. 
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Settings 

Select Options and then click Settings. 
 
The following dialog is displayed. 
 

General Properties 
 

 
General Properties 

 
Define Chip Configuration. 
 

• 2Kbit Chip 
• 16Kbit Chip 

 
Click OK to close. 
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Application Boundaries 
 

 
 

Set Application Boundaries for your pages. 
 
Click OK to close. 
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Legic Encoding 
Select the File Menu, click Mode, and then click Legic Encode Layout to open Legic Encode Layout 
Mode. 
 

Click  from the BadgeCreator Toolbar and select Legic Mode from the drop down menu. 
 

 
 

Main Screen 
 

 
 

In Legic Encode Layout mode Legic layouts are created and edited. 
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Legic Encode Layout Toolbar 

The Toolbar in Legic Layout Mode can be used to quickly start a function by clicking on the desired 
button. 
 

 
 

 Back to Main Screen 
Click on this button to return to the BadgeMaker main screen. 

 

 Badge Layout Mode 
Click on this button to enter the badge layout mode to configure/create badge layouts. 

 

 Magnetic Layout Mode 
Click on this button to enter the magnetic layout mode to configure/create magnetic  encode 
layouts. 

  

 Chip Mode 
Click on this button to enter the chip layout mode to configure/create chip encode layouts. 

 

 Legic Mode 
Click on this button to enter the Legic layout Mode to configure/create Legic layouts. 

 

  Open Layout 
Click on this button to open an existing Legic layout linked to the current project (*.BM) file. 

 

 New Layout 
Click on this button to start the New layout Wizard. 

 

 Save Layout 
Click on this button to save the current layout. 

 

 Add Field 
Click on this button, to add a field to the current track. 

 

  Add Function 
Click on this button, to add a function to the current track. 

 

  Add DB Field 
Click on this button, to store a constant, counted value or card serial in a database. 

 

 Remove Item 
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Click on this button, to remove a field from the layout. 
   

 Preview 
Click on this button, to preview a layout. 
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Open An Existing Legic Layout 

Select File Menu and click Open Layout or use  from the toolbar. 
 
The following screen is presented. Configured Legic Layouts are listed here. 
 

 
Open layout 

Select a Legic Demo from the list (Lg). 
 
For this example Access is chosen. 
 
The Layout is presented in the Main Screen. 
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Legic Menu 

Add Field 

Select Legic Menu and click Add Field or use  from the toolbar.  
 
The following dialog is displayed. 
 

 
Add fields 

 
Select a field to add to your current Legic layout. 
 
Fields 
 

• Row: Select which row to write the field to. 
• Begin Byte: Select a Begin Byte to write the field to (0 - 15). 
• No. of bytes: Select the number of bytes needed for a field  

 
At the bottom an overview summary is shown illustrating the fields positioned on the current layout. 
It is possible to scroll down and view the entire layout structure of the mifare encode layout. 
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Summary 

 
 BadgeCreator divides a segment in rows of 16 bytes. The first row (row 0) is always partially 

occupied with a Header, SCC and Stamp. 
 
Encode As 
 
Encode As: Select the method to encode information onto the card. Select an option from the 
following. 
 

 Options are dependent on field type. 
 

Character 
 

 
 

String: (field type character, numeric and date) 
 

Date 
 

 
 

• String: (field type character, numeric and date) 
• Decimal: (field type numeric) 
• Binary coded decimal: (field type numeric and date) 
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Numeric 
 

 
 
String: (field type character, numeric and date) 
Motorola decimal: (field type numeric) 
Intel decimal: (field type numeric) 
Binary coded decimal: (field type numeric and date) 
 
The contents of a date field can be encoded in different orders. Select a set from the drop down list. 
 
In case you encode as a string every character is represented by its ASCII value (every 
character is encoded into one byte).  
 
Motorola en Intel decimal encoding work with hexadecimal values. Special hexadecimal 
encoding is a mixture (hexadecimal notation without decimal to hexadecimal conversion 
of the value). 
 
Example  
 
Suppose the database has a numeric field with 4 positions named ID number. The value 
is 1500 (=05DC hex).  
 
The following ways of encoding are possible. 
 

 
 
In the case the largest value of the field ID number would be 9999999 (98967F hex), there would be 7 
bytes needed to encode it as a string, 3 bytes to encode it as Motorola or Intel decimal and 4 bytes to 
encode it as special hex. 
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The following example shows how unused bytes are filled when the number of bytes assigned for the 
field is more than needed. 
 
Number of bytes assigned is 6, the value is 1500. 
 

 
 
At the bottom an overview summary is shown illustrating the fields positioned on the current layout. 
It is possible to scroll down and view the entire layout structure of the mifare encode layout. 
 
Numbers running across are the number of bytes in each Block. Number running down the left hand 
side are the number of Blocks to a Track. 
 
Select OK to add the newly created field.. 
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Add Function 

Select Mifare Menu and click Add Function or use  from the toolbar.  
 
The following dialog is displayed. 
 

 
Add functions 

 
Function 
 
Constant: Select a value between 0 and 255. This value will be encoded into the selected byte. If 
more than one byte is selected, same value will be encoded to every byte. The value can also be read 
from the database. Select Field listed in the Function Properties, the value from the field will be 
encoded onto the chip layout. If the value in the database is larger than 1 byte the ‘low byte value’ 
will encoded in the selected byte(s). 
 
Count: The counter function can read a value from the database and increment it with a defined 
value (e.g. the number of times a new card is issued for the same individual can be stored in the 
database), or an array with incremental values can be encoded. 
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Function Properties 
 
In Function Properties you can select if the value must be incremented after it is written to the card. 
 
Select if the value must be incremented after it is written to the card Write before increment or 
before it is written to the card Increment before write. 
 

 
 
Start Value: Select a Start Value between 0 and 255. 
 
At the bottom an overview summary is shown illustrating the fields positioned on the current layout. 
It is possible to scroll down and view the entire layout structure of the mifare encode layout. 
 
Card Serial Number: The card serial number (encoded by the manufacturer in track 0) can be read 
from the card and encoded another time in one of the other tracks. It can be encoded as a decimal 
string (10 bytes) or hexadecimal string (8 bytes). 
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Checksum: A checksum can be calculated over a number of bytes. Select the way the checksum is 
calculated, select where the checksum should be stored and select the bytes where the checksum 
should be calculated over. The checksum is one byte, if more than one byte is selected for the 
checksum, the value of the checksum will be repeated in every byte. 
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Function Properties 
 
In Function Properties you can select the way a checksum is calculated. 
 
XOR 
 
I 0 0 I I 0 0 I 
0 I I 0 0 I I 0 
0 0 I I 0 0 0 I 
I I I 0 I I I 0 
0 I I I I 0 I 0 
 
Result: 0  I   0  I   I  0  I  0 
 
Selecting XOR will always result in a value that fits into one byte. 
 
ADD 
 
I 0 0 I I 0 0 I 
0 I I 0 0 I I 0 
0 0 I I 0 0 0 I 
I I I 0 I I I 0 
0 I I I I 0 I 0 
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Result: I  0   I  0  0  I   I  0  0  0 
 

 When ADD is selected the low byte value will be written to the card. 
 
Parity 
 
A parity check can be selected, since encoding is done in minimal parts of one byte, it will occupy one 
byte only. 
 
Polynomial CRC 
 
Use a polynomial to calculate the checksum. When you use a polynomial fill in the polynomial you 
would like to use. 
 
Example: The polynomial to use is x8+x5+x4+x2+1. This is represented by the binary value 
100110101 (309 in decimal). In the Polynom text box a decimal value must be specified. This decimal 
value must be between 257 and 511 (between 100000001 and 111111111 binary). 
 
Start Value: Select a value between 0 and 255 and fill it in, in the box. 
 

 Polynomial CRC is the most reliable way to calculate a checksum. 
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Add Database Update 

Select Legic Menu and click Add Database Update or use  from the toolbar.  
 
The following dialog is displayed. 
 

 
 

Select a field from the database which will be updated automatically from information on a card 
when the Mifare card is read. 
 
Constant: A constant value can be stored in the selected field. When the card is encoded, the value 
will be written in the field. (Fixed Text) 
 
Count: A counted value can be stored in the selected field. It will be incremented for every card 
encoded. The start value can be given in or can be read from another (or the same) field. 
 
Card Serial No: The card serial number that was written in the card by the manufacturer can be 
stored in the database when the card is encoded.  
 
Example 
 
A card serial number that was written in the card by the manufacturer can be stored in the database 
when the card is encoded. That way it is possible to check the database which card number was 
assigned to a certain person. This number can be stored as a decimal or hexadecimal value. 
 
The database update functions are displayed in the lower half of the main screen. 
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DB update field 
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Remove Item 

First you must select a field and then select Legic Menu and click Remove Item or use  from the 
toolbar.  
 
The following dialog is displayed. 
 

 
 

Select Yes to remove the selected field or No to cancel removal. 
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Remove DB Update Item 

First you must select a field and then select Legic Menu and click Remove DB Update Item or use  
from the toolbar.  
 
The following dialog is displayed. 
 

 
 

Select Yes to remove the selected DB Update field or No to cancel removal. 
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Overview 

Select Legic Menu and click Overview or use   from the toolbar.  
 
The following dialog is displayed. 
 

 
Legic overview 

 
The overview display's a preview of the data that will be encoded onto the current layout.  
 

• Full Screen: Display the Overview full screen (enlarged). 
• Print: To print the Overview select this option. 
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Legic Layout Manager 

Select Legic Menu and click Legic Layout Manager. 
 
The following dialog is presented. 
 

 
Legic layout manager 

 
Select New to create a New Legic File. 
 

 
 

Type a name to give your Legic file. 
Now you can begin to Add segments to a Legic layout.  
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Select Legic File: Select a Legic File from the dropdown list. 
 

 
 

Available Segments: Select segments from the list on the right with available segment files. 
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• Click  to add an available segment to a Legic layout. 
 

• Click  to add all available segments to a Legic layout. 
 

• Click  to remove a segment from a Legic layout. 
 

• Click  to remove all segments from a Legic layout. 
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Options Menu 

Encode Settings... 

Select Options Menu and click Encode Settings. The following dialog is presented. 
 

 
Encode settings 

 
In the Connect Encodes dialog link an encode layout to a badge layout. Check the right badge is 
selected. On the left-hand side of the window, the available configured encode layouts are displayed.  
 
Select one and click the transfer right button. 
 

 
 
Now the encode layout will be displayed on the right-hand side of the window. 
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Click Apply to save.  
 

 A combination of one chip encode layout and one magstripe layout is possible. Only one contact 
or contactless chip encode layout can be connected at a time. If you try to connect them both to a 
layout the following warning message is displayed. 
 

 
 
To disconnect an encode layout, select the layout on the right side and click the transfer left button. 
 

 
 
Click OK to close and save settings. 
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Settings 

Select Options and click Settings.  
 
The following dialog is displayed. 
 

Step 1 
 

 
General properties 

 
Type a Name for the Legic segment and define the Size. The size of a Legic segment is variable, but 
should not exceed the capacity of the medium.  
 

 Do not make a segment larger than needed.  
 
Click Next to proceed. 
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Step 2 
 

 
Stamp 

 
Define the Number of Organizational Levels.  
 
If you select one level only, the Stamp is 1 Byte. For each additional level, the stamp will increase 
with one byte. A byte can have a value between 00 and FF.  
 
You can define up to 12 Organizational Levels. 
 
Step 3 
 
In the following dialog various levels of protection can be set to keep encoded information from 
easily being read. 
 

 
Protection 
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HID Prox Encoding 
Select the File Menu, click Mode, and then click Legic Encode Layout to open Legic Encode Layout 
Mode. 
 

Click  from the BadgeCreator Toolbar and select Legic Mode from the drop down menu. 
 

Main Screen 
 

 
 
In HID Prox Encode Layout mode, HID Prox layouts are created and edited. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 502                                                                                                      

  

HID Prox Encode Layout Toolbar 

The Toolbar in HID Layout Mode can be used to quickly start a function by clicking on the desired 
button. 
 

 
 

 Back to Main Screen 
Click on this button to return to the BadgeMaker main screen.  

 

  Badge Layout Mode 
Click on this button to enter the badge layout mode to configure/create badge layouts. 

 

  Magnetic Layout Mode 
Click on this button to enter the magnetic layout mode to configure/create magnetic encode 
layouts. 

 

 Chip Mode 
Click on this button to enter the chip layout mode to configure/create chip encode layouts. 

 

 HID Prox Mode 
Click on this button to enter the mifare layout mode to configure/create HID Prox  Layouts. 

 

 Open Layout 
Click on this button to open an existing HID Prox Layout linked to the current project (*.BM) 
file. 

 

 New Layout 
Click on this button to start a New layout Wizard. 

 

 Save Layout 
Click on this button to save the current layout. 
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Open An Existing HIP Prox Layout 

Select File Menu and click Open Layout or use  from the toolbar. 
 
The following screen is presented. Configured HID Prox Layouts are listed here. 
 

 
Open layout 

 
Select a HID Prox Demo from the list (HID P). 
 
For this example HIDProxDemo is chosen. 
 
The Layout is presented in the Main Screen. 
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HID Prox layout 
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HID Prox Menu 

Settings 

Select HID Prox Menu and then click Settings. The following dialog is displayed. 
 

 
 
HID Prox reader is connected to: Select which port the HID Prox reader is connect to on your 
computer. 
 

• COM1 
• COM2 

 
Baud rate: Select a connection rate (speed). 
 

• 1200 
• 2400 
• 4800 
• 9600 
• 19200 
• 38400 

 
Select OK to save changes or Cancel to undo changes made. 
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Options Menu 

Encode Settings... 

Select Options Menu and click Encode Settings. The following dialog is presented. 
 

 
Connect encodes 

 
In the Connect Encodes dialog link an encode layout to a badge layout. Check the right badge is 
selected. On the left-hand side of the window, the available configured encode layouts are displayed.  
 
Select one and click the transfer right button. 
 

 
 
Now the encode layout will be displayed on the right-hand side of the window. 
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Click Apply to save.  
 

 A combination of one chip encode layout and one magstripe layout is possible. Only one contact 
or contactless chip encode layout can be connected at a time. If you try to connect them both to a 
layout the following warning message is displayed. 
 

 
 
To disconnect an encode layout, select the layout on the right side and click the transfer left button. 
 

 
 
Click OK to close and save settings. 
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Intelli TWAIN  

Since IntelliTWAIN is compliant with the TWAIN specifications version 1.9, it is possible to use the 
solution in all software packages capable of acquiring images from TWAIN sources. IntelliTWAIN has 
been successfully tested with BadgeMaker, BM Entry, CardCoach and CardsOnline. The images and 
procedures used in this example might not be exactly what you will encounter during the setup in 
your specific software solution but it will give you a good overall understanding of the functionality 
and features utilized by IntelliTWAIN in conjunction with the Canon camera. 

Intelli TWAIN Canon - My Settings 

To configure device settings open Intelli TWAIN Canon – My Settings via the following path:  
Start Menu>All Programs>intelliTwain Canon> Intelli TWAIN canon – My Settings 
 

 
TWAIN Settings 

 
Enable the following options of your choice. 
 
Enable: multiple face handling. 
The IntelliTWAIN face detection is capable of detecting and measuring multiple faces into one image. 
Within the photo-ID requirements it is obvious that multiple faces cannot be handled simultaneously. 
Intelli TWAIN will capture both subjects and crop each subject, allowing the operator to choose 
which cropped image to acquire. In the event that multiple faces are in one image, a selection will 
need to be made. 
 
 
 
 
Enable: auto capture and close. 
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The feature enables the one click process. Select Acquire and Intelli TWAIN is initialized, the software 
will capture the image, crop the image and save it to BadgeMaker in a single click process. 
  
Enable: manual auto cropping correction 
The Image is captured and automatically cropped for your convenience, switch this feature off to 
enable full control when cropping an image. 
 
Display advanced proportion settings. 
Displays more configuration settings to define the proportion of an image. 
 
Display advanced cropping settings. 
Displays more configuration settings to define the composition of an image. 
 
Add to windows start-up 
This feature enables Intelli TWAIN to start up when your Windows Operating System starts up. 
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IntelliLicense – IntelliTWAIN Canon 

To enable full use of the Intelli TWAIN software you must register your version to obtain an 
Application Serial.  For further assistance contact sales.europe@screencheck.com. 
 

 
Intelli license dialog 

 
Select Source for Intelli TWAIN  
 
To acquire a photo using the Intelli Twain camera choose Select Source from the BadgeMaker Image 
Menu. 
 
Select Photo as an Image Type and click TWAIN... 
 

 
 

mailto:sales.europe@screencheck.com�
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Under Sources find and select intelliTWAIN Canon 2.2 (32-32) driver. 
 

 
 
Click Select to link the source to an image type. 
 

 
 
Select OK to return to the main screen and begin capturing photos. 
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Intelli TWAIN will initialize automatically after selecting Acquire. 
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Acquire Intelli TWAIN 

To acquire a photo from the Intelli TWAIN Canon camera select the correct Image Source window 
(Photo), then right-click inside the image window and select Acquire. Or select from the Image Menu 
and click Acquire. 
  

 
 
By selecting Acquire Image a command is sent to the IntelliTWAIN source (Camera). 
 
The IntelliTWAIN window is presented to capture images. Place the subject in the frame until you are 
happy with the position. 
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Camera settings 

 
Click the Capture button, IntelliTWAIN returns a nicely cropped and enhanced image. 
 

 By default, the height / width ratio is 3/4 and the nose will be centered on the diagonals of the 
rectangle. 
 

 
 
Select Yes to accept the captured image or No to cancel transferring the image and 
capture a new image. 
 
Select Yes, the photo is now added to your database and bound to a record.  
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Select a different record and repeat the same process to acquire another photo. 
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Intelli TWAIN Basics 

The default user interface of the IntelliTWAIN camera solution will look like this. 
 

 
 
Capture button 
Left-click is manual cropping, and right-click is automatic cropping. 
 
Update AE/AF  
The camera detects faces in a scene and then automatically focuses (AF) and optimizes exposure (AE) 
and, if needed, flash output. Click once to run. 
 
Settings 
Opens the configuration panel (Camera Settings). 
 
To open the configuration tab, you must enter a PIN-code.  
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The factory default PIN-code is 1234. The configuration tabs are now accessible. 
 

 
 
When the configuration tabs are accessible, four tabs are available to the user. 
 

 
 
 
Camera tab: Gives access to the camera device settings. 
 
Flash tab: Contains flash settings and exposure settings. 
 
Application tab: Contains the configuration software parameters. 
 
About tab: Shows specific details about the software version and system configuration. 
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Camera Tab 

Input: By selecting a different value in the Zoom dropdown box, the operator can use the in-camera 
digital zoom function. 
 

 
Settings 

 
Zoom: When you adjust the Zoom the lens changes focal length and magnification. 
 

 
 
White Balance: In most situations the default Auto option will result in a good white balance and 
exposure setting. If necessary the operator can select one of the presets which can be set and saved 
according to the specific situation. 
 
 

 
 
Metering Mode 
 
Metering Mode refers to the way in which the Canon Camera Canon supports 3 types of Mode. 
 
 

 
 

Evaluative: Here the camera measures the light intensity in several points in the scene, and then 
combines the results to find the settings for the best exposure.  
 
Center weighted: In this system, the meter concentrates between 60 to 80 percent of the sensitivity 
towards the central part of the viewfinder 
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Spot: The camera will only measure a very small area of the scene (between 1-5% of the viewfinder 
area). It’s very accurate and is not influenced by other areas in the frame. 
 
ISO 
 
ISO measures the sensitivity of your image sensor is to the amount of light present. The higher the 
ISO the more sensitive the image sensor is and therefore you more possibility to capture photos in 
low-light areas.  
 

 
 

 By default ISO is set to 200. 
 
The following ISO’s can be chosen 
 

• ISO 80 
• ISO 100 
• ISO 200 
• ISO 400 
• ISO 800 
• ISO 1600 

  
Rotation 
 
Rotate your captured image 90 degrees or 180 degrees. 
 

 
 
Flash tab 
 
Configure flash settings for your camera inside the Flash Screen. 
 

 
 

To enable flash settings the operator must lift up  the flash physically on the camera in order to set 
software flash settings. 
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Under certain conditions, a flash photograph taken with a camera may result in red eye occurring. 
This is caused by a reflection within the eyes of the subject within the capturing frame. Intelli TWAIN 
has a red-eye filter which analyzes the stored image and modifies the stored image to eliminate any 
red-eye phenomenon by changing the red area to black. 
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Application Tab 

Cropping – Type 
 
In the Application tab, relevant software settings can be adjusted. The default setting is to crop 
automatically using a face detection algorithm, but it is possible to override this mechanism. 
 

 
 
The Proportion drop down list lets the operator choose out of one of the predefined height/width 
ratios, or define a custom ratio. 
 
Since the face detection algorithm will always try to center the nose on the diagonals, it could 
happen that the total image from the camera is not wide enough, or in other words, the detected 
face is too close to the border of the image to crop without hitting the boundaries.  
 
To overcome these obstacles, some complex mechanisms are designed into the software to 
automatically shift the face to the required position and add pixels to the image in the areas where 
space must to be created. 
 
Click the Advanced tab, extra settings will appear, the operator can choose an Anchor Point and a Fill 
Color. 
 

 



 

 © 1993-2009 ScreenCheck B.V.        PAGE 522                                                                                                      

  

Select the Preview After Auto Crop option, the software shows the result to the operator before 
passing it to the photo-ID software. 
 
Auto Cropping 
 
The Auto Cropping tab lets the operator configure the photo composition. 
 

 
 
By changing the Size setting, the size of the image in relation to the face can be 
determined. 
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SIZE SET 80 
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SIZE SET 110 
 

 
 
Changing only this setting will still keep the nose on the diagonals.  
 
Changing the Correction Factor we can change the position of the nose in the image composition. 
In the Extra region, the PIN code for locking and unlocking the Settings Panel are entered. If left 
Unlocked the user can freely change the IntelliTWAIN settings. 
 

 
 
The Auto Optimize Image activates or deactivates the proprietary enhancement algorithm. Based on 
mathematical analysis, the enhancement feature decides if the image is too light or too dark and 
adjusts the result accordingly. 
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AUTO OPTIMIZE ENABLED 
 

 
 

AUTO OPTIMIZE DISABLED 
 

 
 
The face detection algorithm developed for use in the IntelliTWAIN solution is very robust and fast. 
The actual face detection and measurement is done in only a few milliseconds. After batch testing 
more than 50.000 real life images in a service bureau environment we can say that the fine-tuned 
algorithm has a success rate of 94%. It is important to realize that IntelliTWAIN is a clever way to let 
the computer guess which combination of pixels could be a face. Therefore IntelliTWAIN contains 
some features to overcome this from happening. 
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Cropping 

In case no face was detected in the image, a manual cropping window is opened. This offers the user 
the possibility to select and crop in the same way as he would do with other, less sophisticated, 
camera systems.  
 

 
 
Click and drag the box over the image until you are happy with the layout, click Transfer to finalize 
the image. You can re-size the crop box as you wish by selecting the end points of the crop box. 
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 In case IntelliTWAIN wrongfully detects a face in an area where no face is present, the user could 
become trapped in a situation where he needs to switch the auto crop feature off before grabbing 
an image. To avoid this, a manual crop can be forced by left clicking on the capture button. 
 
Select Preview to view your captured image before writing the image to a record. 
 

 
 
Click Transfer to finalize. 
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Multiple Face Handling 

The IntelliTWAIN face detection is capable of detecting and measuring multiple faces into one image.  
 
Within the photo-ID requirements it is obvious that multiple faces cannot be handled simultaneously. 
In the event that multiple faces are in one image, a selection will need to be made. 
 

 
 
By either using the Select Face dropdown box, or simply by double-clicking the selected 
face, the operator can select, crop and enhance the face as needed. 
 
Once selected click on Transfer to upload your image. 
 

 
 
Click Yes to transfer the image. The image is now added to the selected record. 
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BM Main Screen 
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